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!
Danger

indicates that death, severe personal injury or substantial property damage will  result if proper precautions are
not taken.

!
Warning

indicates that death, severe personal injury or substantial property damage can result if proper precautions are
not taken.

!
Caution

indicates that minor personal injury or property damage can result if proper precautions are not taken.

Note

draws your attention to particularly important information on the product, handling the product, or to a particular
part of the documentation.

Qualified Personnel
Only qualified personnel  should be allowed to install and work on this equipment. Qualified persons are
defined as persons who are authorized to commission, to ground, and to tag circuits, equipment, and systems
in accordance with established safety practices and standards.

Correct Usage
Note the following:

!
Warning

This device and its components may only be used for the applications described in the catalog or the technical
description, and only in connection with devices or components from other manufacturers which have been
approved or recommended by Siemens.

This product can only function correctly and safely if it is transported, stored, set up, and installed correctly,
and operated and maintained as recommended.

Trademarks
SIMATIC , SIMATIC HMI  and SIMATIC NET  are registered trademarks of SIEMENS AG.

Third parties using for their own purposes any other names in this document which refer to trademarks might
infringe upon the rights of the trademark owners.

Notes on Safety

We have checked the contents of this manual for agreement with the hard-
ware and software described. Since deviations cannot be precluded entirely,
we cannot guarantee full agreement. However, the data in this manual are
reviewed regularly and any necessary corrections included in subsequent
editions. Suggestions for improvement are welcomed.

Disclaimer of LiabilityCopyright � Siemens AG 1996 All rights reserved

The reproduction, transmission or use of this document or its contents is not
permitted without express written authority. Offenders will be liable for
damages. All rights, including rights created by patent grant or registration of
a utility model or design, are reserved.

Siemens AG
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Geschaeftsgebiet Industrie-Automatisierungssysteme
Postfach 4848, D- 90327 Nuernberg

  Siemens AG 1996
Subject to technical change.
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Preface

Validity of the Manual

This manual contains the description of the FM 451 positioning module valid at the
time of publication. We reserve the right to describe modifications in the
functionality of the FM 451 in a product information bulletin.

The manual with the
n mber in the footer

... is valid for the FM 451
number in the footer ....

Order number Revision level

EWA 4NEB 720 6009-02
6ES7 451-3AL00-0AE0

43
21 =

C79000-G7076-C451-02 6ES7 451-3AL00-0AE0

54
32 =

Content of the Manual

This manual describes the hardware and software of the FM 451 positioning
module.

It consists of the following:

• A section describing basic aspects (Chapters 1 to 7)

• A reference section (Chapters 8 to 12)

• An appendix (Chapters A, B and C)

• An index.
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CE Mark

Our products meet the requirements of the EU directive 89/336/EEC 
”Electromagnetic Compatibility” and the harmonized European standards (EN) 
listed in the directive.

In compliance with the above mentioned EU directive, Article 10, the conformity
declarations are available to the relevant authorities at the following address:

Siemens Aktiengesellschaft
Bereich Automatisierungstechnik 
A&D AS E 48
Postfach 1963
D-92209 Amberg

Further Support

If you have questions about using the products described in the manual and you
cannot find the answers here, please contact your local Siemens representative.
You will find the addresses, for example, in the appendix “SIEMENS Worldwide” in
the installation manual:
S7-400/M7-400 Programmable Controllers, Hardware and Installation.

If you have any questions or comments on this manual, please fill out the remarks
form at the end of the manual and return it to the address shown on the form. We
would be grateful if you could take the time to answer the questions giving your
own personal opinion of the manual.

To help you to become familiar with working with SIMATIC S7 PLCs, we offer a
range of courses. Please contact your regional training center or the central
training center in D-90027 Nuremberg, Tel. +49 911/895-3202 for more information.
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Up to the Minute Information

You can obtain the latest information on SIMATIC products from the following
sources:

• on the Internet at http://www.ad.siemens.de/

SIMATIC Customer Support also provides you with the latest information and
downloads that will help you use SIMATIC products:

• on the Internet at http://www.ad.siemens.de/simatic-cs

• From the SIMATIC Customer Support Mailbox at the number 
+49 (911) 895-7100

To dial the mailbox, use a modem with up to V.34 (28.8 kbauds), with the
following parameter settings: 8, N, 1, ANSI, or dial via ISDN (x.75, 64 Kbps).

SIMATIC Customer Support is available at the phone and fax numbers and at the
E-mail addresses listed below. You can also contact us via Internet mail or mail at
the mailbox mentioned above.

Johnson City

Nuremberg

Singapore

Simatic Basic Hotline

Nuremberg

SIMATIC BASIC Hotline

Johnson City

SIMATIC BASIC Hotline

Singapore

SIMATIC BASIC Hotline
Local time: Mo.-Fr. 8:00 to 18:00

Phone: +49 (911) 895-7000

Fax: +49 (911) 895-7002

E-mail: simatic.support@
nbgm.siemens.de

Local time: Mo.-Fr. 8:00 to 17:00

Phone: +1 423 461-2522

Fax: +1 423 461-2231

E-mail: simatic.hotline@
sea.siemens.com

Local time: Mo.-Fr. 8:30 to 17:30

Phone: +65 740-7000

Fax: +65 740-7001

E-mail: simatic@
sae.siemens.com.sg

SIMATIC Premium Hotline
(Calls charged, only with 
SIMATIC Card)

Time: Mo.-Fr. 0:00 to 24:00

Phone: +49 (911) 895-7777

Fax: +49 (911) 895-7001

The languages spoken on the hotlines are generally German and English. On the
authorization hotline, French, Italian and Spanish are also available.
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1.1 What is the FM 451?

The FM 451 positioning module is used in the S7-400 programmable logic
controller (PLC) for controlled positioning with rapid/creep feed speeds. The
module has three independent channels each of which can control a rotary or
linear axis. Each channel of the module supports an incremental or absolute
encoder (SSI).

You can operate a number of FM 451 positioning modules simultaneously.
Combinations with other FM/CP modules are also possible. A typical application is
the combination with an FM 452 electronic cam controller.

FM 451

CPU

with user program and
blocks for the FM 451

S7-400

PC/PG

Configuration package with
parameter assignment 
dialogs, blocks and manual

Figure 1-1 SIMATIC S7-400 Configuration with an FM 451
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1.2 Areas of Application of the FM 451

• Packing machines

• Lifting and transport equipment

• Woodworking machines

Example: Control of feed operations
Various wooden parts are processed with a profile machine. Various operations
and cutters are required to process the wood. The various cutters are changed
by controlled positioning operations.

• Paper and printing machines

• Rubber and plastics processing machines

Example: Simple handling 
The molded parts in an injection molding machine are removed from the mold
by a grab arm. The arm is controlled by the positioning module.

• Building materials industry

• Machine tools
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1.3 Setup for Controlled Positioning with an FM 451

Control Circuit

Figure 1-2 illustrates the components of a controlled positioning setup with
rapid/creep speed drives.

Power unitSafety 
device

Power supply

Mechanical 
transmission
elements

CPU

PC/PG

EMER STOP
switch

Processing
stations

Hardware
limit switch

M Encoder

Motion

FM 451
Positioning
module

Motor

11

Digital outputs
for channel 1
1Q0-1Q3

Configuration package with parameter
assignment user interface, blocks and
manual

Figure 1-2 Controlled Positioning

Power Unit and Safety Device

The power unit (for example a contactor combination) is activated via the digital
outputs of the FM 451. The FM 451 has four control modes (see Section 8.3, page
8-6).

If the safety device responds, (EMERGENCY OFF switch or  hardware limit
switch), the power unit turns off the motor.

Motor

The motor is controlled by the power unit and drives the axis.
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Encoder

The encoder supplies information both about position and direction. The following
encoders can be connected:

• Incremental encoders with 5 V differential signals, symmetrical

• Incremental encoders with 24 V signals, asymmetrical

• SSI absolute encoders

FM 451 Positioning Module

The FM 451 can position up to three axes automatically using rapid/creep feed.

The power unit is controlled via four digital outputs (see Section 8.3, page 8-6).

The FM 451 positioning module calculates the current actual position value of the
axis from the encoder signals that are proportional to the distance moved (see
Section 8.5, page 8-15 and Section 8.7, page 8-22).

The FM 451 provides the following modes and functions:

• “Jogging” (see Section 9.2, page 9-8).

• “Reference point approach” (see Section 9.3, page 9-11).

• “Absolute/relative incremental approach” (see Section 9.4, page 9-17).

• Set actual value / set actual value on-the-fly (see Section 9.5, page 9-24).

• Zero offset (see Section 9.6, page 9-27).

• Set reference point (see Section 9.7, page 9-30).

• Length measurement / edge detection (see Section 9.8, page 9-32).

• Loop traverse (see Section 9.9, page 9-35).

CPU

The CPU executes the user program. Data and signals are exchanged between
the user program and the module using function calls.

PC/PG

The PC/programming device is used for the following:

• Parameter settings: You make the parameter settings for the FM 451 either with
the parameter dialogs or using the parameter DB (see Section 6.5.4, page
6-14).

• Programming: You program the FM 451 with functions that you incorporate
directly in your user program.

• Testing and putting into operation: You test the FM 451 using the parameter
dialogs with which you also finally put the system into operation.
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Overview of the Positioning Module

• Three axes, axis types:

– Linear axis

– Rotary axis

• Four digital outputs per axis

• Four digital inputs per axis

• Typical drives/motors:

– Standard motor, contactor controlled

– Standard motor with frequency converter (example Micromaster)

– Asynchronous motor connected to power unit with vector control.

• Positioning systems:

– Incremental encoder 5 V, symmetrical

– Incremental encoder 24 V, asymmetrical

– SSI absolute encoder

• Monitoring functions:

– Working range monitoring with software limit switches

– Stationary state monitoring

– Encoder monitoring

– Monitoring of axis movement and final target approach

• System environment:

– Used centrally in a SIMATIC S7-400

• System integration:

– Module exchange without PG possible

– Teleservice possible
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Basics of Positioning

Chapter Overview

Section Contents Page

2.1 Controlled Positioning 2-2

2.2 Ranges and Switching Points of the FM 451 2-2
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2.1 Controlled Positioning

Each positioning operation is characterized by the following:

• a start position

• a target to which the tool will move, and

• parameters determining how the positioning operation is executed.

The target position is first approached at high speed (rapid speed). 
At a specified distance from the target position the speed is reduced to a lower
speed (creep speed). Shortly before the axis reaches the target position, again at a
specified distance from the target position, the drive is switched off. The module
then monitors the final target approach.

The drive is controlled via digital outputs that set the rapid or creep speed and the
required direction (see Section 8.3, page 8-6).

2.2 Ranges and Switching Points of the FM 451

Target
The target is the absolute or relative position on the axis that is approached during
a positioning operation.

Definition of the Switching Points and Ranges

The following ranges and positions can be set for each positioning operation:

Range Explanation

Working range Defines the range that you set for your task using the software limit
switches or the end of the rotary axis.

Switchover
difference

Defines the distance to the target at which the drive switches from rapid
speed to creep speed.

Switchover point Defines the position at which the drive changes from rapid speed to
creep speed.

Switch-off
difference

Defines the distance to the target at which the drive is turned off.

Switch-off point Defines the position at which the drive is turned off. From this point
onwards, the FM 451 activates monitoring functions.

Target range Defines the positioning accuracy of your application and is located
symmetrically either side of the target.

Stationary range Defines a symmetrical range around the target that is monitored by the
FM 451.
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Figure 2-1 shows a possible arrangement of the switching points and differences
for a positioning operation. To simplify the illustration, it is assumed that the change
in actual speed is linear over the distance traveled. The ramps that result, are due
to mechanical inertia or due to the parameter settings for the power unit.

vrapid

vcreep

Travel

Start Switchover point Switch-off point

Switchover
difference Sw-off

diff.

Target

A
ct
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l s
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ed

Figure 2-1 Switching Points and Differences

Figure 2-2 illustrates how the switching ranges can be arranged around the target.

Target Software end limit switch0

Switchover difference in travel direction plus

Switch-off difference in travel direction plus

Working range

Target range
Stationary range

1

2

3

4

5
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2 3
4 5

6

Switch-off difference in travel direction minus

Switchover difference in travel direction minus

Software start limit switch 7

Figure 2-2 Switching Ranges Around a Target
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Installing and Removing the FM 451

Important Safety Rules

When integrating an S7-400 with an FM 451 in a plant or system, there are
important rules and regulations that are explained in the installation manual
S7-400/M7-400 Programmable Controllers, Hardware and Installation.

Selecting Slots

The FM 451 positioning module can be installed in a central rack or in an
expansion rack just like a signal module.

Configuring the Mechanical Setup

The options in terms of the mechanical setup and the steps required during
configuration are explained in the installation manual S7-400/M7-400
Programmable Controllers, Hardware and Installation.

Tools Required for Installation and Removal

To install or remove the FM 451, you require a 4.5 mm screwdriver.

3
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Installing the FM 451 Positioning Module

1. Hook the FM 451 on at the top and swing it down.

2. Tighten the screws on the FM 451 (tightening torque 
approximately 0.8 to 1.1 Nm).

3. Label the FM 451 with its slot number using the number wheel supplied with the
module.

For more information on the numbering scheme and how to specify the slot
number, refer to the installation manual S7-400/M7-400 Programmable
Controllers, Hardware and Installation.

Removing the FM 451 Positioning Module

1. Switch off the power unit.

2. Release the front connector and remove it.

3. Release the cover to the encoder interface.

4. Disconnect the sub D connector to the encoders.

5. Loosen the securing screws on the module.

6. Tilt the module upwards and remove it.
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Wiring the FM 451

Chapter Overview

Section Contents Page

4.1 Description of the Encoder Interface 4-2

4.2 Connecting the Encoders 4-3

4.3 Description of the Front Connector 4-4

4.4 Wiring the Power Unit 4-8

4.5 Wiring the Front Connector 4-10

Important Safety Rules

It is essential for the safety of the system to install the elements listed below and to
adapt them to your system.

• EMERGENCY STOP switch with which you can turn off the entire system.

• Hardware limit switches that directly influence the power units of all drives. 

• Motor circuit-breaker.

4
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4.1 Description of the Encoder Interface

Location of the Sub-D Connectors

Figure 4-1 shows the location and labeling of the female connectors on the
module. You can connect incremental or absolute encoders (SSI) to the sub-D
female connectors (see Section 10).

FM 451

ENCODER CH3
1

15 8

9

1

15 8

9

ENCODER  CH1

1

15 8

9

ENCODER CH2

CH = channel

Figure 4-1 Position of the Sub D Female Connectors (Encoder CH1, CH2, and CH3)

Pinout of the Encoder Interfaces (Encoder CH1, CH2 and CH3)

Pin Name Incr. Encoder (24V) Incr. Encoder (5V) Absolute Encoder

1 A* Encoder signal A --- ---

2 CLS --- --- SSI clock signal

3 CLS --- --- SSI clock signal inv.

4 B* Encoder signal B --- ---

5 DC 24V Encoder power Encoder power Encoder power

6 DC 5.2V --- Encoder power Encoder power

7 M Ground Ground Ground

8 N* Zero marker signal --- ---

9 RE Sourcing/sinking
(see Sec. B.3)

--- ---

10 N --- Zero marker signal ---

11 N --- Zero marker signal 
inv.

---

12 B --- Encoder signal B inv. ---

13 B --- Encoder signal B ---

14 A / DAT --- Encoder signal A inv. SSI data inv.

15 A /DAT --- Encoder signal A SSI data
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4.2 Connecting the Encoders

For information about the possible encoders and encoder cables, refer to 
Chapter 10 and Appendix B.

Procedure

Follow the steps outlined below to connect the encoder:

1. Connect the cable to the encoder.

With some encoders it may be necessary to assemble the cable (at the encoder
end) according to the manufacturer’s specifications.

2. The encoder cables must be shielded.

3. The leads A and A, B and B, N and N of an incremental encoder or the leads
DAT and DAT, CLS and CLS of an absolute encoder must be twisted in pairs.

4. Open the front panel and plug the sub D connector into the FM 451.

5. Secure the connector with the knurled screws. Close the front panel.

6. Remove the insulating material on the connecting cable and clamp the cable
shield to the shield/PE bar.

Figure 4-2 Connection of an Encoder to the FM 451 Positioning Module
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4.3 Description of the Front Connector

Front Connector

You connect the power supplies for the encoders and the digital outputs via the
48-pin front connector. The digital outputs and inputs assigned to the channels are
also connected.

Pinout of the Front Connector (X1)

Terminal Name Meaning Incremental Encoders Absolute
Encoders

1 In use; contains cable jumper for detecting the front connector

2

3 1L+ 24 V DC auxiliary supply for the the encoders

4 to 7 Not used

8 1I0 Channel 1: digital input 0 Reference point switch Not used

9 1I1 Channel 1: digital input 1 Reversing switch Not used

10 1I2 Channel 1: digital input 2 Enable input

11 1I3 Channel 1: digital input 3 Input for “set actual value on the fly”/ 
length measurement/edge detection/
external event for incremental dimension
number 252

12 Not used

13 2L+ 24 V DC auxiliary supply for the load current

14 2L+ The two terminals are jumpered on the module.

15 2I0 Channel 2: digital input 0 Reference point switch Not used

16 2I1 Channel 2: digital input 1 Reverse switch Not used

17 2I2 Channel 2: digital input 2 Enable input

18 2I3 Channel 2: digital input 3 Input for “set actual value on the fly”/ 
length measurement/edge detection/
external event for incremental dimension
number 252

19 3I0 Channel 3: digital input 0 Reference point switch Not used

20 3I1 Channel 3: digital input 1 Reverse switch Not used

21 3I2 Channel 3: digital input 2 Enable input

22 3I3 Channel 3: digital input 3 Input for “set actual value on the fly”/ 
length measurement/edge detection/
external event for incremental dimension
number 252

23 to 24 Not used
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Terminal Absolute
Encoders

Incremental EncodersMeaningName

25 3L+ 24 V DC auxiliary supply for the load current

26 3L+ The two terminals are jumpered on the module.

27 1Q0 Channel 1: digital output 0

28 1Q1 Channel 1: digital output 1

29 1Q2 Channel 1: digital output 2

30 1Q3 Channel 1: digital output 3

31 2Q0 Channel 2: digital output 0

32 2Q1 Channel 2: digital output 1

33 2Q2 Channel 2: digital output 2

34 2Q3 Channel 2: digital output 3

35 to 36 Not used

37 4L+ 24 V DC auxiliary supply for the load current

38 4L+ The two terminals are jumpered on the module.

39 3Q0 Channel 3: digital output 0

40 3Q1 Channel 3: digital output 1

41 3Q2 Channel 3: digital output 2

42 3Q3 Channel 3: digital output 3

43 to 47 Not used

48 M Chassis of the auxiliary supplies 1L+, 2L+, 3L+, and 4L+

Auxiliary Power Supply for the Encoders (1L+, M)

Here, you connect the 24 V DC auxiliary power for the encoders. The reference
potential of this power supply (M) is connected with the chassis of the load current
supply (M) in the FM 451.

The 24 V DC auxiliary power for the encoders is monitored for undervoltage and
wire break.

At the encoder interface (sub-D female connectors: encoder CH1, CH2 and CH3),
24 V DC, and 5.2 V DC are available for the different types of encoder.

! Caution

Make sure that the polarity of the 24 V DC auxiliary power supply for the encoders
(1L+, M) is correct.

If you connect the 24 V DC auxiliary power supply for the encoders and
accidentally reverse the polarity, this will damage the module to such an extent
that it must be replaced.
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Auxiliary Power Supply for Load Current (2L+, 3L+, 4L+, M)

You connect the 24 V auxiliary suppies for the load current of the digital outputs at
terminals 2L+, 3L+, 4L+ and M.

! Caution
Make sure that the polarity of the 24 V auxiliary power for the load current (2L+,
3L+, 4L+, M) is correct.
If you connect the 24 V DC auxiliary power for the load current and accidentally
reverse the polarity, this will damage the module to such an extent that it must be
replaced.

Note on Wiring 24 V DC

When wiring up the module, remember that all the terminals 1L+ to 4L+ must be
connected for the module to operate correctly.

Start by wiring the 24 V DC to terminal 38 and jumper the voltage from terminal 37
to terminal 26. Do the same for the other terminals.

As an alternative, you can also connect separate power supplies to the terminals
1L+ (encoders), 2L+ (channel 1), 3L+ (channel 2) and 4L+ (channel 3). Make sure,
however, that all power supplies have a common ground potential. In this case, the
synchronization of the axes is retained following a power outage of the auxiliary
power supplies for the load current.

Load Current Supplies

The DC power supply for the load current must meet the following requirements:

Only low voltage ≤ 60 V DC safety isolated from the power supply network must be
used for the load current supply. Safe isolation can be implemented, for example,
by adhering to the specifications in 
VDE 0100 Part 410 / HD 384-4-41 / IEC 364-4-41
(as functional low voltage with safe isolation) or 
VDE 0805 / EN 60950 / IEC 950
(as safety extra low voltage SELV) or VDE 0106 Part 101.

12 Digital Inputs (1 I0 to 3 I3)

The FM 451 has 4 digital inputs per channel.

You can connect bounce-free switches (24 V current sourcing) or non-contact
sensors (2 or  3-wire proximity switches) to the 12 digital inputs.

The digital inputs are not monitored for short-circuit or wire break and are
electrically connected to the chassis of the encoder power supply.

A separate LED indicates the state of each input.
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12 Digital Outputs (1Q0 to 3Q3)

The FM 451 has 4 digital outputs per channel.

The digital outputs are used to control the power unit. The function of the digital
outputs depends on the control mode. The control mode (see Section 8.3, page
8-6) is selected in the configuration software or in the parameter DB.

The digital outputs are not monitored for short circuit or wire break and are
electrically connected to the chassis of the encoder power supply.

A separate LED indicates the state of each output.

Table 4-1 Functions of the Digital Outputs, x for Channel 1, 2, or 3

Output Q Control Mode

1 2 3 4

xQ0 Rapid speed Rapid/creep
speed

Rapid speed Rapid speed plus

xQ1 Creep speed Position
reached

Creep speed Creep speed plus

xQ2 Travel plus Travel plus Travel plus Rapid speed minus

xQ3 Travel minus Travel minus Travel minus Creep speed minus
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4.4 Wiring the Power Unit

Power Unit

The power unit (for example a simple contactor combination) is connected to the
digital outputs of the FM 451 and controls the motor.

Contactor Circuit

Figure 4-3 shows the control and load current circuits of a power unit. 
The functions of the digital outputs correspond to control mode 1
(see Section 8.3, page 8-6).

Load circuitControl circuit

1Q0 1Q1 1Q2 1Q3

Digital outputs on FM 451

M

K3

K4

K2

K1

K1

K2

K4

K3

K1 = Direction plus
K2 = direction minus
K3 = rapid speed
K4 = creep speed

E1E2

E1 = Hardware limit switch minus
E2 = hardware limit switch plus

K1

K3

K2

K4

M

Pole-changing motor

L1 L2 L3

NC
contact
of

Figure 4-3 Contactor Circuit
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How the Contactor Circuit Works

Contactors K1 and K2 control the direction of the motor. The contactors are
interlocked by the normally closed contacts K2 and K1. The hardware limit
switches E1 and E2 are the limit switches minus/plus. If the axis travels beyond
these limit switches, the motor (direction) is turned off.

The contactors K3 and K4 switch the motor from rapid to creep speed. The
contactors are interlocked by the normally closed contacts K4 and K3.

! Caution

Interlock the power network contactors, as shown in Figure 4-3.

If you do not keep to this rule, a short circuit can occur in the main power network.

Note
Direct connection of inductive components (e.g. relays/contactors) is possible
without external wiring.
If SIMATIC output power circuits can be turned off by additionally installed
contacts (for example relay contacts), you must include additional surge protection
with inductive components (an example of surge protection is shown below).

Example of Surge Protection

Figure 4-4 illustrates an output circuit that requires additional surge voltage
protection. Diodes or Z diodes are used with coils activated by direct current.

with diode with Z diode

- -

++

Digital output of the FM 451

e.g. 1Q0

Contact in output circuit

Digital output of the FM 451

e.g. 1Q0

Figure 4-4 Relay in the Output Circuit
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4.5 Wiring the Front Connector

Connecting Cords

• The cords for digital inputs and digital outputs must be shielded if they exceed
certain lengths, as follows:

– Digital inputs: 50 m or more cord length

– Digital outputs: 100 m or more cord length

• The shields of the cords must be grounded at both ends.

• Flexible cord, cross section 0.25 to 1.5 mm2

• Wire-end ferrules are not required. If, however, you prefer to use them, you can
use wire-end ferrules without an insulation collar (DIN 46228, form A, short
design).

Required Tools

3.5 mm screwdriver or motorized screwdriver

Wiring Procedure

!
Warning

Injury to persons or damage to equipment if the power supply is not turned off.

If you wire the front connector of the FM 451 while it is live, you risk injury from
electric shock.

Wire the FM 451 only when it is not live!

If no emergency stop switch is installed, damage can result from the connected
units.

Install an emergency stop switch with which you can turn off the connected drives
when you are controlling the FM 451 using the Configuration Software.
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To wire up the front connector, follow the steps outlined below:

1. Remove the front connector cover.

2. Strip 6 mm of insulation from the cords. If required, fit wire-end ferrules.

3. Thread the supplied strain relief into the front connector.

4. If you want to lead the cords out at the bottom, start at the bottom, otherwise at
the top. Screw down unused terminals as well.
Use a torque of 0.6 to 0.8 Nm.

5. Fit the strain relief to the connector.

6. Pull the strain relief clamp for the cable row tight.

7. Put the front connector into the operating position (pressing the securing
element).

8. Label the connections on the enclosed labeling strip.

Ground Connection

The ground of the auxiliary supplies is electrically connected to the chassis of the
CPU; in other words, pin 48 (M) must be connected with low resistance to the
chassis of the CPU.

In the case of external encoder supply, you must also provide a low-resistance
connection between the ground of the external encoder supply and the ground of
the CPU.

Ground

FM 451

Shield/PE bar

Pin 48 (M)

Power controller

24 V
24 V
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Installing the Configuration Package

Requirements

STEP 7, Version V4.02 or higher is correctly installed on your programming
device/PC.

Content of the Configuration Package

Configuration
package

Configuration 
software Documentation

Parameter dialogs Manual

Blocks

Getting Started

Block librarySamples

Product information

Functions (FCs) Templates for data
blocks (UDTs)

Figure 5-1 Content of the Configuration Package
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Installation

The entire configuration package is located on the CD supplied. You install the
configuration package as follows:

1. If you already have a configuration package on your system, uninstall it.

2. Insert the CD in the CD drive of your PC/programming device.

3. Start the software installation dialog in Windows 95/Windows NT/Windows 98
by clicking the “Add/Remove Programs” icon in the “Control Panel”.

4. In this dialog, select the CD drive and the folder FMx51\Disk1 , then select the
file Setup.exe  and start the installation.

5. Follow the instructions displayed by the installation program step by step.

Result:  The components of the configuration package are installed in the
following folders:

– SIEMENS\STEP7\S7LIBS\FMx51LIB:  FCs, UDTs

– SIEMENS\STEP7\S7FABS:  Configuration software, readme, online help

– SIEMENS\STEP7\EXAMPLES:  Examples

– SIEMENS\STEP7\MANUAL\S7FABS:  Getting Started, manuals

Note
If you installed STEP 7 in a folder other than SIEMENS\STEP7, this folder is
entered.
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Programming the FM 451

Chapter Overview

Section Contents Page

6.1 Principles of Programming an FM 451 6-2
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6.3 FC ABS_CTRL (FC 1) 6-5
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6.1 Principles of Programming an FM 451

Task

You can assign parameters, control, and commission each channel of the FM 451
module per user program. The following chapters will help you to design a user
program suitable for your application.

Preparations

• Open the block library FMx51LIB in the SIMATIC Manager and copy the
required functions (FCs) and block templates (UDTs) to the block folder of your
project. If the block numbers are already being used, assign new numbers. The
block names are entered unchanged in the symbol table of your S7 program.

Name Meaning

FC ABS_INIT (FC 0) This is required to initialize the channel DB following a module
startup.

FC ABS_CTRL (FC 1) This is required for data exchange and for controlling the module.

FC ABS_DIAG (FC 2) This is required when you process detailed diagnostic information in
the program or want to make this information available to an operator
control and monitoring system.

UDT ABS_CHANTYPE
(UDT 1)

This is required to generate a channel DB per channel; this is used by
FC ABS_INIT and FC ABS_CTRL.

UDT ABS_DIAGTYPE 
(UDT 2)

This is required to create a diagnostic DB for each module; this is
used by FC ABS_DIAG.

UDT ABS_PARATYPE
(UDT 3)

This is required to create a parameter DB; this is used by FC
ABS_CTRL to write or read machine data and incremental dimension
tables.

• Create data blocks (DBs) using the UDTs in the block folder of your S7
program.

– You require a separate channel DB for each channel.

– If you want to write or read parameters using the user program, you require
a separate parameter DB for each channel.

– If you want your user program to run diagnostic functions, you require a
diagnostic DB for each module.

• Enter the module address in the corresponding channel DB and, if required, also in
the corresponding diagnostic DB at the address “MOD_ADDR”. 
You can also have the address entered automatically by selecting the module in
HW Config and then selecting a data block in the “Properties” dialog with the “Mod
Addr” button.

• Enter the channel number and, if required, the number of the parameter DB in the
relevant channel DB.
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• If your programming device/PC is connected to a CPU, you can now download
the FCs and DBs to the CPU.

The following schematic shows how the FM 451, FCs, DBs and OBs communicate.

Startup

e.g. OB100

Cyclic operation, parameter
assignment and control

e.g. OB1

FM 451

Channel DB

Parameter DB

FC ABS_CTRL

Channel DB

FC ABS_INIT

DB_NO DB_NO

PARADBNO

Diagnostic DB

FC ABS_DIAG

DB_NO

Jobs

Function switches

Control signals

Return signals

Diagnostic buffer

Figure 6-1 Data Exchange Between FCs, DBs and the FM 451
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6.2 FC ABS_INIT (FC 0)

Task

FC ABS_INIT deletes the following data in the channel DB: 

• The control signals

• The return signals

• The trigger, done, and error bits of the jobs

• The function switches and their done and error bits

• Job management for FC ABS_CTRL

Call

The function must be run through for each channel following a startup (power
supply on) of the module or CPU. You should therefore call it, for example in the
startup OB (OB100) and the remove/insert OB (OB83) or in the initialization phase
of your user program. This ensures that your user program does not access old
data following a CPU restart or a module startup.

Data Block Used

Channel DB:
The module address must be entered in the channel DB.

Call Parameters

Name Data Type P Type Meaning

DB_NO INT IN Channel DB number.

Return Values

This function does not return a value.
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6.3 FC ABS_CTRL (FC 1) 

Tasks

Using FC ABS_CTRL, you can read the operating data of each channel of the
module, assign parameters for the channels, and control the channel during
operation using the control signals, return signals, function switches, and
write/read jobs.

Each time it is called, the function performs the following activities:

• Read return signals:
FC ABS_CTRL reads all the return signals for a channel and enters them in the
channel DB. Since the control signals and jobs are only executed following this,
the return signals reflect the status of the channel before the block was called. 

• Job management: 
FC ABS_CTRL processes the write and read jobs and transfers 
data between the channel DB, parameter DB, and the module.

• Write control signals:
The control signals entered in the channel DB are transferred to the module.

Call

FC ABS_CTRL must be called cyclically (for example in OB1) for each channel.

Before you call FC ABS_CTRL, enter all the data in the channel DB that are
required to execute the intended functions.

Data Blocks Used

• Channel DB:
The module address and the channel number must be entered in the channel
DB. Incorrect information can lead to I/O access errors or to access to a
different module causing incompatible data.

• Parameter DB:
If you want to write or read machine data using jobs, you require a parameter
DB whose number must be entered in the channel DB.

Call Parameters

Name Data Type P Type Meaning

DB_NO INT IN Number of the channel DB

RET_VAL INT OUT Return value
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Return Values

The function provides the following return values:

RET_VAL BR Description

1 1 At least one job active

0 1 No job active, no error

-1 0 Error: Data error (DATA_ERR) or 
communications error (JOB_ERR) occurred

Jobs

Data exchange with the module other than the control and return signals is handled
using jobs.

To start a job, you set the corresponding trigger bit in the channel DB and provide
the relevant data for write jobs. You then call FC ABS_CTRL to execute the job.

Due to the required confirmations from the module, a write job requires at least
three calls (or OB cycles). A read job is executed immediately.

Once a job has been executed completely, the block resets the trigger bit. The next
time the block is called, the next job is located and executed.

For each job, there is a trigger bit (extension _EN for “enable”) and a done bit and
error bit. These have the extensions _D (for “done”) or _ERR (for “error”) in the
name. FC ABS_CTRL updates the done and error bits when the job has been
executed. These bits should be set to 0 after they have been evaluated or before a
new job is sent.

If you set the JOBRESET bit, all the done and error bits are reset before the
pending jobs are processed. The JOBRESET bit is then set to 0 again.

Function Switches

The function switches activate and deactivate channel states. A job for writing the
function switches is only executed when there is a change in a switch setting. The
setting of the function switch is latched after the job has been executed.

Function switches and jobs can be used at the same time in one FC ABS_CTRL
call.

As with the jobs, the function switches have trigger bits with the name extension
_ON/_OFF, done bits with the extension _D and error bits with the extension
_ERR.

To allow evaluation of the done and error bits of the function switches, you should
set these bits to 0 before you send a job to modify a function switch.
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Order of Job Execution

You can send several jobs at the same time. If no jobs are active, the job
management of FC ABS_CTRL searches through the jobs starting at MDWR_EN
to check whether trigger bits are set or whether modifications have been made to
function switches. When a job is found, it is executed. Once the job is completed,
the job management searches for the next job to be executed. Once the search
has reached the last job (ENCVAL_EN), the search starts again at the MDWR_EN
job. This search is repeated until all jobs have been executed.

The jobs are executed in the following order which has proved practical from a
technological point of view:

Order Addr. in
Channel

DB

Reset
by

Write jobs

1 35.0 MDWR_EN Write machine data FC 1

2 35.1

35.2

35.3

36.4

MD_EN

DELDIST_EN

AVALREM_EN

DELDIAG_EN

Activate machine data

Delete distance remaining

Cancel set actual value

Delete diagnostic buffer

FC 1

3 35.4 TRGL1WR_EN Write incr. dim. table 1 FC 1

4 35.5 TRGL2WR_EN Write incr. dim. table 2 FC 1

5 35.6 REFPT_EN Set reference point FC 1

6

34.0

34.1

34.2

34.3

34.4

Function switches

PLOOP_ON

MLOOP_ON

EI_OFF

EDGE_ON

MSR_ON

Loop traverse in plus direction

Loop traverse in minus direction

Do not evaluate enable input

Edge detection on

Length measurement on

User
program

7 35.7 AVAL_EN Set actual value. FC 1

8 36.0 FVAL_EN Set actual value on-the-fly FC 1

9 36.1 ZOFF_EN Set zero offset FC 1

10 36.2 TRG252_254_EN Write incr. dim. for incr. dim. no.
252/254

FC 1

11 36.3 TRG255_EN Write incr. dim. for incr. dim. no. 255 FC 1

Read jobs

12 36.5 MDRD_EN Read machine data FC 1

13 36.6 TRGL1RD_EN Read incr. dim. table 1 FC 1

14 36.7 TRGL2RD_EN Read incr. dim. table 2 FC 1

15 37.0 MSRRD_EN Read measured values FC 1

16 37.1 ACTSPD_EN Read actual speed, distance
remaining and current incr. dim.

FC 1

17 37.2 ENCVAL_EN Read encoder data FC 1
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This order allows you to start a complete positioning operation with a set of jobs
and control signals. The jobs range from writing and activating the machine data,
setting the external enable input to writing the incremental dimensions for
incremental approaches.

Control Signals

If a STOP signal is active or if an operator error has occurred or if the drive enable
is missing, the block resets the control signals START, DIR_M and DIR_P.

You can start a positioning operation again after acknowledging the operator error
(OT_ERR_A=1). With this acknowledgment, it is not possible to send further jobs
and control signals.

The block sets the acknowledgment of an operator error (OT_ERR_A) to 0 when
no operator error has been detected.

The block resets the start signals START, DIR_P and DIR_M when the channel
signals that a positioning operation has started (except in the “Jogging” mode).

The block holds back all control signals with the exception of the operator error
acknowledgment OT_ERR_A if the axis has not had parameters assigned.

Jobs and Control Signals

You can send several jobs at the same time even along with the control signals
necessary for the positioning operation. If at least one write job is sent at the same
time as the control signals START, DIR_M or DIR_P, the block holds back the
control signals until the write jobs have been executed.

Jobs During an Active Positioning Operation

If the write jobs listed in the table below are sent during a positioning operation,
they are held back until the end of the operation and are only executed the next
time the block is called.

Address Name Type Initial Value Comment

34.0 PLOOP_ON BOOL FALSE 1 = Loop traverse in plus direction

34.1 MLOOP_ON BOOL FALSE 1 = Loop traverse in minus direction

34.2 EI_OFF BOOL FALSE 1 = Do not evaluate enable input

34.3 EDGE_ON BOOL FALSE 1 = Edge detection on

34.4 MSR_ON BOOL FALSE 1 = Length measurement on

35.1 MD_EN BOOL FALSE 1 = Activate machine data

35.2 DELDIST_EN BOOL FALSE 1 = Delete remaining distance

35.3 AVALREM_EN BOOL FALSE 1 = Undo set actual value

35.6 REFPT_EN BOOL FALSE 1 = Set reference point coordinate

35.7 AVAL_EN BOOL FALSE 1 = Set actual value.

36.1 ZOFF_EN BOOL FALSE 1 = Set zero offset

36.4 DELDIAG_EN BOOL FALSE 1 = Delete diagnostic buffer
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Startup

When the module or CPU starts up, call FC ABS_INIT (see Section 6.2, page 6-4).
Among other things, the function switches are reset. FC ABS_CTRL acknowledges
the module startup. During this time, RET_VAL and JOBBUSY are set to 1.

Job Status

You can check the status of job execution using the return value RET_VAL and the
JOBBUSY activity bit in the channel DB. You can evaluate the status of a single
job based on the trigger, done, and error bits of the job.

RET_VAL JOBBUSY Trigger bit
_EN

Done bit
_D

Error bit
_ERR

Job active 1 1 1 0 0

Job completed 
without error

0 0 0 1 0

Job completed 
with error

-1 0 0 1 1

Write job 
aborted

-1 0 0 0 1

Response to Errors

If incorrect data were written during a write job, the channel returns the message
DATA_ERR = 1 in the channel DB.  If an error occurs in communication with the
module during a write or read job, the cause of the error is entered in the
JOB_ERR parameter in the channel DB.

• Error in a write job:

If an error occurs in a job, the trigger bit is reset and the error bit (_ERR) and
the done bit (_D) are set. The trigger bit is also reset but only the error bit
(_ERR) is set for all write jobs still pending. Any pending write jobs are
canceled, since one job may depend on another.

The pending read jobs continue to be processed. JOB_ERR is set again for
each job.

• Error in a read job:

If an error occurs in a job, the trigger bit is reset and the error bit (_ERR) and
the done bit (_D) are set.

The read jobs still pending continue to be processed. JOB_ERR is set again for
each job.

For more detailed information on errors, refer to the description of the parameters
JOB_ERR and DATA_ERR (see Section 11 and Appendix C.3, page C-11).
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Program Structure

Figure 6-2 outlines the structure of a user program with which a channel of the
module can be controlled cyclically after a single startup initialization. The return
value (RET_VAL) of FC ABS_CTRL is used in the user program for general error
evaluation.

An independent and simultaneous startup is possible for each further channel as
shown in Figure 6-2.

Initialization: 
Call FC ABS_INIT 

Set job data and job trigger bits 
Set control signals 

Call FC ABS_CTRL 

Evaluate return value (RET_VAL) of FC ABS_CTRL 

<0 =0 >0

General 

non-specified 

reaction to: 

 data error, 
programming error 

Evaluate

data of read jobs 

and return signals

C
yc

lic
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l 
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Next job 

Next cycle 
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Error Jobs done Jobs being 
processed

Figure 6-2 General Program Structure
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6.4 FC ABS_DIAG (FC 2)

Tasks 

Using FC ABS_DIAG, you read out the diagnostic buffer of the module and can
make it available for display in an operator control and monitoring system or for
programmed evaluation.

Call

The function must be called cyclically (for example OB 1). An additional call in an
interrupt OB is not permitted. For complete execution of this function, at least two
calls (cycles) are required.

The function reads out the diagnostic buffer when a new entry is indicated in the
diagnostic buffer by the return signal DIAG = 1. After reading the diagnostic buffer,
DIAG is set to 0 by the module.

Data Block Used

Diagnostic DB:
The module address must be entered in the diagnostic DB. The latest entry in the
diagnostic buffer is entered in the DIAG[1] structure and the oldest entry in the
DIAG[9] structure.

Call Parameters

Name Data Type P Type Meaning

DB_NO INT IN Number of the diagnostic DB

RET_VAL INT OUT Return value
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Return Values

The function provides the following return values:

RET_VAL BR Description

1 1 Job active

0 1 No job active, no error

-1 0 Error

Jobs

You can read the diagnostic buffer whether or not there is a new entry by setting
the DIAGRD_EN trigger bit. After reading the diagnostic buffer, the trigger bit is set
to 0.

Execute this job following a CPU startup and a module startup. This ensures that
the content of the diagnostic DB matches the content of the diagnostic buffer of the
module even if the module has made no new entry in the diagnostic buffer.

Startup

There is no startup processing associated with the function.

Response to Errors
If an error occurs in the execution of the job, the cause of the error can be found in
the diagnostic DB in the JOB_ERR parameter (see Chapter 11 and Appendix C.3,
page C-11).
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6.5 Data Blocks

6.5.1 Templates for Data Blocks

The supplied library (FMx51LIB) contains a block template (UDT) for each data
block. Based on these UDTs, you can create data blocks with any number and
name you wish.

6.5.2 Channel DB

Task

The channel DB (see Appendix C.1, page C-2) is the data interface between the
user program and the FM 451. It contains and receives all the data required for
controlling and operating a channel.

Structure

The channel DB is subdivided into various areas:

Channel DB

Control signals

Return signals

Trigger bits for read jobs

Function switches

Trigger bits for write jobs

Done bits

Module address *)

Data for jobs

Job management for functions

*) You can enter the address with 
the configuration software

Error bits

Number of the parameter DB

Channel number
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6.5.3 Diagnostic DB

Task

The diagnostic DB (see Appendix C.3, page C-11) contains the data for FC
ABS_DIAG and also contains the diagnostic buffer of the module created by this
function.

Structure

Diagnostic DB

Internal data
Job status

Trigger bit
Diagnostic buffer

Module address

6.5.4 Parameter DB

Task

If you want to modify the machine data and incremental dimension tables during
operation, you require a parameter DB (see Appendix C.2, page C-9) in which
these data are stored. The parameters can be modified by the user program or by
an operator control and monitoring system.

You can export the data displayed in the configuration software to a parameter DB.
You can also import a parameter DB into the configuration software and display it
there.

There can be several sets of parameter data for each channel (for example for
different recipes) the required set being selected in the program.

Structure

Parameter DB

Machine data

Incremental dimension tables
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6.6 Technical Specifications of the FCs and DBs for the FM 451

The table below provides you with an overview of the technical data of the
functions and data blocks.

Table 6-1 Technical Specifications of the Functions and Data Blocks for the FM 451 

No. Block Name Version Space
in Load
Memory
(bytes)

Space
in Main
Memory
(bytes)

Space
in Local Data

Area
(bytes)

MC7
Code/Data

(bytes)

Called 
System Functions

FC 0 FC ABS_INIT 1.0 184 130 2 94

ÁÁÁ
ÁÁÁ

FC 1ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

FC ABS_CTRL ÁÁÁ
ÁÁÁ

1.0 ÁÁÁÁ
ÁÁÁÁ

4548 ÁÁÁÁ
ÁÁÁÁ

4176 ÁÁÁÁÁ
ÁÁÁÁÁ

34 ÁÁÁÁ
ÁÁÁÁ

4140 ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

SFC 58: WR_REC,
SFC 59: RD_RECÁÁÁ

ÁÁÁ
ÁÁÁ

FC 2
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

FC ABS_DIAG
ÁÁÁ
ÁÁÁ
ÁÁÁ

1.0
ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ

1800
ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ

1658
ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ

42
ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ

1622
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

SFC 59: RD_REC

Channel DB - 638 184 - 148

Parameter DB - 840 556 - 520

Diagnostic DB - 524 388 - 352

Module Cycle

The return signals of a channel are updated by the module every 8 ms. The actual
value is updated every 3 ms.
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Execution Times

The following table provides you with an overview of the execution times of the
functions for the FM 451. The run time from the first function call to the done
message (trigger bit reset) is shown. The cycle is extended by between 1 and 2 ms
when a function is called.

Table 6-2 Execution Times of the Functions for the FM 451 

Block Block Name/Job

CPU 416-2 
(6ES7 416-2XK01-0AB0)Block Block  Name/Job

Run time in ms

FC 0 FC ABS_INIT 0.01ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ

FC 1

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

FC ABS_CTRL

Control/return

MDWR_EN

MD_EN

TRGL1WR_EN

DELDIST_EN

REFPT_EN

Function switches

AVAL_EN

FVAL_EN

ZOFF_EN

TRG252_254_EN

TRG255_EN

DELDIAG_EN

MDRD_EN

TRGL1RD_EN

MSRRD_EN

ACTPOS_EN

ENCVAL_EN

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

0.06

16.7

2.9

21.6

3.2

3.2

3.2

3.2

1.9

3.2

1.9

2.3

3.2

1.4

1.8

0.7

0.7

0.7

FC 2

FC ABS_DIAG

Idle run

Read diagnostic buffer

0.03

2.4
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6.7 Fast Access to Module Data 

Application

In special applications or in an interrupt level, particularly fast access to return and
control signals may be necessary. You can obtain this data directly via the input
and output areas of the module.

To coordinate startup following each module startup (for example after inserting the
module, CPU STOP → RUN), FC ABS_CTRL must be called continuously until the
end of the startup is indicated by RET_VAL = 0. Following this, you must no longer
use FC ABS_CTRL.

Note

It is not possible to use FC ABS_CTRL in conjunction with write access.

Direct Access for Reading Return Signals

The byte addresses are specified relative to the base address of the outputs of the
particular channel. The names of the parameters are those in the channel DB (see
Appendix C.1, page C-2).

Base address of channel 1 = base address of module

Base address of channel 2 = base address of module + 8

Base address of channel 3 = base address of module + 16

In STL, you access the data with the commands PIB (read 1 byte), PIW (read 2
bytes) and PID (read 4 bytes).

Address Bit number

7 6 5 4 3 2 1 0

Byte 0 PARA internal internal DATA_ERR OT_ERR DIAG internal internal

Byte 1 CHGOVE
R

CUTOFF ZSPEED SPEED_OUT 0 WAIT_EI WORKING ST_EN
BLD

Byte 2 MODE_OUT

Byte 3 POS_RCD 0 FVAL_DO
NE

0 GO_P GO_M MSR_DO
NE

SYNC

Byte 4

Byte 5 ACT_POS

Byte 6

Byte 7
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Example: Actual position value (ACT_POS)

STL Explanation

Example

L PID 516

The base address of the module is 512

Read actual position value (ACT_POS) of
channel 1 using direct access:
Base address of the channel + 4

Direct Access for Writing Control Signals

The byte addresses are specified relative to the base address of the inputs of the
particular channel. The names of the parameters are those in the channel DB (see
Appendix C.1, page C-2).

Base address of channel 1 = base address of module

Base address of channel 2 = base address of module + 8

Base address of channel 3 = base address of module + 16

In STL, you access the data with the commands PQB (write 1 byte), PQW (write 2
bytes) and PQD (write 4 bytes).

Address Bit number

7 6 5 4 3 2 1 0

Byte 0 0 0 0 0 OT_ERR_A 0 0 0

Byte 1 DRV_EN SPEED252 0 0 DIR_P DIR_M STOP START

Byte 2 MODE_IN

Byte 3 MODE_TYPE

Byte 4 Reserved

Byte 5

Byte 6

Byte 7

Example: START signals channel 2

STL Explanation

Example

L 2#10001000
T PQB 521

The base address of the module is 512

Set DRV_EN and DIR_P to 1
Write signals for Channel 2 using direct
access:
Base address of the module + 8 + 1
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6.8 Parameter Transfer Routes 

The term parameter includes the following machine data and incremental dimensions.

System data
(SDB)

Configuration
software

HW Config

Parameters

Para-
meter

DB

User 
program

ABS_CTRL

1

2

3

4

5

6 7

8
10

11

Para. assg.

DB

11b

11a

10b

10a

2a

PG/PC

offline

CPU

online
FM 451

System data
(SDB)

9

Figure 6-3 Parameter Transfer Routes

1 Save parameters in the configuration software.

2 Save and compile the hardware configuration.

2a Download the hardware configuration to the CPU. The CPU executes Step 3 automatically.

3 The CPU writes the parameters to the module during system parameter assignment.

4 Upload parameters of a module channel to the PG with “PLC - Upload Channel”.

5 Download parameters from the PG to a module channel with “PLC - Download Channel”.

6 Write parameters to a channel of the module using jobs in the user program.

7 Read parameters from a channel of the module using jobs in the user program.

8 Store parameters from the user program in the online DB.

9 Read parameters into the user program from the online DB.

10 Export parameters from the configuration software to the offline DB.

10a Download the offline DB to the CPU.

10b Export parameters from the configuration software to the online DB.

11 Import parameters from the offline DB to the configuration software.

11a Upload parameters from the online DB to the programming device.

11b Import parameters from the online DB to the configuration software.
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Typical Situations for the Transfer of Parameters:

• You edit the parameters with the configuration software. You then want the channels
of the module to have parameters assigned automatically during startup. 
Action required: steps 1, 2 and 2a.

• You modify parameters during startup in the test mode in the configuration software:
Action required: steps 4 and 5.

• The parameters modified during installation should be downloaded automatically
during startup:
Action required: steps 1, 2 and 2a.

• You create the parameters with the configuration software. You only want the
channels of the module to be assigned parameters during startup by the user program
via data blocks: 
Action required: steps 10, 10a and 6 or 10b and 6.

• You want to create data for recipes:
Action required: steps 10 and 10a.

• You create the parameters with the configuration software. These should be available
to the user program for temporary modifications. 
Action required: steps 1, 2 and 2a for automatic parameter assignment. 
Action required: steps 10, 10a, 9, 8 and 6 for access by the user program.

• You modify existing parameters (exclusively) with the user program: 
Action required: steps 7, 9, 8 and 6.

• You want to view the data modified by the user program in the configuration software.
Action required: steps 11a and 11 or only 11b.

• The parameters modified by the user program should be downloaded automatically
during startup:
Action required: steps 11b or 11a, 11 and then 1, 2, 2a.
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Putting the FM 451 into Operation

Important Note

Please read the points in the following warning carefully.

! Warning

Injury to persons and damage to equipment can occur.

To prevent personal injury and material damage, please note the following points:

• Install an EMERGENCY STOP switch in the vicinity of the computer. This is the
only means of ensuring that the system can be switched off safely in the event
of a computer or software failure.

• Install a hardware limit switch directly connected to the power units of all
drives.

• Make sure that nobody can obtain access to the area of the system that
contains moving parts.

• Controlling and monitoring the FM 451 from within your program and from the
“Test > Commission” dialog at the same time can lead to conflicts with
unforeseeable effects. For this reason, always switch the CPU to STOP when
you work in the Test dialog or deactivate your program.

7
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Hardware Installation and Wiring

In this first section you install the FM 451 in your S7-300 and wire the external
peripheral components.

Step What needs to be done? �

1 Install the FM 451  (see Chapter 3)

Insert the module in one of the slots 4 to 11. �

2 Wire up the FM 451  (see chapter 4)

• Wire the front connector of the FM 451:

– Auxiliary power supply for the encoders

– Auxiliary power supply for the load current

– Digital inputs

– Digital outputs

• Connect the encoders

�

�

�

�

�

3 Check the switches relevant for safety

Check that the following switches are functioning correctly:

• The emergency stop switch

• The hardware limit switch

�

�

4 Front connector

The front connector must sit firmly. �

5 Check the shielding of each individual cable. �

6 Switch on the power supply

Switch the CPU to the STOP state (safe state).

Turn off the 24 V power supply for the auxiliary voltages.

�

�

Creating a Project

Create a project in STEP 7.

The steps required to set up a project in the SIMATIC Manager are described
below (without using a wizard).

Step What needs to be done? �

1 If you have not already done so, install the configuration package. �

2 Create a new project in the SIMATIC manager (File> New ). �

3 Insert a station in your project (Insert > Station ). �

4 Select the station and start the configuration user interface “HW Config” by
double-clicking “Hardware”.

�

5 Insert a rack in your hardware configuration with the following:

• A power supply (PS)

• CPU

• Function module (FM 451)

�

6 Save this hardware configuration in HW Config (Station > Save ). �
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Preparations for Programming

Create the blocks you require in your project if you want to access the module from
the user program.

Step What needs to be done? �

1 Select the library FMX51LIB in the SIMATIC Manager (File > Open > Libraries ). �

2 From the library, copy the functions FC0, FC1, and the channel DB template UDT 1 to
the blocks folder.

�

3 Create a channel DB for each channel based on the UDT 1 template and enter the
channel number.

�

4 If you want to program diagnostic evaluation, copy FC 2 and UDT 2 and create a
diagnostic DB for each module.

�

5 If you want to write or read machine data and incremental dimension tables in the user
program, you require UDT 3 to create a parameter DB for each channel.

�

Parameter Assignment using the Configuration Software

When you first put the module into operation, assign the parameters to it using the
parameter assignment dialogs of the configuration software.

Step What needs to be done? �

1 Select the tier in the rack containing the FM 451 module. �

2 Now double-click to start the parameter assignment dialogs for the FM 451. �

3 Using the menu command File > Properties , you can modify the following settings:

• General

You can modify the name and enter a comment.

• Addresses

If you change the base address, you must also modify the end address. Note down
the module address displayed.

The module address must be entered in the MOD_ADDR parameter in the channel
DB and, if required, also in the diagnostic DB.

You can have the address entered automatically by clicking the MOD_Adr  button
and then select the channel DB and, if required, the diagnostic DB.

• Basic Parameters

You can set the interrupt type and the reaction to a CPU stop.

�

4 Set the appropriate parameters in the dialogs Drive, Axis, Encoder and Incremental
Dimensions .

�

5 With Edit > Create Channel , you can create your channels. �

6 Save the parameter settings with the menu command File > Save . �

7 Close the parameter dialogs with File > Exit . �

8 Save the hardware configuration in HW Config with Station > Save and Compile . �

9 Set up an online connection to the CPU and download the hardware configuration to the
CPU. The parameter data are transferred to the FM 451.

�
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Test and Commissioning

You can test the entries and modifications you have made in the parameter dialogs
of the configuration software.

Step What needs to be done? �

1 Check your data with the dialogs Test > Commission , Test > Service  and Test > Error
Evaluation .

�

2 You can modify incorrect machine data in the Test > Commission  dialog. These
modifications are valid until the CPU next changes from STOP to RUN.

�

3 You can save the corrected machine data on the CPU by repeating steps 6 to 9 of the
previous table.

�

Note

If you set the drive enable in the commissioning dialog with the CPU in the STOP
mode and then exit all the parameter dialogs, the drive enable is canceled.

Testing Modes, Jobs, and Function Switches

Using the following tests you can check whether the parameters are set correctly
for the FM 451.

Step What needs to be done? �

1 Synchronize the axis

• Incremental Encoders

– Select “set reference point”. Enter
the corresponding value (see
Section 9.7, page 9-30).

or

– Select the “Reference Point
Approach” mode (see Section 9.3,
page 9-11).

• Absolute Encoders

– The FM 451 is synchronized
immediately after parameter
assignment.

– Make an absolute encoder
adjustment (see Section 8.6, page
8-19).

�

Check the actual status of the axis. The actual position must agree with the position
indicated.

�

2 Select the Jog  operating mode. �

• Check the correct interconnection of the outputs (control type) and the actual value.

– Move the axis in the plus and minus directions at creep speed.

– Move the axis in the plus and minus direction at rapid speed.

�

• Check the encoder resolution (see Section 8.7, page 8-22)

– Move the drive over a defined distance in a defined direction.

The actual distance traveled must match the display in the 
Test > Commissioning dialog.

�
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Step �What needs to be done?

3 Select the operating mode incremental mode

:

• absolute with incremental dimension number 255

– Check the travel with the defined incremental dimension

– and adapt the switchover and switch-off differences to your system based on
incremental dimension 255.

�

�

4 Test the other function switches and jobs according to your applications

• For example loop traverse, set actual value

�

Preparing the Channel DB

Step What needs to be done? �

1 Open the channel DB. �

2 Check the following entries:

• The module address in the MOD_ADDR parameter

• The channel number in the CH_NO parameter

• If applicable, the number of the parameter DB in the PARADBNO parameter

�

�

�

3 Save the channel DB (File > Save ). �

Preparing the Diagnostic DB

Step What needs to be done? �

1 Open the diagnostic DB �

2 Check whether the module address has already been entered in the MOD_ADDR
parameter.

�

3 Save the diagnostic DB (File > Save ). �

Linking the Functions

Step What needs to be done? �

1 Link the required functions in your user program. �

Downloading Blocks to the CPU

Step What needs to be done? �

1 Select the blocks in the SIMATIC manager and download them with the menu command
 PLC > Download to CPU.

�
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8.1 Writing and Reading Machine Data and Incremental Dimension
Tables

This chapter describes how to modify and read out parameters during operation
using your application.

All the parameters are stored in the parameter DB.

• The machine data are in the parameter DB at addresses 4.0 to 116.0.

• Incremental dimension tables are located in the parameter DB from addresses
120.0 to 516.0.

You must enter the number of the parameter DB in the appropriate channel DB.

You can enter the parameters either with the DB editor or more conveniently in the
dialogs “Drive”, “Axis”, “Encoder” and “Incremental Dimensions” and write them to
the parameter DB using the “Export” function.

You can import the parameters from an existing parameter DB into the dialogs with
the “Import” function.

Writing, Activating and Reading Machine Data

With the machine data, you adapt the FM 451 to the axis and the encoder.

Initial parameter assignment

If the channel does not yet have machine data, follow the steps outlined below
when assigning parameters for the first time without using the parameter dialogs:

• Enter the new values in the parameter DB and save it.

• Download the parameter DB to the CPU.

• Set the following trigger bit in the channel DB for the job:

– Write machine data (MDWR_EN).

• Call the FC ABS_CTRL function in the cyclic user program.

Modifying machine data

To modify machine data using your application, follow the steps outlined below:

• Enter the new values in the parameter DB.

• Set the trigger bits in the channel DB for the following jobs:

– Write machine data (MDWR_EN)

– Activate machine data (MD_EN)

• Call the FC ABS_CTRL function in the cyclic user program.

If you set the trigger bits for these jobs all at once, FC ABS_CTRL makes sure that
the jobs are processed in the correct order.
Otherwise, always modify the machine data in the following order:

• Write machine data

• Activate machine data
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Reading machine data

To read the current machine data from a channel, follow the steps outlined below:

• Set the following trigger bit in the channel DB:

– Read machine data (MDRD_EN)

• Call the FC ABS_CTRL function in the cyclic user program.

This enters the current machine data in the parameter DB on the CPU.

Excerpt from the Channel DB

Address Name Data
Type

Initial Value Description

35.0 MDWR_EN BOOL FALSE 1 = write machine data

35.1 MD_EN BOOL FALSE 1 = activate machine data

36.5 MDRD_EN BOOL FALSE 1 = read machine data

Writing and Reading Incremental Dimension Tables

Initial parameter assignment

If the channel does not yet have incremental dimension tables, follow the steps
below when making the initial parameter assignment without the configuration
software:

• Enter the new values in the parameter DB and save it.

• Download the parameter DB to the CPU.

• Set the trigger bits in the channel DB for the following jobs:

– Write incremental dimension table 1 (TRGL1WR_EN) and / or write
incremental dimension table 2 (TRGL2WR_EN)

• Call the FC ABS_CTRL function in the cyclic user program.

Modifying incremental dimension tables

To modify incremental dimension tables using your application, follow the steps
outlined below:

• Enter the new values in the parameter DB.

• Set the trigger bits in the channel DB for the following jobs:

– Write incremental dimension table 1 (TRGL1WR_EN) and / or write
incremental dimension table 2 (TRGL2WR_EN)

• Call the FC ABS_CTRL function in the cyclic user program.
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Reading incremental dimension tables

To read the incremental dimension tables from a channel, follow the steps outlined
below:

• Set the trigger bits in the channel DB for the following jobs:

– Read incremental dimension table 1 (TRGL1RD_EN) and / or read
incremental dimension table 2 (TRGL2RD_EN)

• Call the FC ABS_CTRL function in the cyclic user program.

The incremental dimension tables are stored in the parameter DB on the CPU.

Excerpt from the Channel DB

Address Name Data
Type

Initial Value Description

35.4 TRGL1WR_EN BOOL FALSE 1 = write incremental dimension table 1 (1 ...
50)

35.5 TRGL2WR_EN BOOL FALSE 1 = write incremental dimension table 2 (51
... 100)

36.6 TRGL1RD_EN BOOL FALSE 1 = read incremental dimension table 1 (1 ...
50)

36.7 TRGL2RD_EN BOOL FALSE 1 = read incremental dimension table 2 (51
... 100)

Note

If parameters are modified that are relevant for the synchronization, the following
actions are taken by the module for the relevant channel when the machine data
are activated:
• Synchronization deleted

• The function switches and zero point offset are reset

• All previous machine data and incremental dimension tables become invalid

The following parameters are relevant for synchronization:
• Axis type
• End of rotary axis
• Encoder type
• Distance per encoder rev.
• Increments per encoder rev.
• Number of revolutions.
• Reference point coordinate
• Absolute encoder adjustment
• Type of reference point approach
• Count direction
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8.2 System of Units 

Selecting a Unit

In the configuration software of the FM 451, you can select one of the following
systems of units for entering and outputting data:

• mm (default)

• inches

• degrees

Note
If you change the unit in the parameter dialogs, the values are calculated in the
new system. This can lead to rounding errors.
If you change the system of units by programming with the jobs “write machine
data” and “activate machine data”, the values are not automatically recalculated.

System of Units in the Parameter DB

Address Name Data
Type

Initial Value Description

8.0 UNITS DINT L#1 Units
1 = 10-3 mm
2 = 10-4 inches
3 = 10-4 degrees
4 = 10-2 degrees
6 = 10-3 degrees

Standard System of Units

In this manual, the limit values  are always specified in the system of units mm .
To define the limits in other systems of units, please make the following
conversion:

To convert.... Calculate

mm � inches Limit value (inches) = limit value (mm) � 0.1

mm ��deg 10-4 (4 decimal places)

10-3 (3 decimal places)

10-2 (2 decimal places)

Limit value (degrees) = limit value (mm) � 0.1

Limit value (degrees) = limit value (mm) � 1

Limit value (degrees) = limit value (mm) � 10

Relationship between Increments and System of Units

The encoder signals of a connected encoder are evaluated by the FM 451 and
converted to the current system of units. For the conversion, the resolution is used
(see Section 8.7, page 8-22).

If the FM 451

• has counted 10 increments and

• a resolution of 100 �m per increment is set by the encoder parameters,

this means that the axis was moved by a distance of 1 mm.
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8.3 Machine Data for the Drive

Drive Data

Address Name Data
Type

Initial Value Description

92.0 CTRL_TYPE DINT L#1 Control Mode :

The control mode describes how the four
digital outputs per channel operate a
connected motor via the power controller.

x stands for channel 1, 2 and 3

Control mode 1

Rapid speed

Creep speed

Travel plus

Travel minus

vrapid

vcreep

xQ0

xQ1

xQ2

xQ3

Return signal
       PEH=1

Control mode 2

Rapid/creep speed

Position reached

Travel plus

Travel minus

vrapid

vcreep

xQ0

xQ1

xQ2

xQ3

Return signal
       PEH=1
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Control mode 3

Rapid speed

Creep speed

Travel plus

Travel minus

vrapid

vcreep

xQ0

xQ1

xQ2

xQ3

Return signal
       PEH=1

Control mode 4

Rapid traverse plus

Creep speed plus

Rapid traverse minus

Creep speed minus

vrapid

vcreep

xQ0

xQ1

xQ2

xQ3

Return signal
       PEH=1

Table 8-1 Table with the States of the 4 Outputs for each Control Mode (x stands for channel 1, 2 and 3)

Control Mode 1 Rapid speed Creep speed Position
reached hold

Direction + Direction - Direction + Direction -
reached  hold

(PEH)

xQ0 1 1 0 0 -

xQ1 0 0 1 1 -

xQ2 1 0 1 0 -

xQ3 0 1 0 1 -

Control Mode 2

xQ0 1 1 0 0 0

xQ1 0 0 0 0 1

xQ2 1 0 1 0 0

xQ3 0 1 0 1 0
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Table 8-1 Table with the States of the 4 Outputs for each Control Mode (x stands for channel 1, 2 and 3)

Control Mode 3 Rapid speed Creep speed Position
reached hold

Direction + Direction - Direction + Direction -
reached  hold

(PEH)

xQ0 1 1 0 0 -

xQ1 1 1 1 1 -

xQ2 1 0 1 0 -

xQ3 0 1 0 1 -

Control Mode 4

xQ0 1 0 0 0 -

xQ1 1 0 1 0 -

xQ2 0 1 0 0 -

xQ3 0 1 0 1 -
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Address Name Data
Type

Initial Value Description

100.0

104.0

108.0

112.0

CHGDIF_P

CHGDIF_M

CUTDIF_P

CUTDIF_M

DINT

DINT

DINT

DINT

L#5000

L#5000

L#2000

L#2000

Switchover difference plus

Switchover difference minus

Switch-off difference plus

Switch-off difference minus

Range:

• 1 �m to 1 000 000 000 �m at a 
resolution of � 1 �m/pulse

• 1 �m to 100 000 000 �m at a 
resolution of  < 1 �m/pulse

Switchover diff. plus/minus
Switch-off diff. plus/minus

The “switchover difference“ defines the switchover point at which the drive switches over from rapid to
creep speed.

The “switch-off difference” defines the switch-off point at which the drive is turned off (at creep speed).
From this point onwards, the FM 451 starts monitoring functions.

The values apply for all targets which the FM 451 approaches; with the exception of incremental
dimension 255.

Rules

• The values for the plus and the minus direction can be different.

• The switchover difference must be greater than the switch-off difference.

• The switchover difference must be within the working range.

• The switchover difference must be less than the end of the rotary axis.

• The switch-off difference must be greater than the half target range.

• The distance between the switchover point and the switch-off point must be adequate so that the
drive can switch reliably from rapid to creep speed.

• The distance between the switch-off point and target must be selected so that the drive comes to a
stop within the target range.

• The distance between the switchover point, the switch-off point, and the start of the target range
must be equivalent to a time of at least 8 ms.

For more detailed information about the arrangement of the ranges, refer to Section 2.2.

Working range
Target range
Stationary range1 2 3

4 5

6

7

Target
0

12 3

4 5
6

7 89
9

8

8

9 Switch-off point
Switchover point

Software limit switch endSoftware limit switch start
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Address Name Data
Type

Initial Value Description

76.0 TRG_RANGE DINT L#1000 Target range  

• 0 = No monitoring

Range:

• 1 �m to 1 000 000 000 �m at a 
resolution of � 1 �m/pulse

• 1 �m to 100 000 000 �m at a 
resolution of  < 1 �m/pulse

The target range is located symmetrically around the target.

Specifying the value 0 deactivates the monitoring of the target range.

On the topic of target approach, you should also refer to Section 9.1 (page 9-2).

Address Name Data
Type

Initial Value Description

84.0 ZSPEED_R DINT L#1000 Stationary range

• 0 = No monitoring

Range:

• 1 �m to 1 000 000 000 �m at a 
resolution of � 1 �m/pulse

• 1 �m to 100 000 000 �m at a 
resolution of  < 1 �m/pulse

The stationary range is located symmetrically around the target. Whether the drive remains stationary at
the approached position or drifts away is monitored.

If the stationary range is left without a valid travel job, the FM 451 signals an error.

For a value 0 the stationary monitoring is switched off.

Recommendation: The stationary range should be greater than the target range.

Refer also to Section 9.1 (page 9-2) that illustrates the target approach and the various monitoring
functions and messages.

Address Name Data
Type

Initial Value Description

88.0 ZSPEED_L DINT L#30000 Stationary speed

• 0 = No monitoring

• 1 �m/min to 100 000 �m/min

The stationary speed is used as a reference speed for the end of a positioning operation. Refer also to
Section 9.1 (page 9-2).

The value 0 deactivates monitoring of the stationary speed.
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Address Name Data
Type

Initial Value Description

80.0 MON_TIME DINT L#2000 Monitoring time

• 0 = No monitoring

• 1  to 100 000 ms

Based on the monitoring time, the module monitors the following:

• The movement of the axis up to the switch-off point.

The monitoring time starts at the beginning of a positioning operation and is restarted at each change
in the actual value in the direction of travel.

• The target approach.

The positioning operation must be completed within the monitoring time.

The monitoring time is triggered for the last time when the switch-off difference is reached.

• The plausibility of the actual values at the switching points.

Oscillation of the axis at the switching point leads to operating errors.

The value 0 deactivates the monitoring functions.

Actual monitoring time

For the monitoring time you can specify all values from the defined range.

• 0: The monitoring is deactivated.

• 1 to 100,000 ms: The FM 451 rounds the specified time up to a multiple of 8 ms (module cycle).
Ideally, you should therefore enter the monitoring time as a multiple of 8 ms.

Address Name Data
Type

Initial Value Description

99.1 EI_TYPE BOOL FALSE Evaluate enable input

0 = level-triggered

1 = edge-triggered

The enable input is an external input with which positioning can be enabled by an external event.

• Level-triggered (EI_TYPE=0)

Travel begins when you apply a “1” signal to the enable input and continues until you apply a “0”
signal to the enable input.

• Edge-triggered (EI_TYPE=1)

Travel begins when a rising edge is detected at the enable input. Subsequent signal changes at this
input no longer affect the travel that has started. 
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8.4 Machine Data of the Axis

Axis Data

Address Name Data
Type

Initial Value Description

12.0 AXIS_TYPE DINT L#0 Axis type:

0 = Linear axis

1 = Rotary axis

A linear axis  is an axis with a limited physical travel range.

Physical start Physical end

Start of rotary axis = end of rotary axis

A rotary axis  is an axis whose travel range is not restricted by mechanical limit stops.

Largest displayed
value

Address Name Data
Type

Initial Value Description

16.0 ENDROTAX DINT L#100000 End of the rotary axis:

Range:

• 1 �m to 1 000 000 000 �m at a 
resolution of � 1 �m/pulse

• 1 �m to 100 000 000 �m at a 
resolution of  < 1 �m/pulse

The value “end of rotary axis” is the highest theoretical value that the actual value can reach.
The highest theoretical value is however never displayed since it is physically the same position as the
start of the rotary axis (0).

The largest value which is displayed for a rotary axis, has the value:
 End of the  rotary axis [ �m] - resolution [ �m / pulse] �1 [pulse] 

Rotary axis with absolute encoders
With a rotary axis with an absolute encoder the rotary axis range (0 to end of rotary axis) must exactly
cover the range of the absolute encoder.

End of rotary axis[�m]� number of revolutions (encoder) ·
dist[�m]

revolution

Example: End of the rotary axis 1000 mm, resolution 1000 �m/pulse
The display jumps:
• With a positive direction of rotation from 999 mm to 0 mm.
• With a negative direction of rotation from 0 mm to 999 mm.
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Address Name Data
Type

Initial Value Description

44.0 REFPT DINT L#0 Reference point coordinate:

Range:

• -1 000 000 000 �m to 1 000 000 000 �m at
a resolution of � 1 �m/pulse

• -100 000 000 �m to 100 000 000��m 
at a resolution of < 1 �m/pulse

Incremental encoder:
You require the reference point coordinate for the “reference point approach” mode.
If the axis is not synchronized after writing and activating machine data, the actual value is set to the
value of the reference point coordinate.

Absolute encoder (SSI)
You require the reference point coordinate for the mechanical adjustment of the encoder.
Read the description of absolute encoder adjustment in Section 8.6 (page 8-19), explaining the
interaction of absolute encoder adjustment with other data.

The value of the reference point coordinate must be within the working range:
• Linear axis

including the software limit switches

• Rotary axis

Greater than or equal to 0 and less than the value “end of the rotary axis” (0 � reference point
coordinate < “end of the rotary axis”).

Address Name Data
Type

Initial Value Description

52.0 REFPT_TYPE DINT L#0 Type of reference point approach:

Ranges:

0 = plus, ref. point switch in direction +

1 = plus, ref. point switch in direction -

2 = minus, ref. point switch in direction +

3 = minus, ref. point switch in direction -

With type of reference point approach , you select the conditions for synchronization of the axis.

• The first statement defines the start direction in which the reference point approach starts.

• The second statement defines the location of the zero marker that leads to synchronization relative to
the reference point switch.

Use of this data is described in Section 9.3 (page 9-11).

Address Name Data
Type

Initial Value Description

99.0 REFPT_SPD BOOL TRUE Start speed for reference point approach

0 = rapid speed

1 = creep speed

With this data you select the speed for the start of a reference point approach:
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Address Name Data
Type

Initial Value Description

64.0

68.0

SSW_STRT

SSW_END

DINT

DINT

L#-100000000

L#100000000

Software limit switch start

Software limit switch end

Range:

• -1 000 000 000 �m to 1 000 000 000 �m at
a resolution of � 1 �m/pulse

• -100 000 000 �m to 100 000 000��m 
at a resolution of < 1 �m/pulse

These axis data are used only for a linear axis.

The software limit switches are monitored when the axis is synchronized. The range set by the software
end limit switch is known as the working range .

The start software limit switch (SLS) must always be less than the end software limit switch (SLE).
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Working range
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Encoder range Travel range
SLS SLE

Incremental encoders

Initially, the axis is not synchronized after each FM 451 startup. The set software limit switches are only
monitored after synchronization.

Absolute encoders (SSI)

The axis is synchronized once the FM 451 has received a complete, error-free frame for the relevant
channel. The software limit switches are monitored from this point in time.

The absolute encoder must cover at least  the working range including the software limit switches.

Relationship: working range, encoder range, travel range

• The “working range” is the range you specify for your task using the software limit switches.

• The “encoder range” is the range covered by the encoder. With a linear axis, this is placed
symmetrically over the working range by the module; in other words, the module shifts the encoder
range so that the distances between the software limit switches and the ends of the encoder range
are the same (see figure).

• The “travel range” is the range of values that can be processed by the FM 451. It is dependent on the
resolution.

Address Name Type Initial
Value

Comment

4.0 EDGEDIST DINT L#0 Minimum edge-to-edge distance

Range:

• 0 to 1 000 000 000 �m at a 
resolution of � 1 �m/pulse

• 0 to 100 000 000 �m at a 
resolution of < 1 �m/pulse

With this machine data, you define a range after detection of the start of measurement when using edge
detection. If the end of the measurement is within this range, the measurement is rejected.
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8.5 Machine Data of the Encoder 

Definition

The encoder supplies position information (see Chapter 10, page 10-1) to the
module that evaluates the information and calculates an actual value based on the
resolution.

You can only be sure that the calculated actual value of the axis position matches
the actual axis position when the information in the machine data of the encoder is
correct.

Data in the Parameter DB

Address Name Type Initial Value Comment

20.0 ENC_TYPE DINT L#1 Encoder type and frame length :

Range of values:
1 = 5 V incremental
2 = 24 V incremental
3 = SSI 13-bit frame length
4 = SSI 25-bit frame length

With the “frame length”, you specify the clock frame output by the FM 451.

Address Name Type Initial Value Comment

24.0 DISP_REV DINT L#80000 Distance per encoder revolution :

Range of values:
1 �m  to  1 000 000 000 �m

With the machine data “distance per encoder revolution” you inform the FM 451 of the distance
covered by the drive system per encoder revolution.

The value “distance per encoder revolution” depends on how the axis is set up and how the encoder is
installed. You must take into account all transmission components such as couplings or gearing.

Section 8.7 (page 8-22) describes the relationship between the machine data “distance per encoder
revolution” and “increments per encoder revolution”.

Motor
Encoder

Gear unit

Motor

Encoder
Gear unit
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Address Name Type Initial Value Comment

32.0 INC_REV DINT L#500 Increments per encoder revolution :

Range of values:

1 to 225

The “increments per encoder revolution” machine data specifies the number of increments output by an
encoder per revolution. Based on this value and the machine data “distance per encoder revolution”, the
FM 451 can calculate the resolution.

Incremental encoders 

Any value from the range shown can be entered. One increment involves 4x decoding by the module
(see also Section  10.1, page 10-2).

Absolute encoders

For the limits there is a difference between the various encoder models: Only values in steps of a power
of two are allowed as input.

• Single-turn encoders with (number of revolutions = 1) 13-bit frame length:

– Minimum value = 4

– Maximum value = 8192

• Multiturn encoders (number of revolutions > 1) with 25-bit frame length:

– Minimum value = 4

– Maximum value = 8192

• Single-turn encoders with 25 bit frame length, no. of revs. = 1

– Minimum value = 4

– Maximum value  = 225

Linear scales are assigned parameters as follows as multiturn encoders:

• Increments per encoder revolution = 8192

• Number of revolutions × 8192 ≥ number of steps of the linear scale

Address Name Type Initial Value Comment

36.0 NO_REV DINT L#1 Number of encoder revolutions :

Range of values:

1 (single-turn encoder)

2 to  4096 in powers of 2 (multiturn encoder)

The machine data “number of encoder revolutions” is only used for absolute encoders. You use it to
define the number of revolutions possible with this encoder.

The total number of steps of the encoder does not belong to the machine data.

It is calculated as follows:

Total number of steps = increments per encoder revolution  ×  number of revolutions
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Address Name Type Initial Value Comment

40.0 BAUDRATE DINT L#0 Baud rate :
Range of values:
0 = 125 kHz
1 = 250 kHz
2 = 500 kHz
3 = 1000 kHz

With the baud rate machine data, you define the speed of the data transfer from SSI encoders to the
FM 451.

This entry has no significance for incremental encoders.

The maximum baud rate depends on the cable length: 

• 320 m 
 125 kHz

• 160 m 
 250 kHz

• 63 m 
 500 kHz

• 20 m 
 1000 kHz

Address Name Type Initial Value Comment

59.0 CNT_DIR BOOL FALSE Count direction :
0 = normal
1 = inverted

With the machine data “count direction”, you match the direction of the position detection to the direction
of axis movement.

You must also take into account all the directions of rotation of the transmission elements (for example
coupling and gearing).

• Normal = ascending count pulses (incremental encoder) or encoder values (absolute encoder)
correspond to ascending actual position values

• Inverted = ascending count pulses (incremental encoder) or encoder values (absolute encoder)
correspond to descending actual position values.
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Address Name Type Initial Value Comment

63.0
63.1
63.2

MON_WIRE
MON_FRAME
MON_PULSE

BOOL
BOOL
BOOL

TRUE
TRUE
TRUE

Monitoring functions :

1 = wire break
1 = frame error (must always be 1)
1 = missing pulses

Wire break  

When the monitoring is activated, the FM 451 monitors all cables with a 5 V incremental encoder and an
absolute encoder. The monitoring detects:

• Wire break

• Short circuit on the separate lines.

• Edge-to-edge distance of the count pulses (even with 24 V incremental encoders)

When monitoring with a 24 V incremental encoder, you must set a monitoring time MON_TIME > 0.

With 5 V incremental encoders without zero markers, you must either deactivate the wire break
monitoring or wire the signals N and N externally (see Section 10.1).

Frame error  

The module monitors the frame of an absolute encoder (SSI) for the following:

• Start and stop bit errors

Monitoring for frame errors cannot be deactivated with absolute encoders (SSI).

Missing pulses (incremental encoder)

An incremental encoder must always supply the same number of increments between two consecutive
zero markers.

The FM 451 checks whether the zero marker of an incremental encoder occurs at the correct encoder
status.

For encoders without zero markers, you must deactivate error pulse monitoring.

You must also deactivate wire break monitoring or connect the zero marker inputs N and N externally.
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8.6 Absolute Encoder Adjustment

Definition

With absolute encoder adjustment and the reference point coordinate, there is a
defined correlation between the range of values of the encoder and the coordinate
system of the axis.

Finding the Correct Absolute Encoder Adjustment

After the initial parameter assignment, further steps are necessary to establish the
correct relationship between the encoder and the coordinate system. The
procedure is illustrated using the parameter assignment dialogs.

1. Move the axis to a defined, reproducible point to which a unique coordinate is
assigned.

This could be, for example,the “end software limit switch”.

2. Call the “set reference point” job with the coordinate of the point defined in 1.

The FM 451 now calculates the correct absolute encoder adjustment for the
reference point coordinate in the machine data. This value is displayed in the
dialogs of the encoders and in the service dialog of the configuration software.

3. Save the parameter settings with the menu command File > Save .

4. Close the parameter dialogs with File > Exit .

5. Save the data in HW Config with Station > Save and Compile .

6. Download the data in HW Config to the CPU.

Note
You make this adjustment once during installation and startup. The FM 451 is
synchronized following parameter assignment during startup as soon as a
complete, error-free frame is received from the encoder following startup.

Data in the Parameter DB

Address Name Data
Type

Initial Value Description

44.0 REFPT DINT L#0 Reference point coordinate

Range:

• -1 000 000 000 �m to 1 000 000 000 �m at
a resolution of � 1 �m/pulse

• -100 000 000 �m to 100 000 000��m 
at a resolution of < 1 �m/pulse

48.0 ENC_ADJ DINT L#0 Absolute encoder adjustment :

Range:  0 to (225-1)



Machine Data and Incremental Dimensions

8-20
FM 451 Positioning Module

C79000-G7076-C451-02

Example of Absolute Encoder Adjustment
In the example, the following is assumed:

• Reference point coordinate = -125 mm

• Working range of SSW_STRT = - 1000 mm to SSW_END = 1000 mm

• Absolute encoder adjustment = 0

• Encoder range = 2048 increments with a resolution of 1 mm/pulse

• The absolute encoder used cannot be exactly adjusted mechanically and also
does not have the option of setting the encoder value.
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–125
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s

–1000 10000–125

Encoder value 0

Current

Encoder

Desired

1)

2)

1) Correlation between the coordinate system and the encoder values with the set abso-
lute encoder adjustment. The encoder value 0 corresponds to the actual value -125.

Required correlation of the coordinate system with the encoder. At this position the 
coordinate should be -125.

2)

0

Actual value

Result After Setting the Reference Point

After “set reference point”, the relationship is as follows:

The reference point coordinate on the axis (-125) is assigned to the encoder value
(1798) calculated from the absolute encoder adjustment.
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Absolute encoder adjustment 875
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1123

–1023 1024

The encoder supplies 2048 defined values. The working range is defined by the
software limit switches. Due to the selected resolution of 1 mm per pulse, the
encoder can, however, cover a larger working range than intended with the
software limit switches.

With the set resolution the working range is already covered with 2001 values.
Therefore, in the example there are 47 pulses “left over” which lie symmetrically
about the working range.

Alternative: Mechanical Adjustment of an Encoder

You can obtain a correct relationship between the coordinate system and the
encoder as follows:

1. Move the axis to a reproducible position (for example the software limit switch
start).

2. Enter this coordinate value in the machine data as the reference point
coordinate.

3. Read the encoder value displayed at this position in the service dialog of the
configuration software.

4. Enter this value as the absolute encoder adjustment in the machine data.

A correct actual value is then always displayed after parameters have been set.

Instead of steps 3. and 4., you can also set the encoder to zero with “Reset” (if this
exists) and enter the value “0” as the absolute encoder adjustment in the machine
data.
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8.7 Resolution

Definition

The resolution specifies the distance corresponding to one pulse . It is a measure
of the accuracy of the positioning and also determines the maximum possible
travel range of the FM 451.

The resolution (RES) is calculated as illustrated in the following table:

Incremental Encoders Absolute Encoders

Input
values

• Distance per encoder rev.
• Increments per encoder

revolution:
– Pulse evaluation: 4x

– 1 increment = 4 pulses

• Distance per encoder rev.
• Increments per encoder

revolution:
– 1 increment = 1 pulse

Calculatio
n RES�

dist
encoder rev

pulses
encoder rev

Note

All position information is rounded up to the integral multiple of the resolution. This
allows you to distinguish between the entered and the used values.

Range of Values of the Resolution

The selected system of units decides the range of values for the resolution:

System of
Units

Specified in... Range for the Resolution

mm 10-3 mm 0.1�10-3 .... 1000�10-3 mm/pulse

inches 10-4 inches 0.1�10-4 .... 1000�10-4 inches/pulse

degrees 10-4 degrees

10-3 degrees

10-2 degrees

0.1�10-4 .... 1000�10-4 degrees/pulse

0.1�10-3 .... 1000�10-3  degrees/pulse

0.1�10-2 .... 1000�10-2 degrees/pulse
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Example

• An incremental encoder has the following data:

– Increments per encoder revolution: 5000

– Distance per encoder revolution: 1000 mm

– 1 increment = 4 pulses

This results in the following resolution (4x decoding):

Resolution
1000 mm

=
5000 increments

= 0.2000
mm

increment 4 pulses
=

mm

0.0500
pulse

mm
=

0.2000

• An SSI encoder has the following data:

– Increments per encoder revolution: 4096

– Distance per encoder revolution: 1000 mm

– 1 increment = 1 pulse

This results in the following resolution:

Resolution
1000 mm

=
4096 increments

= 0.2441
mm

increment pulse

mm
= 0.2441

Relationship Between Travel Range and Resolution

The travel range is limited by the numeric representation in the FM 451. The
number representation varies depending on the resolution. Therefore, make sure
that you are always within the permissible limits when specifying values.

The maximum travel range is represented in the table below:

Resolution (RES) is in the range Maximum travel range

0.1 �m/pulse ≤ RES < 1 �m/pulse -108 �m to 108 �m (-100 m to + +100 m)

1 �m/pulse ≤ RES ≤ 1000 �m/pulse -109 �m to 109 �m (-1000 m to +1000 m)
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8.8 Incremental Dimensions

Definition

Incremental dimensions are targets that can be approached by the FM 451 in the
absolute/relative incremental approach  modes.

Requirements for Incremental Dimensions

The positioning target must be at a location corresponding to at least half the
target range before the software limit switch.

SLS SLE

Range in which targets may be locatedWorking
range

1 2

 1/2 target
range

1 2

TargetTarget

 1/2 target
range

No target may be located in this part of the working range.

0

Figure 8-1 Limits for Entry of Incremental Dimensions

8.8.1 Incremental Dimension Number 1 to 100

You can enter a maximum of 100 incremental dimensions in a table that are valid
both for the relative incremental approach  and the absolute incremental
approach  modes.

Note that the FM 451 does not allow any negative values for the relative
incremental approach . The values are interpreted by the FM 451 depending on
the direction of movement as positive or negative differences.

Note
The entry is made in the appropriate unit for the selected system of units. Make
sure that the decimal places are correct.
Example:

Incremental dimension 800 mm

Units 10-3 mm

Entry in the parameter DB 800000

Recommendation: Define separate ranges for relative and absolute increments in
the incremental dimension table.
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Data Used in the Channel DB

Address Name Type Initial Value Comment

35.4 TRGL1WR_EN BOOL FALSE 1 = write incremental dimension table 1
(incremental dimensions 1 ... 50)

35.5 TRGL2WR_EN BOOL FALSE 1 = write incremental dimension table 2
(incremental dimensions 51 ... 100)

36.6 TRGL1RD_EN BOOL FALSE 1 = read incremental dimension table 1
(incremental dimensions 1 ... 50)

36.7 TRGL2RD_EN BOOL FALSE 1 = read incremental dimension table 2
(incremental dimensions 51 ... 100)

Data Used in the Parameter DB

Address Name Type Initial Value Comment

120.0 TRGL1.TRG[1] DINT L#0 Incremental dimension number 1

.

.
.
.

.

.
.
. Incr. dim. table 1

316.0 TRGL1.TRG[50] DINT L#0 Incremental dimension number 50

320.0 TRGL2.TRG[51] DINT L#0 Incremental dimension number 51

.

.
.
.

.

.
.
. Incr. dim. table 2

516.0 TRGL2.TRG[100] DINT L#0 Incremental dimension number 100

8.8.2 Incremental Dimension Number 252

With incremental dimension number 252, you can move the drive initially in a
specific direction without a target (continuous travel) and to start a positioning
operation to the set target (incremental dimension) with the occurrence of an
external event (digital input xI3).

The entries in the parameter DB are valid for the switchover and switch-off
differences for this incremental dimension.
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Data Used in the Channel DB

Address Name Type Initial Value Comment

36.2 TRG252_254_EN BOOL FALSE 1 = write incremental dimension for
incremental dimension number 252 or
254

96.0 TRG252_254 DINT L#0 Incremental dimension for incremental
dimension number 252 or 254

Data Used in the Parameter DB

Address Name Type Initial Value Comment

100.0 CHGDIF_P DINT L#5000 Switchover difference plus

104.0 CHGDIF_M DINT L#5000 Switchover difference minus

108.0 CUTDIF_P DINT L#2000 Switch-off difference plus

112.0 CUTDIF_M DINT L#2000 Switch-off difference minus

8.8.3 Incremental Dimension Number 254

You can also use this incremental dimension number 254 to specify the distance
independent of the incremental dimension table. The entries in the parameter DB
are valid for the switchover and switch-off differences for this incremental
dimension.

Data Used in the Channel DB

Address Name Type Initial Value Comment

36.2 TRG252_254_EN BOOL FALSE 1 = write incremental dimension for
incremental dimension number 252 or
254

96.0 TRG252_254 DINT L#0 Incremental dimension for incremental
dimension number 252 or 254

Data Used in the Parameter DB

Address Name Type Initial Value Comment

100.0 CHGDIF_P DINT L#5000 Switchover difference plus

104.0 CHGDIF_M DINT L#5000 Switchover difference minus

108.0 CUTDIF_P DINT L#2000 Switch-off difference plus

112.0 CUTDIF_M DINT L#2000 Switch-off difference minus



Machine Data and Incremental Dimensions

8-27
FM 451 Positioning Module
C79000-G7076-C451-02

8.8.4 Incremental Dimension Number 255

Incremental dimension number 255 also allows you to set the distance.

You transfer the switch-off differences and the switchover differences together with
the incremental dimension. In contrast to the other incremental dimensions,
incremental dimension 255 uses the value for the switch-off and switchover
difference specified in the channel DB. The entries from the machine data have no
validity for this incremental dimension.

Data Used in the Channel DB

Address Name Type Initial Value Comment

36.3 TRG255_EN BOOL FALSE 1 = write incremental dimension for
incremental dimension number 255

100.0 TRG255 DINT L#0 Incremental dimension for incremental
dimension number 255

104.0 CHGDIF255 DINT L#0 Switchover differences for incremental
dimension number 255

108.0 CUTDIF255 DINT L#0 Switch-off differences for incremental
dimension number 255
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9.1 End of Positioning

Definition

The end of a positioning operation is indicated by the return signal WORKING = 0.
This can be achieved in three different ways:

• Final target approach

• Terminating

• Aborting

Monitoring Functions

In the last phase of a positioning operation, the following monitoring functions are
active:

• Monitoring time

The monitoring time is retriggered for the last time at the switch-off point and
ceases to be valid at the end of the positioning operation.

During this time, the end of the positioning operation must be reached,
otherwise the outputs are deactivated and the operating error “error in target
approach” (error number 5) is signaled.

• Monitoring of the target range

The FM 451 places a symmetrical range either side of a target which defines
the positioning accuracy of your application. The axis must become stationary
during a target approach within this range. Setting a value of “0” cancels the
tolerance during target approach.

• Monitoring of the stationary speed

The stationary speed is used to check that the drive becomes stationary within
the target range. After reaching the switch-off point, the drive is monitored to
detect when the speed falls below this setting.

The drive speed must fall below the stationary speed within the target range,
otherwise the FM 451 signals the operating error “target range passed” (error
number 10).

The speed falling below the stationary speed is monitored only once per target
approach.

Note that the speed can momentarily fall below the stationary speed used by
the module to detect the speed if the  positioning speed is extremely low (fewer
than 2 pulses per 8 ms).

• Monitoring of the stationary range

On completion of a positioning operation, a monitoring function detects whether
the drive remains stationary at the target position or whether it drifts away from
this position.

The stationary range is monitored
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– after the FM 451 has returned the “PEH” signal,

– when the monitoring time is exceeded,

– when the speed falls below the stationary speed.

If the drive leaves the stationary range without a valid travel job, the FM 451
indicates the operating error “stationary range exited” (error number 6).

Target Approach

In the “absolute/relative incremental approach” modes, the target approach begins
when the switch-off point is reached. At this point, the drive is turned off and the FM
451 starts the monitoring functions.

Depending on the monitoring functions you have activated, there are various
situations in which the return signal “PEH (POS_RCD)” is generated. Positioning is
aborted as soon as the generation of the “PEH (POS_RCD)” return signal does not
take place.

1. You have set the following parameters:

– Target range (TRG_RANGE) > 0

– Stationary speed (ZSPEED_L) > 0

– Monitoring time (MON_TIME) > 0

PEH is generated when the speed falls below the stationary speed and the
target range is reached. Which condition is satisfied first is irrelevant.

PEH is not generated when the actual value does not reach the target range
within the monitoring time or the target range is passed without the speed falling
below the stationary speed.

Target–1000 mm 1000 mm0

Switchover difference plus
Switch-off difference plus

1
2 3

4

Target range

Stationary range

vstationary speed

vcreep
5

6

t
Ü

Target range reached with vstill: PEH is set
Stationary speed reached

tm = monitoring time

1

2

3

4

5

6

Figure 9-1 Final Target Approach of an Incremental Approach
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2. You have set the following parameters:

– Target range (TRG_RANGE) > 0

– Stationary speed (ZSPEED_L) = 0

– Monitoring time (MON_TIME) > 0

PEH is generated when the target range is reached.

PEH is not generated if the actual value does not reach the target range within
the monitoring time.

Target
–1000 mm 1000 mm0

Switchover difference plus
Switch-off difference plus
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2 3
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Target range

Stationary range

vcreep
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Target range reached with vstill: PEH is set

tm = monitoring time

4

5

1

2

3

Figure 9-2 Final Target Approach of an Incremental Approach

3. You have set the following parameters:

– Target range (TRG_RANGE) = 0

– Stationary speed (ZSPEED_L) > 0

– Monitoring time (MON_TIME) > 0

PEH is generated when the speed falls below the stationary speed and the
target is reached.

PEH is not generated if the actual value does not reach the target during the
monitoring time or the target range is passed without the speed falling below
the stationary speed.
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Figure 9-3 Final Target Approach of an Incremental Approach

4. You have set the following parameters:

– Target range (TRG_RANGE) = 0

– Stationary speed (ZSPEED_L) = 0

– Monitoring time (MON_TIME) > 0

PEH is generated when the target is reached.

PEH is not generated if the actual value does not reach the target within the
monitoring time.

Target
–1000 mm 1000 mm0

Switchover difference plus
Switch-off difference plus

1
2 3

Stationary range

vcreep

4

t
Ü

Target reached: PEH is set

tm = monitoring time

1

2

3

4

Figure 9-4 Final Target Approach of an Incremental Approach
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5. You have set the following parameters:

– Target range (TRG_RANGE) ≥ 0

– Stationary speed (ZSPEED_L) ≥ 0

– Monitoring time (MON_TIME) = 0

In this situation, if the axis becomes stationary during positioning before the
target range is reached, the end of positioning is not detected. PEH is not
generated and the WORKING return signal remains set. You can abort the
positioning operation only by clearing the drive enable signal (DRV_EN = 0).

Terminating without a Specified Target

Terminating means that the positioning operation is stopped at the switching points
after changing from rapid to creep speed while maintaining the differences.

Positioning is terminated when

• The FM 451 receives a STOP signal (STOP=1)

• The “jogging” and “reference point approach” modes are exited

• When operator errors or operating error number 9 occur

The “PEH (POS_RCD)” return signal is not set. The sequences are analogous to
target approach.

–1000 mm 1000 mm0

Switchover diff. plus Switch-off diff. plus

1
2

3

1 2 3

vrapid

vcreep

End of 
positioning

Target range

e.g. STOP

Figure 9-5 End of Positioning
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Aborting

Aborting means that the positioning operation is stopped immediately changing
from rapid or creep speed to stationary ignoring the switchover and switch-off
differences. All the relevant outputs of the control mode are deactivated
immediately and the following settings made:

• Incremental dimension = actual value

• Remaining distance = zero

Positioning is aborted in the following situations:

• The drive enable signal is cleared (DRV_EN=0)

• The CPU changes to STOP

• Diagnostic errors or any operating errors except for operating error “target
range passed” (error number 9) occur.

The “PEH (POS_RCD)” return signal is not set in the “incremental approach”
mode.

If you have set the stationary speed parameter, the stationary monitoring becomes
active once the speed falls below the stationary speed. If you have not set the
stationary speed parameter, the stationary monitoring becomes active when the
outputs are deactivated.

vrapid

vcreep

Abort

Figure 9-6 Aborting a Positioning Operation

Data Used in the Parameter DB

Address Name Type Initial Value Comment

76.0 TRG_RANGE DINT L#1000 Target range

80.0 MON_TIME DINT L#2000 Monitoring time

84.0 ZSPEED_R DINT L#1000 Stationary range

88.0 ZSPEED_L DINT L#30000 Stationary speed

Return signals in the Channel DB

Address Name Type Initial Value Comment

23.1 WORKING BOOL FALSE 1 = positioning active

25.7 POS_RCD BOOL FALSE 1 = position reached
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9.2 Jogging Operating Mode

Definition
In the “jogging” mode, you move the drive in a specific direction by pressing a
button. You must install one button for each direction (plus and minus). You can
use the “jogging” mode both for a synchronized and for an unsynchronized axis.

Requirement

You have set the parameters for the axis.

Sequence of the “Jogging” Mode

1. Set the control signal for the “jogging” mode (MODE_IN=1).

2. Set the control signal for drive enable (DRV_EN=1).

3. Set the function switch for “do not evaluate enable input”
(EI_OFF=1) or wire up the enable input for the relevant channel.

4. Enter the start speed.

– Rapid speed (MODE_TYPE=1)

– Creep speed (MODE_TYPE=0)

5. Set the control signal for the direction of travel plus or minus (DIR_P=1 or
DIR_M=1).

6. Call FC ABS_CTRL.

xI2
Enable input

DIR_M; DIR_P

MODE_IN=1
Jogging

WORKING

vrapid

vcreep

s

DRV_EN
Drive enable

WAIT_EI

Figure 9-7 Example of the “Jogging” Mode
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Data Used in the Channel DB

Address Name Type Initial Value Comment

15.2 DIR_M BOOL FALSE 1 = direction minus

15.3 DIR_P BOOL FALSE 1 = direction plus

15.7 DRV_EN BOOL FALSE 1 = activate drive enable

16.0 MODE_IN BYTE B#16#0 1 = jogging

17.0 MODE_TYPE BYTE B#16#0 1 = rapid speed

0 = creep speed

23.0 ST_ENBLD BOOL FALSE 1 = start enabled

23.1 WORKING BOOL FALSE 1 = positioning active

23.2 WAIT_EI BOOL FALSE 1 = axis waiting for ext. enable

34.2 EI_OFF BOOL FALSE 1 = do not evaluate enable input

Terminating Jogging
The “jogging” mode is terminated in the following situations:

• When you release the “jogging” button (DIR_M or DIR_P=0)

• When the FM 451 receives a STOP signal (STOP=1)

• When the actual value of a synchronized linear axis reaches the limit of the
working range. Travel is then only possible in the opposite direction.

After terminating the positioning operation, travel can be continued in either
direction.

Aborting Jogging

The “jogging” mode is aborted in the following situations:

• When the drive enable signal is cleared (DRV_EN=0)

• A travel range limit is passed on a linear axis.

Monitoring Functions

In the “jogging” mode, the following monitoring functions are not active at the end
of the positioning:

• Monitoring of the stationary range

• Monitoring of the target range

• Monitoring of the stationary speed
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Working Range Limits of a Linear Axis
The limits for the “jogging” mode differ depending upon whether an axis is
synchronized or not.

Table 9-1 Jogging with a Synchronized and Non-Synchronized Axis 

Axis is not synchronized Axis is synchronized.

If the travel range limit is passed during jogging:
• the indicated actual value is no longer 

valid
• positioning is aborted.

1000 m

The indicated actual value is no longer 
valid

Jogging means positioning on targets located at a
distance from the software limit switches
corresponding to the entire target range.
The working range limits are calculated as follows:
• SLE-  1/2 target range  for the end of the linear

axis in the plus direction
• SLS+  1/2 target range  for the end of the linear

axis in the minus direction
If you do not release the button earlier, the FM 451
terminates at a target point which is located at a
distance corresponding to half the target range
before the relevant software limit switch. All ranges
required to ensure correct termination, are placed
around this target point by the FM 451.

SLEMaximum target

Part of the working range in which no target
position may be located.

1

2

3

Switchover diff. plus Switch-off diff. plus1 2 3 1/2 target range



Modes and Jobs

9-11
FM 451 Positioning Module
C79000-G7076-C451-02

9.3 Reference Point Approach Mode

Definition

With the “reference point approach” mode, you can synchronize the axis based on
a repeated external event.

Requirements

• An incremental encoder with zero marker.

• You have set parameters for the axis.

Connection Channel 1 Channel 2 Channel 3

Reference-point switch Digital input 1I0 Digital input 2I0 Digital input 3I0

The reference-point switch should be designed so that the drive
can brake reliably from rapid to creep speed in the region of the
switch.

Reversing switch Digital input 1I1 Digital input 2I1 Digital input 3I1

When you set the parameters, make sure that the start of the
reference point approach is set in the direction of the reversing
switch. Only then can you be sure that the reference-point switch
is always found.

Enable input Digital input 1I2 Digital input 2I2 Digital input 3I2

Sequence of the “Reference Point Approach” Mode

1. Enter the value for the reference point coordinate in the parameter DB
(REFPT).

2. Enter the type of “reference point approach” in the parameter DB.

Here, you have the following options:

Start in direction... For Synchronization use...

plus The first zero marker in the direction plus  after
leaving the reference point switch

REFPT_TYPE=0

plus The first zero marker in the direction minus
after leaving the reference point switch

REFPT_TYPE=1

minus The first zero marker in the direction plus  after
leaving the reference point switch

REFPT_TYPE=2

minus The first zero marker in the direction minus
after leaving the reference point switch

REFPT_TYPE=3
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3. Enter the start speed.

– Rapid (REFPT_SPD=0)

– Creep  (REFPT_SPD=1)

4. Write and activate the machine data.

5. Set the control signal for the “reference point approach” mode (MODE_IN=3).

6. Set the control signal for the drive enable (DRV_EN=1).

7. Set the function switch for “do not evaluate enable input”
(EI_OFF=1) or wire up the enable input for the relevant channel.

8. Set the control signal for the travel direction plus or minus or the start signal
(DIR_P=1, DIR_M=1 or START=1)

9. Call FC ABS_CTRL.

Table 9-2 Start Commands for a Reference Point Approach

Start
Command

Task Remark

DIR_P The drive starts in the direction of
more positive values; in other words,
it moves in the direction of the end of
the travel range.

If a negative direction is entered in
the machine data, the FM 451
signals an operating error. No
reference point approach is carried
out.

DIR_M The drive starts in the direction of
more negative values; in other
words, it moves in the direction of the
start of the travel range.

If a positive direction is entered in the
machine data, the FM 451 signals an
operating error. No reference point
approach is carried out.

START The drive starts in the direction
entered in the machine data.

Note

The following applies for a rotary axis: The reproducibility of the reference point is
only guaranteed if an integral ratio exists between the value end of rotary axis
and the value distance per encoder revolution .
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xI2
Enable input

MODE_IN=3
Ref. point approach

WORKING

Vrapid

Vcreep

s

DRV_EN
Drive enable

START;
DIR_M; DIR_P

Reference
point switch

Zero
marker

SYNC

*

* The start signals are reset by FC ABS_CTRL.

WAIT_EI

Figure 9-8 Example of the “Reference Point Approach” Mode

Data Used in the Channel DB

Address Name Type Initial Value Comment

15.0 START BOOL FALSE 1 = start positioning

15.2 DIR_M BOOL FALSE 1 = direction minus

15.3 DIR_P BOOL FALSE 1 = direction plus

15.7 DRV_EN BOOL FALSE 1 = activate drive enable

16.0 MODE_IN BYTE B#16#0 3 = reference point approach

23.0 ST_ENBLD BOOL FALSE 1 = start enabled

23.1 WORKING BOOL FALSE 1 = positioning active

23.2 WAIT_EI BOOL FALSE 1 = axis waiting for ext. enable
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Address CommentInitial ValueTypeName

25.0 SYNC BOOL FALSE 1 = axis is synchronized

34.2 EI_OFF BOOL FALSE 1 = do not evaluate enable input

Data Used in the Parameter DB

Address Name Type Initial Value Comment

44.0 REFPT DINT L#0 Reference-point coordinate

52.0 REFPT_TYPE DINT L#0 Type of reference point approach

99.0 REFPT_SPD BOOL TRUE Start speed for reference point approach 
0 = rapid
1 = creep

Effects of the Mode

• As soon as travel starts, the synchronization is canceled.

• The actual position is set to the value of the reference coordinate when the
“SYNC” return signal is set.

• The working range is fixed on the axis.

• The individual points within the working range retain their original value, are
however located at new positions.

Aborting the Reference Point Approach

The “reference point approach” mode is aborted in the following situations:

• The drive enable signal is cleared (DRV_EN=0),

• A travel range limit is overshot on a linear axis.
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Reference Point Approach Depending on the Start Position

The actual situation in a reference point approach depends on the following:

• the position of the drive at the start of a reference point approach

• the selected start direction

• the set position of the zero marker for the reference point switch.

Table 9-3 explains all the situations for REFPT_TYPE 0 and 1. The diagrams apply
analogously to REFPT_TYPE 2 and 3.

Table 9-3 Options for a Reference Point Approach 

Conditions for a Reference Point Approach Sequence of a Reference Point Approach

Example of a reference point approach
(REFPT_TYPE=0):

• Start direction is plus.

• Position of the zero marker from the reference
point switch is set in the plus direction.

vrapid

vcreep

REF

SYNC

Z

Start position

Example of a reference point approach
(REFPT_TYPE=1):

• Start direction is plus.

• Position of the zero marker from the reference
point switch is set in the minus direction.

vcreep

REF

SYNC

Z

Start position
R

-vcreep

vrapid

Example of a reference point approach
(REFPT_TYPE=0):

• The start direction must  be set in the plus
direction.

• Position of the zero marker from the reference
point switch is set in the plus direction.

• The reverse switch is more positive than the
reference-point switch.

REF

REV

vcreep

SYNC

-vcreep

Z

Start positionR

-vrapid

R = Direction
reversal

REF = Reference-point
switch

RS = Reversing
switch

Z = Encoder zero mark
SYNC = Synchronization was achieved
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Table 9-3 Options for a Reference Point Approach, continued

Conditions for a Reference Point Approach Sequence of a Reference Point Approach

Example of a reference point approach
(REFPT_TYPE=1):

• Start direction is plus.

• Position of the zero marker from the reference
point switch is set in the minus direction.

• Start position for the reference point approach
is at the reference-point switch. -vcreep

REF

SYNC

Z

Start position

Example of a reference point approach
(REFPT_TYPE=0):

• Start direction is plus.

• Position of the zero marker from the reference
point switch is set in the plus direction.

• The reverse switch is more positive than the
reference-point switch.

R

vcreep

REF

REV

SYNC
R

Z

Start position

-vcreep

vrapid

-vrapid

Example of a reference point approach
(REFPT_TYPE=0):

• Start direction is plus.

• Position of the zero marker from the reference
point switch is set in the plus direction.

• Start speed = creep speed

vcreep

REF

SYNC

Z

Start position

R = Direction
reversal

REF = Reference-point
switch

RS = Reversing
switch

Z = Encoder zero mark
SYNC = Synchronization was achieved
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9.4 Incremental Operating Mode

Definition

With the “incremental approach”, the FM 451 can do the following:

• Move the drive to absolute  targets,

• Move the drive relatively  by a distance in a specified direction.

The target or the relative distances are specified for the FM 451 as incremental
dimensions. You can enter a maximum of 100 incremental dimensions in a table
that are valid both for the relative incremental approach  and the absolute
incremental approach  modes. Regardless of the incremental dimension table,
you can specify the distance using the incremental dimension 254 and 155 (see
Section 8.8, page 8-24).

With incremental dimension 252, you can move the drive initially in a specific
direction without a target (continuous travel ) and start a positioning operation with
the occurrence of an external event (xI3).

Requirements

• You have set parameters for the axis.

• The axis must be synchronized.

• The incremental dimensions must exist on the module.

Interpretation of the Incremental Dimensions

Depending on which incremental approach you select, the FM 451 interprets the
information differently.

• Absolute incremental mode: The incremental dimensions are interpreted as an
absolute target position.

• Relative incremental mode: The incremental dimensions are interpreted as a
relative distance from the start position.

Note

For the ”relative incremental approach” mode, only positive incremental
dimensions are permitted. The sign for the incremental dimensions is obtained
from the specified direction DIR_P or DIR_M.
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Sequence of the “Incremental Approach” Mode with Incremental Dimension
Number 1 - 100

Absolute Incremental Approach Relative Incremental Approach

Incremental Dimension Number 1 - 100

1. Set the control signal for the “absolute
incremental approach” mode
(MODE_IN=5).

1. Set the control signal for the “relative
incremental approach” mode
(MODE_IN=4).

2. Enter the incremental dimensions in the tables (TRGL1; TRGL2).

3. Write the incremental dimension tables (TRGL1/2WR_EN=1).

4. Set the control signal for drive enable (DRV_EN=1).

5. Set the function switch for “do not evaluate enable input” (EI_OFF=1) or wire up the
enable input for the relevant channel.

6. Enter the incremental dimension number (MODE_TYPE=1...100).

7. Set the control signal:

• Linear axis:

– START: The only possible direction
is determined by the target and the
current actual value.

• Rotary axis

– START: The target is approached
along the shortest path.

– DIR_P; Start in plus direction

– DIR_M; Start in minus direction

7. Set the control signal:

• Linear axis:

– DIR_P; Start in plus direction

– DIR_M; Start in minus direction
 

• Rotary axis

– DIR_P; Start in plus direction

– DIR_M; Start in minus direction

8. Call FC ABS_CTRL.

Steps 2 and 3 are only required if no incremental dimensions already exist or if you want to
modify the existing incremental dimensions.

Sequence of the “Incremental Approach” Mode with Incremental Dimension
Number 252

Absolute Incremental Approach Relative Incremental Approach

Incremental Dimension Number 252

1. Set the control signal for the “absolute
incremental approach” mode
(MODE_IN=5).

1. Set the control signal for the “relative
incremental approach” mode
(MODE_IN=4).
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Absolute Incremental Approach Relative Incremental Approach

2. Set the control signal for drive enable (DRV_EN=1).

3. Set the function switch for “do not evaluate enable input” (EI_OFF=1) or wire up the
enable input for the relevant channel.

4. Enter the incremental dimension number (MODE_TYPE=252).

5. Enter the start speed.

– Rapid (SPEED252=1)

– Creep (SPEED252=0)

6. Enter the incremental dimension for incremental dimension number 252
(TRG252_254).

7. Set the trigger bit for writing the incremental dimension (TRG252_254_EN=1).

8. Set the control signal:

• Linear axis/rotary axis:

– DIR_P; Start in plus direction

– DIR_M; Start in minus direction

9. Call FC ABS_CTRL.

10. When an external event occurs (digital input xI3), positioning on the selected target
(incremental dimension) is started.

The actions listed as points 6 and 7 can only be executed during travel. In this case, the
FM 451 module approaches a target that is located at a distance corresponding to half the
target range until the incremental dimension is specified.

Sequence of the “Incremental Approach” Mode with Incremental Dimension
Number 254

Absolute Incremental Approach Relative Incremental Approach

Incremental Dimension Number 254

1. Set the control signal for the “absolute
incremental approach” mode
(MODE_IN=5).

1. Set the control signal for the “relative
incremental approach” mode
(MODE_IN=4).

2. Set the control signal for drive enable (DRV_EN=1).

3. Set the function switch for “do not evaluate enable input” (EI_OFF=1) or wire up the
enable input for the relevant channel.

4. Enter the incremental dimension number (MODE_TYPE=254).

5. Enter the incremental dimension for incremental dimension number 254
(TRG252_254).

6. Set the trigger bit for writing the incremental dimension (TRG252_254_EN=1).
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Absolute Incremental Approach Relative Incremental Approach

7. Set the control signal:

• Linear axis:

– START: The only possible direction
is determined by the target and the
current actual value.

• Rotary axis

– START: The target is approached
along the shortest path.

– DIR_P; Start in plus direction

– DIR_M; Start in minus direction

7. Set the control signal:

• Linear axis:

– DIR_P; Start in plus direction

– DIR_M; Start in minus direction
 

• Rotary axis

– DIR_P; Start in plus direction

– DIR_M; Start in minus direction

8. Call FC ABS_CTRL.

Sequence of the “Incremental Approach” Mode with Incremental Dimension
Number 255

Absolute Incremental Approach Relative Incremental Approach

Incremental Dimension Number 255

1. Set the control signal for the “absolute
incremental approach” mode
(MODE_IN=5).

1. Set the control signal for the “relative
incremental approach” mode
(MODE_IN=4).

2. Set the control signal for drive enable (DRV_EN=1).

3. Set the function switch for “do not evaluate enable input” (EI_OFF=1) or wire up the
enable input for the relevant channel.

4. Enter the incremental dimension number (MODE_TYPE=255).

5. Enter the incremental dimension for incremental dimension number 255 (TRG255).

6. Enter the value of the switchover difference for incremental dimension number 255
(CHGDIF255).

7. Enter the value of the switch-off difference for incremental dimension number 255 
(CUTDIF255).

8. Set the trigger bit for writing the incremental dimension, switch-off and switchover
difference (TRG255_EN=1).

9. Set the control signal:

• Linear axis:

– START: The only possible direction
is determined by the target and the
current actual value.

• Rotary axis

– START: The target is approached
along the shortest path.

– DIR_P; Start in plus direction

– DIR_M; Start in minus direction

9. Set the control signal:

• Linear axis:

– DIR_P; Start in plus direction

– DIR_M; Start in minus direction
 

• Rotary axis

– DIR_P; Start in plus direction

– DIR_M; Start in minus direction

10. Call FC ABS_CTRL.
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xI2
Enable input

MODE_IN=4/5
Incr. approach

WORKING

Vrapid

Vcreep

s

DRV_EN
Drive enable

START;
DIR_M; DIR_P

* The start signals are reset by FC ABS_CTRL.

*

WAIT_EI

POS_RCD
(PEH)

Figure 9-9 Example of the “Incremental Approach” Mode

Data Used in the Channel DB

Address Name Type Initial Value Comment

15.0 START BOOL FALSE 1 = start positioning

15.2 DIR_M BOOL FALSE 1 = direction minus

15.3 DIR_P BOOL FALSE 1 = direction plus

15.6 SPEED252 BOOL FALSE Start speed for incremental approach with
incremental dimension number 252
0 = creep speed
1 = rapid speed

15.7 DRV_EN BOOL FALSE 1 = activate drive enable

16.0 MODE_IN BYTE B#16#0 4 = relative incremental approach

5 = absolute incremental approach

17.0 MODE_TYPE BYTE B#16#0 Incremental dimension number 1 - 100,
252, 254 or 255

23.0 ST_ENBLD BOOL FALSE 1 = start enabled

23.1 WORKING BOOL FALSE 1 = positioning active

23.2 WAIT_EI BOOL FALSE 1 = axis waiting for ext. enable
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Address CommentInitial ValueTypeName

25.7 POS_RCD BOOL FALSE 1 = position reached

34.2 EI_OFF BOOL FALSE 1 = do not evaluate enable input

36.2 TRG252_254_EN BOOL FALSE 1 = write incremental dimension for
incremental dimension number 252 or 254

36.3 TRG255_EN BOOL FALSE 1 = write incremental dimension for
incremental dimension number 255

35.4 TRGL1WR_EN BOOL FALSE 1 = write incremental dimension table 1
(incremental dimension number 1 ... 50)

35.5 TRGL2WR_EN BOOL FALSE 1 = write incremental dimension table 2
(incremental dimension number 51 ... 100)

96.0 TRG252_254 DINT L#0 Incremental dimension for incremental
dimension number 252 or 254

100.0 TRG255 DINT L#0 Incremental dimension for incremental
dimension number 255

104.0 CHGDIF_255 DINT L#0 Switchover difference for incremental
dimension number 255

108.0 CUTDIF_255 DINT L#0 Switch-off difference for incremental
dimension number 255

Data Used in the Parameter DB

Address Name Type Initial Value Comment

100.0 CHGDIF_P DINT L#5000 Switchover difference plus

104.0 CHGDIF_M DINT L#5000 Switchover difference minus:

108.0 CUTDIF_P DINT L#2000 Switch-off difference plus

112.0 CUTDIF_M DINT L#2000 Switch-off difference minus

120.0 TRGL1.TRG[1] DINT L#0 Incremental dimension number 1

.

.
.
.

.

.
.
. Incr. dim. table 1

316.0 TRGL1.TRG[50] DINT L#0 Incremental dimension number 50

320.0 TRGL2.TRG[51] DINT L#0 Incremental dimension number 51

.

.
.
.

.

.
.
. Incr. dim. table 2

516.0 TRGL2.TRG[100] DINT L#0 Incremental dimension number 100
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Remaining Distance

The remaining distance is the difference between the target (incremental
dimension) and actual value. This is

• positive if the target has not yet been reached

• negative if the target has already been passed

Terminating an Incremental Approach
The “incremental approach” mode is terminated when the FM 451 receives a
STOP signal (STOP=1).

After the approach has been terminated, a remaining distance still remains.

The remaining distance can be traveled in a “relative incremental approach” and
“absolute incremental approach with incremental dimension number 252” in the
following situation:

• The operating mode is unchanged, and

• The incremental dimension number is unchanged,

• The direction is unchanged and

• The remaining distance is greater than the set switch-off difference.

You can travel the remaining distance by starting the “relative incremental
approach” or the “absolute incremental approach with incremental dimension
number 252” once again unchanged.

Aborting an Incremental Approach

The “incremental approach” mode is aborted when the “drive enable” signal is
cleared (DRV_EN=0).

Delete Remaining Distance

With the “delete remaining distance” job, you delete the current remaining
distance.

In an “incremental approach with incremental dimension number 252”, the axis
travels continuously after the remaining distance has been deleted.

If you start a different mode or start the mode in a different direction, you also
delete the current remaining distance.

Data Used in the Channel DB

Address Name Type Initial Value Comment

35.2 DELDIST_EN BOOL FALSE 1 = delete remaining distance
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9.5 Set Actual Value / Set Actual Value on-the-fly / Cancel Set
Actual Value

Definition

With the “set actual value/set actual value on-the-fly” job, you assign a new
coordinate to the current encoder reading. The working range is projected to a
different physical range on the axis.

You can calculate the offset of the working range as follows: ACTnew -ACTcurrent .

• ACTnew  is the new specified value

• ACTcurrent  is the actual value at the time of execution

Requirements

• You have set parameters for the axis.

• The axis must be synchronized.

Positioning must be completed to use “set actual value”.

Sequence of the Job

1. Enter the coordinate for the actual value (ACTnew) (AVAL, FVAL).

– Linear axis:

You must select an actual value so that the software limit switch is still within
the permitted travel range after the job has been called.

The value of the offset resulting from (ACTnew -ACTcurrent ) must be less
than or equal to the value of the permitted travel range (maximum 100 m or
1000 m).

– Rotary axis

The following rule must apply to the specified actual value:

0 ≤ actual value < end of rotary axis

2. Set the appropriate trigger bit (AVAL_EN=1, FVAL=1).

“Set actual value” is executed immediately.

“Set actual value on-the-fly” is executed at the next rising edge at digital input xI1.
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Data Used in the Channel DB

Address Name Type Initial Value Comment

35.7 AVAL_EN BOOL FALSE 1 = set actual value

36.0 FVAL_EN BOOL FALSE 1 = set actual value on-the-fly

84.0 AVAL DINT L#0 Coordinate for “set actual value”

88.0 FVAL DINT L#0 Coordinate for “set actual value on-the-fly”

Effects of the Job

Based on the example “set actual value” to 300 mm, you can see how the job
projects the working range to a particular position of the axis. It produces the
following effects:

• The actual position is set to the value of the actual value coordinate.

• The working range is offset on the axis.

• The individual points (for example software limit switch end) within the working
range retain their original value, are located, however, at new positions.

Table 9-4 Offset of the Working Range on the Axis by “Set Actual Value“

Set actual value. SLS ACT SLE

Projection of
the working

range by set
act al val e to

SLS ACT SLE

A
xi

s 0 500-500
100

[mm]

Old coordinate system

ng
 r

an
ge

-400 100 400

actual value  to
300 mm

0
300

-500

New coordinate system

500

SLEAC
T

SLS

W
or

ki
n

-400 300 400
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Canceling the Job

With the “cancel set actual value” job, you reset the last working range offset
caused by “set actual value”.

Once a “set actual value on-the-fly” job has been started, this can no longer be
cleared before execution by a rising edge at the digital input xI3. 
However, it can be overwritten by a new “set actual value on-the-fly” job. During a
module start up, these jobs are reset.

Data Used in the Channel DB

Address Name Type Initial Value Comment

35.3 AVALREM_EN BOOL FALSE 1 = cancel set actual value
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9.6 Zero Offset

Definition

With the “zero offset” job, you move the zero point in the coordinate system by the
value entered.

The sign determines the direction of the offset in the coordinate system.

Calculating the New Coordinate

All the values in the shifted coordinate system can be calculated according to the
following formula:

coordinate new = coordinate old  - (ZOFnew - ZOFold )

ZOFold  is any existing old zero offset.

If no zero offset was active before the call, use the value 0 for ZOFold .

This allows you to find out which coordinate values are adopted, for example, by
the software limit switches.

Requirements

• Positioning must be completed.

• You have set parameters for the axis.

Sequence of the Job

1. Enter the value for the zero offset (ZOFF).

– Linear axis:

The zero offset must be selected so that the software limit switch is still
within the permitted number range after the job is called.

– Rotary axis

The following rule must apply to the zero offset:

amount of zero offset ≤ end of the rotary axis

2. Set the corresponding trigger bit (ZOFF_EN=1).

Data Used in the Channel DB

Address Name Type Initial Value Comment

36.1 ZOFF_EN BOOL FALSE 1 = set zero offset

80.0 ZOFF DINT L#0 Zero Offset
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Effects of the Job on a Linear Axis

Based on the example of a zero offset of -200 mm, you can see that this job shifts
the coordinate system in a positive direction. It produces the following effects:

• The working range is not  physically shifted.

• New coordinate values (such as the software limit switches) are assigned to the
individual points.

Table 9-5 Coordinate System Shift Resulting from Zero Offset

Zero Offset SLS ACT SLE

SLS ACT SLE
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xi

s 0 500-500
200

[mm]

Old coordinate system

Coordinate shift
of 200 mmra
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-400 200 400

0
400

-500

New coordinate system

of 200 mm
resulting from
zero offset of
-200 mmW
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 r

500
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Effects of the Job on a Rotary Axis

Based on the example of a zero offset by -45°, you can see how this job turns  the
coordinate system:

0 �

180 �

0 �

180 �

Tool at ACT = 340 �

The zero point
turns through
-45 degrees. All
points on the
axis receive
new coordinate
values

Tool at ACT =
25 �

Figure 9-10 Rotation of the Coordinate System Resulting from a Zero Offset

Taking into account a ZOFold  = 0, a new value of 385° results.

Since the actual value starts again at 0 at the end of the rotary axis turning in the
positive direction, the real actual value of 25° is calculated as follows:

coordinate new = coordinate old  - (ZPOnew - ZPOold ) -end of rotary axis
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Loss of Synchronization

If synchronization is lost due to an error or is reset due to “reference point
approach”, a zero offset remains active.

Canceling the Job

By setting a zero offset of 0 mm, you reset an existing offset.
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9.7 Set Reference Point

Definition
With the “set reference point” job, you can synchronize the axis. The job shifts the
working range. All offsets resulting from set actual value are retained.

Requirement
• Positioning must be completed.

• You have set parameters for the axis.

Sequence of the Job

1. Enter the value for the reference point coordinate (REFPT).

– Linear axis:

The reference-point coordinate must not be located outside the software limit
switches. This also applies to the reference point coordinate in a shifted
coordinate system.

– Rotary axis

The following rule applies to the reference point coordinate:

0 ≤ reference point coordinate < end of the rotary axis

2. Set the corresponding trigger bit (REFPT_EN).

Data Used in the Channel DB

Address Name Type Initial Value Comment

25.0 SYNC BOOL FALSE 1 = axis is synchronized

35.6 REFPT_EN BOOL FALSE 1 = set reference point

92.0 REFPT DINT L#0 Reference point coordinate
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Effects of the Job
Based on the example of “set reference point” to 400 mm, you can see how this
job projects the working range to a specific physical position on the axis. It
produces the following effects:

• The actual position is set to the value of the reference-point coordinate.

• The working range is offset on the axis.

• The individual points (for example software limit switch end) retain their original
value but are located at new positions.

• The SYNC bit is set in the return signals.

Table 9-6 Shifting the Working Range on the Axis Using “Set Reference Point”

Set reference point SLS ACT SLE

Projection of
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range by Set
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Note on Absolute Encoders
This job is necessary for an absolute encoder adjustment (see section 8.6, page
8-19).
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9.8 Length Measurement/edge acquisition

Definition

With “length measurement” and “edge detection”, you can find out the length of a
workpiece.

The “length measurement” or “edge detection” function switches are and remain
active until you deactivate them again or until you select the other measurement
method. If you select both methods at the same time, FC ABS_CTRL activates the
length measurement.

Requirements

• Positioning must be completed.

• You have set parameters for the axis.

• The axis must be synchronized.

• A bounce-free  switch must be connected at input xI1.

• If these jobs are selected during a positioning operation, “length measurement”
and “edge detection” can only be executed with the next positioning operation.
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Sequence of the Jobs

Depending on the type of measurement, the FM 451 updates the data on the
module at different times. The FM 451 signals every update in a parameter on the
return interface.

Length Measurement Edge Detection

MSR_ON

xI3

Update data

MSR_DONE

EDGE_ON

xI3

Update data

MSR_DONE

1. Set the function switch for “length
measurement” (MSR_ON).

2. Start a positioning operation.
3. The rising edge at input xI3 starts the length

measurement.
4. The falling edge at input xI3 terminates a

measurement in progress. The FM 451 updates
the data start value, end value, and length.

5. With the MSR_DONE parameter set, the
FM 451 signals the updating of the data. The
parameter indicates that the measurement is
completed. The results of the measurement can
be read out.

6. The start of another measurement with the
rising edge at xI3 resets the MSR_DONE
parameter.

1. If necessary, enter a value for the minimum
edge-to-edge distance (EDGEDIST) in the
parameter DB. Write and activate the machine
data.

2. Set the function switch for “edge detection”
(EDGE_ON). The MSR_DONE parameter is
set.

3. Start a positioning operation.
4. The rising edge at input xI3 starts the

measurement. After traveling the distance
“minimum edge-to-edge distance” the
measurement is valid. This is indicated by
MSR_DONE=0. The results of the
measurement are updated and can be read out,
the start of the measurement is entered; the
end value and length become -1.

5. After the update, the FM 451 signals the
change by resetting the MSR_DONE
parameter.

6. The falling edge at input xI3 terminates a
measurement in progress. The FM 451 updates
the data for end value of the measurement and
length.

7. After the update, the FM 451 signals the
change by setting the MSR_DONE parameter.
The results of the measurement can be read
out.

8. The start of another measurement with the
rising edge at xI3 resets the MSR_DONE
parameter.

Data Used in the Parameter DB
Address Name Type Initial Value Comment

4.0 EDGEDIST DINT L#0 Minimum edge-to-edge distance for edge
detection

If the end of the measurement is within this range, the measurement is discarded (BEG_VAL, END_VAL
and LEN_VAL=-1).
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Data Used in the Channel DB

Address Name Type Initial Value Comment

25.1 MSR_DONE BOOL FALSE 1= length measurement/edge detection completed

34.3 EDGE_ON BOOL FALSE 1 = edge detection on

34.4 MSR_ON BOOL FALSE 1 = length measurement on

35.0 MDWR_EN BOOL FALSE 1 = write machine data

35.1 MD_EN BOOL FALSE 1 = activate machine data

37.0 MSRRD_EN BOOL FALSE 1 = read measured values

136.0 BEG_VAL DINT L#0 Start value of length measurement/edge detection

140.0 END_VAL DINT L#0 End value of length measurement/edge detection

144.0 LEN_VAL DINT L#0 Length

Conditions for Length Measurement

• The distance between the off edge and on edge at input xI3 must be large
enough so that your program on the CPU can evaluate the measurement result
correctly before a new measurement begins.

• The minimum interval between the rising and the falling edge at input xI3 as
well as between the falling and the next rising edge at input xI3 must be greater
than 8 ms.

Incorrect Measurement

If a length measurement / edge detection is incorrect, the FM 451 returns the value
-1 for the length. A length measurement error occurs when:

• The measured length of a rotary axis is greater than 231.

• The on and off edge are detected at the same time by the FM 451 (for example
due to switch bounces).
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9.9 Loop Traverse

Definition

With “loop traverse”, you specify the direction in which a target will be approached
with force contact. You can use the loop traverse when force contact between the
motor and the axis can only be ensured in one direction.

A target which is approached against the specified direction is first overshot. The
FM 451 then reverses the direction and approaches the target in the specified
direction.

Requirements

• You have set parameters for the axis.

• The axis must be synchronized.

• In a loop traverse in a direction opposite to the direction to the target, the
maximum target position is as follows:

– in the plus travel direction

target � SLE - 1/2 target range - switch-off difference plus - switchover
difference minus

– in the minus travel direction

target � SLS + 1/2 target range + switch-off difference minus +
switchover difference plus

• A loop traverse is not  executed if the target is approached in the direction of
the loop traverse. In this case, an incremental approach without direction
reversal is executed.

• The sequence of the “incremental approach” mode must be familiar (see
Section 9.4, page 9-17).

Sequence of Loop Traverse

1. Set the control signal for the “absolute/relative incremental approach” mode
(MODE_IN=4/5).

2. Set the control signal for drive enable (DRV_EN=1).

3. Set the function switch for “do not evaluate enable input”
(EI_OFF=1) or wire up the enable input for the relevant channel.

4. Enter the incremental dimension number (MODE_TYPE=1...100, 254, 255).
The incremental dimension number 252 is not permitted here.

5. Set the function switch (PLOOP_ON / MLOOP_ON=1).

6. Start the incremental approach
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Data Used in the Channel DB

Address Name Type Initial Value Comment

15.0 START BOOL FALSE 1 = start positioning

15.2 DIR_M BOOL FALSE 1 = direction minus

15.3 DIR_P BOOL FALSE 1 = direction plus

15.7 DRV_EN BOOL FALSE 1 = activate drive enable

16.0 MODE_IN BYTE B#16#0 4/5= relative/absolute incremental
approach

17.0 MODE_TYPE BYTE B#16#0 Incremental dimension number 1 - 100 or
254 or 255

34.0 PLOOP_ON BOOL FALSE 1 = loop traverse in plus direction

34.1 MLOOP_ON BOOL FALSE 1 = loop traverse in minus direction

34.2 EI_OFF BOOL FALSE 1 = do not evaluate enable input

Fictitious Target

If you start positioning with a target that is located in the direction opposite to that
set for the loop traverse, the FM 451 calculates a fictitious target for this target at
which it reverses direction and then approaches the target in the correct direction.

This fictitious target must  be located at a position corresponding to at least half the
target range before the relevant software limit switch.

The distance between the fictitious target and the set target is calculated
depending on the direction:
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Table 9-7 Calculating the Location of the Fictitious Target for a Loop Traverse 

Settings Location of the Fictitious Target

Parameter settings:
Loop + (force contact plus)
and travel in minus direction.

The fictitious target (target f ) has the value:
Target f = target - switch-off difference minus - switchover
difference plus 

Start positionTargetFictitious target0

Parameter settings:
Loop - (force contact minus)
and travel in the plus direction.

The fictitious target (target f ) has the value:
Target f = target + switch-off difference plus + switchover
difference minus

Start position Target Fictitious target0

Example

Based on a positioning operation with a loop traverse in the plus direction to a
maximum destination, we can illustrate the location of the fictitious target.

Switchover diff. minus Switch-off diff. plus1

2 3

½ target range

1

2

Target

-vcreep

3

Change
of

direction

vrapid

Vcreep

Software limit switch
 end

Fictitious
target

Figure 9-11 Loop Traverse in the Plus Direction to a Maximum Target
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9.10 Enable input

Definition

The enable input is an external input with which a positioning operation can be
executed as a result of an external event.

Evaluating the Enable Input (EI_OFF=0)

The relevant enable input (xI2) must be wired for the channel.

This allows you to prepare the start of a positioning operation. 
You start the positioning operation independent of the execution of your user
program by applying a “1” signal to the enable input.

You have the following options as to how the enable input is evaluated:

• level-triggered (EI_TYPE=0)

– Travel starts when you apply a “1” signal at the enable input and is stopped
when you apply a “0” signal to the enable input.

• edge-triggered (EI_TYPE=1)

– Travel begins when a rising edge is detected at the enable input.
Subsequent signal changes at this input no longer affect the travel that has
started.

Do Not Evaluate Enable Input (EI_OFF=1)

When you deactivate the evaluation of the enable input, an operating mode starts
immediately after detection of the start signal. It is then not possible to prepare an
operating mode and to start it at a defined later point in time.

Data Used in the Channel DB

Address Name Type Initial Value Comment

34.2 EI_OFF BOOL FALSE 1 = do not evaluate enable input

Data Used in the Parameter DB

Address Name Type Initial Value Comment

99.1 EI_TYPE BOOL FALSE 0 = level-triggered

1 = edge-triggered
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9.11 Read Position Data

Definition

With the “read position data” job, you can read the incremental dimension,
remaining distance, and speed at the current time.

Sequence of the Job

1. Set the trigger bit in the channel DB (ACTSPD_EN=1).

2. The data are stored in the channel DB.

Data Used in the Channel DB

Address Name Type Initial Value Comment

37.1 ACTSPD_EN BOOL FALSE 1 = read position data

112.0 ACTSPD DINT L#0 Current speed

116.0 DIST_TO_GO DINT L#0 Remaining distance

120.0 ACT_TRG DINT L#0 Current incremental dimension
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9.12 Read Encoder Data

Definition

With the “read encoder data” job, you read the current data of the encoder and the
value of the absolute encoder adjustment.

Requirements

You can read out the value for the absolute encoder adjustment after executing the
“set reference point” job (see Section 8.6, page 8-19).

Sequence of the Job

1. Set the trigger bit in the channel DB (ENCVAL_EN=1).

2. The data are stored in the channel DB.

Data Used in the Channel DB

Address Name Type Initial Value Comment

37.2 ENCVAL_EN BOOL FALSE 1 = read encoder values

124.0 ENCVAL DINT L#0 Encoder actual value (internal representation)

128.0 ZEROVAL DINT L#0 Last zero marker value (internal representation)

132.0 ENC_ADJ DINT L#0 Absolute encoder adjustment
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9.13 Return Signals for Positioning

Definition

With the “return signals for positioning”, you are informed of the current status of
the positioning operation.

Sequence 

The data are stored in the channel DB whenever FC ABS_CTRL is called.

Data Used in the Channel DB

Address Name Type Initial Value Comment

23.0 ST_ENBLD BOOL FALSE 1 = start enabled

23.1 WORKING BOOL FALSE 1 = positioning active

23.2 WAIT_EI BOOL FALSE 1 = axis waiting for ext. enable

23.4 SPEED_OUT BOOL FALSE 0 = creep speed

1 = rapid speed

23.5 ZSPEED BOOL FALSE 1 = axis is in the stationary range

23.6 CUTOFF BOOL FALSE 1 = axis is located in the switch-off range

23.7 CHGOVER BOOL FALSE 1 = axis is located in the switchover range

24.0 MODE_OUT BYTE B#16#0 Active mode

25.2 GO_M BOOL FALSE 1 = axis travels in minus direction

25.3 GO_P BOOL FALSE 1 = axis travels in plus direction

25.5 FVAL_DONE BOOL FALSE 1 = set actual value on-the-fly completed

25.7 POS_RCD BOOL FALSE 1 = position reached

26.0 ACT_POS DINT L#0 Actual position (actual position of the axis)
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9.14 Return Signals for Diagnostics

Definition

The “return signals for diagnostics” job informs you of diagnostic events that have
occurred.

Sequence

1. When the module enters a new event in the diagnostic buffer, it sets the DIAG
bit in all channels. Whenever an error occurs belonging to any of the error
classes listed in Appendix C, an entry is made in the diagnostic buffer. If you
delete the diagnostic buffer, the DIAG bit is also set.

2. If it is not possible to call a mode or to control an active mode or if an error
occurs attempting either of these actions, the module sets an operator error
(OT_ERR). The cause of the error is entered in the diagnostic buffer. As long
as the operator error is set, you can neither start a new mode nor continue the
stopped mode. You acknowledge an operator error with OT_ERR_A=1.

3. If the module recognizes a write job with incorrect data, it sets the DATA_ERR
bit. The cause of the error is entered in the diagnostic buffer.

4. The return signals are stored in the channel DB.

5. Once the diagnostic buffer has been read, the module resets the DIAG bit to 0
in all channels.

Data Used in the Channel DB

Address Name Type Initial Value Comment

22.2 DIAG BOOL FALSE 1 = diagnostic buffer modified

22.3 OT_ERR BOOL FALSE 1 = operator error

22.4 DATA_ERR BOOL FALSE 1 = data error
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10.1 Incremental Encoders 

Connectable Incremental Encoders

Incremental encoders with two pulses electrically offset by 90° with or without zero
markers are supported:

• Encoders with asymmetric output signals with 24 V level

– Cut-off frequency = 50 kHz:

– max. 100 m line length.

• Encoders with symmetric output signals with 5 V differential interfaces
conforming to RS-422

– Cut-off frequency = 500 kHz

– At 5 V supply voltage: max. 32 m line length.

– At 24 V supply voltage: max. 100 m line length.

Note

If the encoder (5 V) does not output a zero marker signal and you have activated
the wire-break monitoring, you must connect the zero marker inputs N and N
externally so that these inputs have a different level (for example, N at 5V, N at
chassis).

Signal Shapes

Figure 10-1 illustrates the signal shapes from encoders with asymmetric and and
symmetric output signals.

asymmetric symmetric

A*

B*

N*

A

B

N

A

B

N

Figure 10-1 Signal Waveforms from Incremental Encoders
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Signal Evaluation

Increments

An increment identifies a signal period of the two encoder signals A and B. This
value is listed in the specifications of an encoder and/or on its type label.

A

B

4x decodingPulses

Signal period= Increment

1 2 3 4

Figure 10-2 Increments and Pulses

Pulses

The FM 451 evaluates all 4 edges of the signals A and B (see figure) in each
increment (4x decoding).

1 increment (from encoder)� 4 pulses (FM evaluation)

Reaction Times

With incremental encoders connected, the FM 451 has the following reaction
times:

Reaction time = switching time of the connecting switching elements

Note

You can compensate the minimum reaction time by appropriate parameter
settings for the switchover and switch-off differences.

Unsharpness

Unsharpness affects the positioning accuracy. With incremental encoders the
unsharpness is negligible.
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10.2 Absolute Encoders

Single-turn and Multiturn Encoders

Absolute encoders are grouped as follows:

• Single-Turn Encoders

Single-turn encoders cover the total measuring range in one encoder revolution.

• Multiturn Encoders

Multiturn encoders cover the measuring range in a number of encoder
revolutions.

Connectable Absolute Encoders

Absolute encoders with a serial interface are supported. Position information is
transferred synchronously using the SSI protocol (synchronous serial interface).
The FM 451 supports only GRAY code. Due to the arrangement of the data bits in
the transferred frames, the data formats 25-bit (“fir tree”), and 13-bit (“half fir tree”)
are used.

Encoder Type Frame Length

Single-turn

Single-turn

Multiturn

13 bits

25 bits

25 bits

Data Transfer

The baud rate for the data transfer depends on the cord length (see Appendix A,
Technical Specifications).

Pulse Evaluation with Absolute Encoders

1 increment (from encoder)� 1 pulse (FM evaluation)
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Reaction Times

With absolute encoders, the FM 451 has the following reaction times:

Minimum reaction time = frame run time + switching time of the connected switching elements

Maximum reaction time = 2 × frame run time + monoflop time + switching time of the connected switching elements

With programmable absolute encoders:

Maximum reaction time = frame run time + monoflop time + switching time of the connected switching elements
+1/max. step train frequency

Monoflop Time

The monoflop time is 64 �s.

Encoders with values higher than the limit shown here are not permitted.

Frame Run Times

The frame run times depend on the baud rate:

Baud Rate Frame Transfer Time (13-bit) Frame Transfer Time (25-bit)

0.125 MHz 112 �s 208 �s

0.250 MHz 56 �s 104 �s

0.500 MHz 28 �s 52 �s

1.000 MHz 14 �s 26 �s

Example of Reaction Times

This example shows how to calculate the minimum and maximum reaction time.
The encoder in the example is not prgrammable.

• Hardware switching time: approx. 150 µs

• Frame transfer time: 26 µs at 1 MHz baud rate (25-bit frame)

• Monoflop time: 64 µs

Minimum reaction time = 26 µs + 150 µs = 176 µs

Maximum reaction time = 2 × 26 µs + 64 µs + 150 µs = 266 µs

Note

You can compensate the minimum reaction time by appropriate parameter
settings for the switchover and switch-off differences.
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Unsharpness

Unsharpness is the difference between the maximum and minimum reaction time.
With an Absolute encoder it is as follows:

Unsharpness = frame transfer time + monoflop time

With programmable absolute encoders:

Unsharpness =  frame run time + monoflop time + 1/max. step train frequency
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11.1 Options for Displaying and Evaluating Errors

You can obtain information on errors in the following ways:

• Observing the error LEDs on the module. 
The meaning of the error LEDs is explained in Section 11.3 (page 11-3).

• Connect your programming device with the CPU and open the error evaluation
dialog of the configuration software. The current (error) state of the module is
displayed along with the error class, error number and a plain language
explanation. When necessary, you can update the display by clicking the
“Update” button. 
The causes of the displayed error messages and possible remedies are
explained in the error list in Appendix C.5 (page C-14).

• Write a detailed error evaluation routine in your user program (see Section 11.4,
page 11-4) or a reaction to a diagnostic interrupt (see Section 11.4 and 11.7).

• To display errors on an OP: Read out the diagnostic buffer of the module
cyclically in your user program (see Figure 11-2). Evaluate the diagnostic DB on
the OP. The meaning of the error class and error number is explained in the
error list in Appendix C.5 (page C-14).

Deleting the Diagnostic Buffer

To give you a better chronological overview of the error messages, the FM 451
allows you to delete the diagnostic buffer completely. This is, however, only
possible when a positioning operation has been completed and when you have set
parameters for the channel.

11.2 Types of Error

11.2.1 Synchronous Errors

These errors occur at the same time as a job or the start of a positioning operation.
Synchronous errors are operator errors (error class 2), data errors (error class 4),
machine data errors (error class 5), incremental dimension table errors (error class
6) (refer to the error list in Appendix C.5, page C-14).

11.2.2 Asynchronous Errors

These errors occur during operation as a result of external events. These errors
trigger a diagnostic interrupt. Asynchronous errors include operating errors (error
class 1) and diagnostic errors (error class 128) (refer to the error list in Appendix
C.5, page C-14).
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11.3 Meaning of the Error LEDs 

The status and error LEDs indicate various error states. The LEDs are lit, even
with errors that occur briefly, for at least 3 seconds.

INTF

EXTF

Figure 11-1 Status and Error Indicators of the FM 451

Indicator Meaning Explanation

INTF (red)

LED - ON

Group error for
internal errors

This LED display the following fault/error status of the FM 451:

• a module defect

• an internal (channel) error

• The FM 451 is not configured. Configure the module.

EXTF (red)

LED - ON

Group error for
external errors

This LED indicates an external (channel) error.
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11.4 Displaying Errors on an OP

Figure 11-2 shows the structure of a user program as illustrated in Figure 6-2 with
extra functions for reading out the diagnostic buffer for display on an OP. FC DIAG
stores the diagnostic buffer in a DB that can be displayed by the OP.

Initialization: 
Call FC ABS_INIT 

Set job data and job trigger bits 
Set control signals 

Read out the diagnostic buffer of the module: 
Call FC ABS_DIAG 

Call FC ABS_CTRL 
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Are jobs still
unfinished?

Yes

No

<0 =0 >0

General
non-specified

reaction to:
 data error,

programming error

Evaluate

data of read jobs 

and return signals

Next job

Next cycle

If applic.

Error Jobs done Jobs being 
processed

Evaluate return value (RET_VAL) of FC ABS_CTRL

Figure 11-2 Program Structure with Diagnostic Display for an OP
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11.5 Error Evaluation in the User Program

In your user program, you can plan specific reactions to errors. The following data
are available for this purpose:

• The return values (RET_VAL) of the linked standard FCs: 
This value is refreshed each time the block is called. 
RET_VAL = -1 is a group indicator for a synchronous error in a job or in the
communication of the module.

• Each job has an error bit (_ERR) as a group indicator for an error in the job or
in one of its predecessors in a chain of jobs: 
The error bit is set for a write job and for the subsequent jobs if a data error was
indicated by the module or if a communication error occurred. 
In read jobs, the error bit is set for the job affected if a communication error
occurred. 
The error bits are set again by FC ABS_CTRL after a job has been executed.
They should be reset however by the user program to allow error evaluation.

• The return signal DATA_ERR is a group indicator for an error detected by the
module in a write job. The signal is updated with the next write job.

• The return signal OT_ERR (operator error) is used as a group indicator for an
error detected by the module when a travel operation is started. The error must
be acknowledged after it has been eliminated by setting OT_ERR_A=1.

• The return signal DIAG is set when the content of the diagnostic buffer
changes. This signal can be set later as the signals DATA_ERR and OT_ERR.

• The communication error JOB_ERR contains an error code for a
communication problem between the FC and module (refer to the list of
JOB_ERR messages in Appendix C.4). The value is updated after a job has
been executed and stored by FC ABS_CTRL in the channel DB and by FC
ABS_DIAG in the diagnostic DB.

• FC ABS_DIAG for reading out the diagnostic buffer of the module. Here, you
can find out the causes of errors for synchronous and asynchronous events.

• Diagnostic interrupts for fast reaction to events in the diagnostic interrupt OB
(OB82).

Figure 11-3 shows a possible program structure with which you can react to the
return signals “Data Error” (DATA_ERR), “Operator Error” (OT_ERR) and the error
bits of the jobs (_ERR).



Diagnostics

11-6
FM 451 Positioning Module

C79000-G7076-C451-02

< 0 = 0 > 0

Communication error
JOB_ERR < 0?

No

Reaction to possible causes:
DB not loaded

DB too short
Incorrect DB number

Gen. programming error

Data error
DATA_ERR = 1?

Yes

Job-specific error reaction
No

For all the jobs sent for a chain:
Evaluate error and done bits

_ERR = 1 and
_D = 1

(this job involved 
an error)

_ERR = 1 and
_D = 0

(this job was aborted
due to an

earlier job with
an error)

_ERR = 0 and
_D = 1

(job without error)

Poss. job-specific 
error reaction, repetition,

restart

Operator errors
OT_ERR = 1 ?

Yes

NoReaction to operator error

Call FC ABS_CTRL

Yes

Evaluate return value (RET_VAL) of FC ABS_CTRL

Figure 11-3 User Program with Evaluation of the Error Bits of the Jobs
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Figure 11-4 shows a possible program structure with which you can evaluate all
errors based on the entries in the diagnostic DB. This allows you to react in the
program when one or more new errors are entered in the diagnostic buffer of the
module. Several possible programmed reactions are shown in detail in Figures
11-5 to 11-8.

< 0 = 0 > 0

Reaction to possible causes:
Causes:

DB not loaded
DB too short

Incorrect DB number
Gen. programming error

Evaluate current entries in the diagnostic DB
see Figures 11–5 to 11–8

Call FC ABS_DIAG

Diagnostic buffer
modified

(DIAG=1 or
diagnostic memory bit=1) ?

Set diagnostic memory bit to 1

Yes

Set diagnostic memory bit to 0

Call FC ABS_CTRL

No

Next cycle

Evaluate return value (RET_VAL) of FC ABS_DIAG

Figure 11-4 User Program with Complete Evaluation using the Diagnostic DB
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Start specific reaction to error based on the error number

Data error
DATA_ERR = 1 ?

Search in diagnostic DB for error class 4, 5, 6

Yes

No

Figure 11-5 Possible Evaluation of a Data Error

Start specific reaction to error based on the error number
Acknowledge operator error

Operating errors.
OT_ERR = 1 ?

Search for error class 2 in the diagnostic DB

Yes

No

Figure 11-6 Possible Evaluation of an Operator Error
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Start specific reaction to error based on the error number

Identifier from 
diagnostic interrupt set ?

Search for error class 1, 128 in diagnostic DB

Yes

No

Figure 11-7 Possible Evaluation of a Diagnostic Interrupt

Start specific reaction to error based on the error number

Error class, error number,
Channel, ...

= specified values ?

Yes

No

Figure 11-8 Possible Evaluation of Specifically Selected Error
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11.6 Diagnostic Buffer of the Module

The diagnostic buffer of the module contains a maximum of 9 diagnostic entries
and is organized as a ring buffer.

A diagnostic event is written to the buffer when a message (error) “entering state”
is detected. This can be a synchronous error (data error, operator error) or an
asynchronous error (operating error, diagnostic error). One problem can also
cause several entries as follow-on errors. Messages for events “leaving state” do
not cause entries in the diagnostic buffer.

The following is specified for each diagnostic event:

• Status (always entering state)

• Internal error

• External error

• Error class

• Error number

• Channel number

• Incremental dimension number (for incremental dimension errors)

If a diagnostic event is written to the diagnostic buffer, the return signal DIAG=1 is
set in all channels being used.

The entire diagnostic buffer can be transferred to a data block (diagnostic DB)
using FC ABS_DIAG or displayed in the error evaluation dialog of the configuration
software. If the diagnostic buffer is read, the module sets the return signal
DIAG=0.

Note
If the diagnostic buffer is read simultaneously by FC ABS_DIAG and the error
evaluation dialog, it is possible that a newly entered diagnostic event is not
detected by the program.



Diagnostics

11-11
FM 451 Positioning Module
C79000-G7076-C451-02

11.7 Diagnostic Interrupts

Interrupt Handling

The FM 451 can trigger diagnostic interrupts. You service these interrupts in an
interrupt OB. If an interrupt is triggered and the corresponding OB is not loaded,
the CPU changes to STOP (refer to the manual Programming with STEP 7).

You enable the servicing of diagnostic interrupts as follows:

1. Select the module in HW Config

2. Using the menu command Edit > Object Properties > Basic Parameters  ,
enable diagnostic interrupts.

3. Save and compile the hardware configuration.

4. Download the hardware configuration to the CPU.

Overview of the Diagnostic Interrupts

The following events and errors trigger a diagnostic interrupt:

• Operating error

• Incorrect machine data (when parameters assigned with SDB)

• Diagnostic errors

These errors are explained in detail in Appendix C.5.

Reaction of the FM 451 to an Error with a Diagnostic Interrupt
• Positioning is aborted.

• The synchronization is deleted with the following diagnostic interrupts:

– Front connector not plugged in, no external auxiliary supply for the encoder,

– A zero marker error was detected, cable fault (5 V encoder signals)

– The travel range was exceeded (indicated by an operating error)

– Set actual value cannot be executed (indicated by an operating error).

• With one exception, the control signals START, DIR_P and DIR_M are no
longer processed

Exception:

If an operating error occurs, jogging in the direction of the working range is
possible.

• Function switches and jobs continue to be processed.
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The FM 451 detects an error ( “ entering state”)

A diagnostic interrupt is “entering state” if at least one error is pending. If only
some of the errors are eliminated, the remaining pending errors are signaled again
as “entering state”.

Sequence:

1. The FM 451 detects one or more errors and initiates a diagnostic interrupt. One
of the LEDs “INTF” or “EXTF” lights up. The error is entered in the diagnostic
buffer.

2. The CPU operating system calls OB 82.

3. You can evaluate the start information of OB82.

4. With the OB82_MOD_ADDR parameter, you can see which module triggered
the interrupt.

5. You can obtain further information by calling FC ABS_DIAG.

The FM 451 detects that an error state is cleared (“leaving state”) 

A diagnostic interrupt is then only “leaving state” if the last error on the module has
been rectified.

Sequence:

1. The FM 451 detects that all errors have been rectified and initiates a diagnostic
interrupt. The LED “INTF” or “EXTF” is no longer lit. The diagnostic buffer is not
modified.

2. The CPU operating system calls OB 82.

3. With the OB82_MOD_ADDR parameter, you can see which module triggered
the interrupt.

4. Evaluate the OB82_MDL_DEFECT bit.

If this bit is “0”, then there are no errors on the module. Your evaluation can
stop here.

Diagnostic Interrupts Depending on the CPU Status

• In the CPU STOP state the diagnostic interrupts from the FM 451 are disabled.

• If not all of the pending errors are eliminated while the CPU is in the STOP
mode, the FM 451 signals the errors that have not yet been eliminated as
“entering state” again when the CPU changes to RUN.

• If all errors have been rectified in the CPU STOP state, then the error-free FM
451 state is not  signaled with a diagnostic interrupt after the transition to the
RUN state.
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Evaluation of a Diagnostic Interrupt in the User Program

The FM 451 sets the following entries in the local data of the diagnostic interrupt
OB (OB82). The errors are also entered in the diagnostic buffer 
(error class 128, for the meaning and possible remedies, refer to Appendix C.5):

Address Name Type Comment

0.0 OB82_EV_CLASS BYTE Event class and IDs:

B#16#38: Event leaving state

B#16#39: Event entering state

1.0 OB82_FLT_ID BYTE Error code (B#16#42)

2.0 OB82_PRIORITY BYTE Priority class:

B#16#1A in the RUN mode

B#16#1C in the STARTUP mode

3.0 OB82_OB_NUMBR BYTE OB number (82)

4.0 OB82_RESERVED_1 BYTE Reserved

5.0 OB82_IO_FLAG BYTE Input module: B#16#54

6.0 OB82_MDL_ADDR INT Logical base address of the module on
which the error occurred

8.0 OB82_MDL_DEFECT BOOL Module fault

8.1 OB82_INT_FAULT BOOL Internal error

8.2 OB82_EXT_FAULT BOOL External error

8.3 OB82_PNT_INFO BOOL Channel error

8.4 OB82_EXT_VOLTAGE BOOL External auxiliary supply missing

8.5 OB82_FLD_CONNTR BOOL Front connector missing

... Not used

10.3 OB82_WTCH_DOG_FLT BOOL Watchdog monitoring has responded

... Not used

12.0 OB82_DATE_TIME DATE_AND_TIME Date and time at which the OB was
called
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Figure 11-9 Possible Evaluation of a Diagnostic Interrupt
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12.1 Introduction

When you install the FM 351/FM 451 configuration package, a sample project is
also installed that illustrates several typical applications based on a number of
selected functions.  

The English sample project is in the following folder:

...\STEP7\EXAMPLES\zEn18_01

This contains several S7 programs of varying complexity and with different aims.
The programs include comprehensive comments.

12.2 Requirements

The following requirements must be met:

• You have created and wired up an S7 station consisting of a power supply
module, a CPU, and an FM 351 module, (version ≥ 3) or FM 451 (version ≥ 2).
Earlier versions of the module may deviate from the behavior described.

• You have correctly installed STEP 7 and the configuration package for the
FMx51 on your programming device/PC.  The description of how to handle the
programs is based on STEP 7 V5.0. If you use a different version of STEP 7,
the procedures may differ slightly.

• The programming device is connected to the CPU.

You can operate an FM 351 or an FM 451 with these samples.
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12.3 Preparing the Samples

To be able work through the samples online, make the following preparations:

1. Open the sample project zEn18_01_FMx51___Prog  in the folder
...\STEP7\EXAMPLES  using the SIMATIC Manager (use the detailed display
so that you can see the symbolic names) and copy it to your project folder
assigning a suitable name (File > Save As ).

2. Insert a station in your project to match your hardware configuration.

3. Select a sample program and copy the program to the offline CPU.

4. Configure the hardware completely in HW Config.

5. Set the parameters for the FM 351 or FM 451 based on “Getting Started”.
Export the parameters you have adapted to your system to the parameter DBs
of all samples except for the sample “Getting Started” using File > Export .

6. Select the FM 351 or FM 451 in the hardware configuration and display the
object properties (Edit > Object Properties) .  
In the “Mod Adr…” dialog, enter the current module address in all offline
channel DBs (CHAN_1, CHAN_2) and diagnostic DBs (DIAG) that exist in the
sample program. The module address must not be entered in your parameter
DBs (PARADB_1, PARADB_2) because these would then be incorrectly
overwritten. Open the dialog separately for each block. 
You can also enter the module address with the LAD/STL/FBD editor in the
MOD_ADDR block parameter.

7. Save the hardware configuration and download it to the CPU.

8. Select a sample program and download its block folder to the online CPU.

9. If you want to try out the next sample, go to step 8.

12.4 Code of the Samples

The samples are written in STL. You can view them directly in the LAD/STL/FBD
editor.

Select the view with “Symbolic Representation”, “Symbol Selection” and
“Comment”. If you have sufficient space on the monitor, you can also display the
“Symbol Information”.
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12.5 Testing a Sample

When you have made all the necessary entries for the sample, download the
complete block folder to the CPU.

The sample programs include variable tables (VATs) with which you can view and
modify the data blocks online (in other words in the RUN-P mode on the CPU). In
the variable table, select the views “Symbol” and “Symbol Comment”. Open a
variable table, link it with the configured CPU and monitor the variables cyclically.
The displayed variables are then continuously updated. By transferring the control
values, you can modify the values in the online data blocks.

All the samples require that the machine data were entered and saved in the
parameter dialogs. This allows you to execute the samples one after the other.

If “continuous reading” from the FM 351 is programmed in your application (for
example, position values), this may impede the updating of the parameter dialogs
when using an S7-300 CPU.

12.6 Adapting a Sample

You can use the code of the samples directly as user program.

The code of the samples in neither optimized nor designed for all eventualities.
Error evaluation is not programmed in detail in the sample programs to avoid the
programs becoming unwieldy.

The “AllFunctions” sample program can be used as a template to form the basis of
your user program, which you tailor to your needs by modifying and deleting
functions.

The samples are prepared for channel 1 (”MultiChannels” for channels 1 and 2). If
necessary, adapt the channel number with the LAD/STL/FBD editor.
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12.7 Sample Program 1 “GettingStarted”

Aim:

With this sample, you start up your positioning module which has parameter
settings based on “Getting Started”.

The sample extends the program shown in the “Linking in the User Program”
chapter of “Getting Started” by adding error evaluation.

Requirements:

You have set the parameters for your positioning module as described in “Getting
Started”.

The address of your module is entered correctly in the channel DB  in the
parameter MOD_ADDR and the channel number in the parameter CH_NO.

Startup:

In the startup OB (OB100) you call FC ABS_INIT that resets all the control and
return signals and the job management in the channel DB.

Cyclic Operation:

Open the variable table (VAT_CTRL_1), establish the connection to the configured
CPU and monitor the variables. Transfer the prepared control values. Activate
“CHAN_1”.DRV_EN: The drive is now enabled (“CHAN_1”.ST_ENBLD=1).
If the drive is not enabled, check your enable inputs.

! Caution

With the next two steps, you start the drive.

You can stop the drive again in one of the following ways:

• Set the control value for the direction to 0 again and activate it

• Set the control value for the drive enable to 0 again and activate it

• Change the CPU to the STOP mode

Set DIR_P=1 to travel in the plus direction in the selected mode “Jogging”. If you set
DIR_P=0, the drive will be correctly deactivated.
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Error Evaluation:

Create a data error by setting the reference point coordinate “CHAN_1”.REFPT in
VAT_CTRL_1 outside the working range or the end of the rotary axis. Then
activate the “set reference point” job with “CHAN_1”.REFPT_EN=1. The CPU
changes to STOP. (In a sample, this is the simplest method of indicating an error.
You can, of course, program a different error evaluation.)

Open HW Config and double-click on the FM 351 or FM 451. The parameter
assignment software is started. Display the cause of the error in the dialog by
selecting Test > Error Evaluation .

The status values in VAT_CTRL_1 still indicate the status before the CPU changed
to STOP. Update the status values to view the error and done bits of the jobs.

To eliminate the error, follow the steps outlined below:

1. Enter a permitted value in the control value.

2. Switch the CPU to STOP.

3. Switch the CPU to RUN-P.

4. Activate the control values. If you activate the control values before the CPU
restarts, they are reset by the initialization in OB100 and therefore have no
effect.
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12.8 Sample Program 2 “Commission”

Aim:

In this sample, you put the positioning module into operation without the parameter
assignment dialogs. You control and monitor using variable tables (VATs).

Requirements:

You have set the parameters for your positioning module as described in “Getting
Started”.

The address of your module is entered correctly in the channel DB  in the
parameter MOD_ADDR and the channel number in the parameter CH_NO.

The address of your module is correctly entered in the diagnostic DB in the
MOD_ADDR parameter.

The supplied channel DB already contains the DB number (30) of the
corresponding parameter DB for the machine data in the PARADBNO parameter.

The machine data of your system are stored in the data block PARADB_1.

Startup:

In the startup OB (OB100), call FC ABS_INIT to initialize the channel DB. You then
set the trigger bits for all jobs that you require after the module starts.

Cyclic Operation:

Open the variable table (VAT_CTRL_1), establish the connection to the configured
CPU and monitor the variables.

Transfer the prepared control values. The “jogging” mode is selected and the
required enable signals are set. With DIR_P=1, the drive turns. The actual value
must change. To stop the drive, set STOP to “1” and transfer the control values.
Activate and transfer the control value “CHAN_1”.REFPT_EN (set reference point).
The return signal “CHAN_1”.SYNC =1 means that the channel is synchronized.

In VAT_DIAG, you can see the most important entries of the diagnostic buffer of
the module. The meaning of the error classes and error numbers is described in
the manual in Appendix C.5, pageC-14.
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Error Evaluation:

Attempt to create further errors:

• Specify a reference point coordinate that is higher than the working range or
end of the rotary axis.

• Turn off the external power supply.

• Delete PARADB_1 on the online CPU and attempt to write machine data.  (In
the sample, the error evaluation is programmed so that the CPU changes to
STOP. When you update VAT_CTRL_1 again, the error code for this error is
displayed in “CHAN_1”.JOB_ERR. The meaning of the error codes is described
in the manual in Appendix C.4, pageC-13.)
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12.9 Sample Program 3 “AllFunctions”

Aim:

In this sample you will find all the functions of the FM 351/451:

• Modes

• Function switches

• Write jobs

• Read jobs

You can use the sample program as a template to form the basis of your user
program, which you tailor to your needs by modifying and deleting functions. The
data you need to adapt to your application are marked ***. Some functions are
available only for the FM 451.

Reactions to external events and the error evaluation are system-specific and are
therefore not included in the sample.

Requirements:

You have set the parameters for your positioning module as described in “Getting
Started”.

The address of your module is entered correctly in the channel DB  in the
parameter MOD_ADDR and the channel number in the parameter CH_NO.

The supplied channel DB already contains the DB number (30) of the
corresponding parameter DB for the machine data in the PARADBNO parameter.

The machine data of your system are stored in the data block PARADB_1.

Startup:

In the startup OB (OB100), call FC ABS_INIT to initialize the channel DB. You then
set the trigger bits for all jobs that you require after the module starts.
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Operation:

The CPU is in the STOP mode. Open the variable table USER_VAT and enter the
job number required for your user program in the control values. The job numbers
are explained in the code of the sample.

The correct combination of the user data “USER_DB”.CTRL_SIG,
“USER_DB”.FUNC_SW, “USER_DB”.WR_JOBS, “USER_DB”.RD_JOBS and
“USER_DB”.RETVAL_CTRL is necessary.

For more detailed information, refer to chapter 9.

Establish the connection to the configured CPU and transfer and activate the
control values.

Start the CPU (STOP > RUN-P). Monitor the return signals and actual values.

You can repeat the execution of the steps in the sequence by changing the CPU
from STOP to RUN again. This method is, of course, not suitable for continuous
operation. The aim in the example, is to reinitialize the module each time.



Samples

12-11
FM 451 Positioning Module
C79000-G7076-C451-02

12.10 Sample Program 4 “OneChannel”

Aim:

In this sample, you control a drive with the user program. The user program starts
up the module following a CPU warm restart. Afterwards, it executes a series of
steps that reacts to events.
Using the variable tables, you set the events, monitor the reactions of the module
and evaluate the diagnostic buffer.

In this somewhat more complex sample, you can get to know the following options
available with the blocks:

• Specifying several jobs at the same time

• Mixing write and read jobs

• Reading using a permanent job without waiting for the end of the job

• Evaluating the return signals of the block

• Evaluating the return signals of an individual job

• Resetting the done and error bits for individual or for all jobs

• Central ABS_CTRL call at the end of the user program

Requirements:

You have set the parameters for your positioning module as described in “Getting
Started”.

The address of your module is entered correctly in the channel DB  in the
parameter MOD_ADDR and the channel number in the parameter CH_NO.

The supplied channel DB already contains the DB number (30) of the
corresponding parameter DB for the machine data in the PARADBNO parameter.

The machine data of your system are stored in the data block PARADB_1.

Startup:

In the startup OB (OB100) you set the startup flag (Step 0) for the user program in
the corresponding instance DB (USER_DB).
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Operation:

The CPU is in the STOP mode. Open the variable table USER_VAT, adapt the
incremental dimensions (”USER_DB”.TRG_INC_1, “USER_DB”.TRG_INC_2), the
switch over difference (“USER_DB”.CHGDIF) and the switch-off difference
(“USER_DB”.CUTDIF) to your system and transferee the control values.

Start the CPU (STOP > RUN-P). Watch the step number of the sequence
(“USER_DB”.STEPNO), the return signals, and the actual values. After
initialization, a “relative incremental approach” is executed. The drives moves in a
negative direction to its first position (“USER_DB”.TRG_INC_1).

The program then waits in step 6 for an external trigger
(“USER_DB”.START_INC_2), to trigger the next incremental approach in the plus
direction. When the position is reached, the sequence of steps is located at its final
value (-2). The incremental approach with incremental dimension number 255
allows the transfer of the switch over and switch-off difference. This allows you to
test the final target approach.

You can repeat execution of the sequence of steps by triggering a new start (STOP
> RUN-P) on the CPU. This method is, of course, not suitable for continuous
operation. The aim in the example, is to reinitialize the module each time.

Error Evaluation:

If an error occurs during execution, the sequence of steps is stopped. The value -1
is entered as the step number.

Try to create errors that are entered in the “USER_DB”.ERR bit as group errors by
the central error evaluation.

• In USER_VAT, activate the prepared control value for incremental dimension
number 1 (“USER_DB”.TRG_INC_1), that is higher than the software limit
switch.
The sequence of steps is stopped, -1 is displayed as the step number. Check
the error using the error evaluation dialog.

• In USER_VAT, activate further control values for incremental dimension number
1 (“USER_DB”.TRG_INC_1) one after the other, incremental dimension number
255 (“USER_DB”.TRG_INC_2), or the switchover difference
(“USER_DB”.CHGDIF) and switch-off difference (“USER_DB”.CUTDIF). Check
the error in the same way as for incremental dimension 1.
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User program FB1 (USER_PROG):

The user program accesses the data in the module-specific data blocks
(USER_DB) with the form <blockname>.<symbolic name>. This means that the
user program can operate exactly one channel. The DB number specified in the
user program call is simply passed on so that  FC_ ABS_CTRL  is supplied with
values. With this type of programming, you can access data in the data block using
symbolic names. Indirect addressing of more than one channel is part of the
sample program 6 “MultiChannels”.

The user program executes a sequence of steps made up as follows:

Step 0 : The positioning module is initialized. The jobs with the corresponding data
are set that will be executed when the module is started up.

Step 1 : The program waits for the jobs set in step 0 to be processed.

Step 2 : The values set for the incremental dimension “USER_DB”.TRG_INC_1 is
entered in the incremental dimension table. The incremental dimension table is
then written to the module. The control signals for the first incremental approach
are sent at the same time.  FC ABS_CTRL make sure that the order of execution
from step 2 in correct.

Step 3 : The program waits for the execution of the set write job.

Step 4 : The program waits for the “PEH” return signal and the updated position
values from the first incremental approach.

Step 5 : The values set for the second incremental approach, switchover
difference, and switch-off difference are entered in the channel DB. The second
incremental approach with incremental dimension number 255 is then started with
“USER_DB”.START_INC_2 .

Step 6 : The program waits for the execution of the set jobs.

Step 7 : If an error occurs in the execution, the sequence of steps is stopped.
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12.11 Sample Program 5 “DiagnosticAndInterrupt”

Aim:

This sample contains a user program with the same task as in Sample Program 4
“OneChannel”. In this sample, we will show you how to evaluate a diagnostic
interrupt for certain modules and how to process this in the user program to
produce a general module error.

Requirements:

You have set the parameters for your positioning module as described in “Getting
Started”.

The address of your module is entered correctly in the channel DB  in the
parameter MOD_ADDR and the channel number in the parameter CH_NO.

The address of your module is correctly entered in the diagnostic DB in the
MOD_ADDR parameter.

The supplied channel DB already contains the DB number (30) of the
corresponding parameter DB for the machine data in the PARADBNO parameter.

The machine data of your system are stored in the data block PARADB_1.

In the hardware configuration, enable the diagnostic interrupt for this module with
Edit > Object Properties > Basic Parameters > Select Interrupt > Diagnostics .
Compile the hardware configuration and download it to the CPU.

Startup:

In the startup OB (OB100), the startup flag (step 0) for the user program is set in
the instance DB.

Operation:

As in Sample Program 4 “OneChannel”.
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Error Evaluation:

If an error occurs during execution, the sequence of steps is stopped. The value -1
is entered as the step number. You will find the latest entry of the diagnostic buffer
in USER_VAT. You can find out the cause of the error using the error class and
error number (appendix  C.5, page C-14).

Try to create errors that are entered in the “USER_DB”.ERR bit as group errors by
the central error evaluation.

• In USER_VAT, activate the prepared control value for incremental dimension
number 1 (“USER_DB”.TRG_INC_1), that is higher than the software limit
switch.
The sequence of steps is stopped, -1 is displayed as the step number. Check
the errors in the error evaluation dialog or in the diagnostic data in USER_VAT.

• In USER_VAT, activate further control values for incremental dimension number
1 (“USER_DB”.TRG_INC_1) one after the other, incremental dimension number
255 (“USER_DB”.TRG_INC_2), or the switchover difference
(“USER_DB”.CHGDIF) and switch-off difference (“USER_DB”.CUTDIF). Check
the error in the same way as for incremental dimension 1.

• Produce a diagnostic interrupt by disconnecting the power supply for the
module or by removing the front connector. The diagnostic error
“USER_DB”.ERR_MOD and group error “USER_DB”.ERR  become 1 and the
step number becomes   –1.

User Program (FB PROG):

The task is the same as in Sample Program 4 “OneChannel”.

In this sample, no special measures have been taken for restarting after
eliminating the error.

Diagnostic interrupt (OB82)

Depending on the address of the module that triggered the interrupt
(OB82_MDL_ADDR), the error ID in the corresponding instance DB (USER_DB) of
the user program is entered in the diagnostic interrupt. There is a reaction in the
cyclic user program.
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12.12 Sample Program 6 “MultiChannels”

Aim:

This example contains the same user program as sample program  4
“OneChannel”, however, it controls 2 channels of the module. The same copy of
the user program is used for both channels. Naturally, each channel has its own
set of data blocks.

Requirements:

You have set parameters for channel 1 as described in “Getting Started”. Copy
channel 1 to channel 2 with Edit > Copy Channel .
Where necessary, adapt the parameters for channel 2. Save the hardware
configuration and download it to the CPU.

The address of your module is entered correctly in the channel DB  in the
parameter MOD_ADDR and the channel number in the parameter CH_NO.

The address of your module is correctly entered in the diagnostic DB in the
MOD_ADDR parameter.

The supplied channel DBs already contain the DB number (30 or 31) of the
corresponding parameter DB for the machine data in the PARADBNO parameter.

The data blocks PARADB_1 and PARADB_2 each containing machine data for 1
channel of your system.

In the hardware configuration, enable the diagnostic interrupt for this module with
Edit > Object Properties > Basic Parameters > Select Interrupt > Diagnostics .
Compile the hardware configuration and download it to the CPU.

A variable table is prepared for each channel.

Startup:

In the startup OB (OB100), you set the startup ID (step 0) for the user program in
both instance DBs (USER_DB_1, USER_DB_2).

Operation:

The CPU is in the STOP mode. Open USER_VAT_1 and USER_VAT_2 and
transfer their control values.

Start the CPU (STOP > RUN-P). You can see how the actual positions of both
channels change.

Error Evaluation:

As in Sample Program 5 “DiagnosticAndInterrupt”, but separately for each channel.
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User Program (FB PROG):

The aim and sequence of the user program are as in Sample Program 5
“DiagnosticAndInterrupt” and Sample Program 4 “OneChannel”.

The user program is designed for the operation of more than one channel since it
accesses the module-specific data blocks indirectly (channel DBs, diagnostic DB,
and parameter DBs). The DB numbers specified in the call are not only passed on
to supply FC ABS_CTRL and FC ABS_DIAG but are also used in the user
program. With this type of programming, you cannot use symbolic names for the
data in the data blocks.

Diagnostic Interrupt (OB82)

Depending on the address of the channel that triggered the interrupt
(OB82_MDL_ADDR), the error ID in the corresponding instance DB of the user
program is entered in the diagnostic interrupt.
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Technical Specifications

General Technical Specifications

The following Technical Specifications are described in the reference manual
S7-400/M7-400 Programmable Controllers, Module Data.

• Electromagnetic compatibility

• Transport and storage conditions

• Mechanical and climatic ambient conditions

• Details on insulation tests, class and level of protection.

• Approvals and Standards

! Warning

Injury to persons and damage to property may occur.

In areas subject to explosion hazards persons may be injured and property
damaged if you remove S7-400 connectors during active operation.

Turn off the power to the S7-400 before removing connectors in hazardous areas.

! Warning

WARNING - DO NOT DISCONNECT WHILE CIRCUIT IS LIVE
UNLESS LOCATION IS KNOWN TO BE NON-HAZARDOUS

CE Mark

Our products meet the requirements of the EU directive 89/336/EEC
”Electromagnetic Compatibility” and the harmonized European standards (EN)
listed in the directive.

In compliance with the above mentioned EU directive, Article 10, the conformity
declarations are available to the relevant authorities at the following address:

Siemens Aktiengesellschaft
Bereich Automatisierungstechnik 
A&D AS E4
Postfach 1963
D-92209 Amberg, Germany

A
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Area of Application 

SIMATIC products are designed for use in an industrial environment.

Area of Application Requirements

Emitted interference Immunity

Industry EN 50081-2 : 1993 EN 50082-2 : 1995

Adherence to Installation Instructions

SIMATIC products meet the requirements if you follow the installation instructions
described in manuals during both installation and operation.
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Technical Specifications

Dimensions and weight

Dimensions W � H � D (mm) 50 � 290 � 280

Weight Approx. 535 g

Current, voltage and power

Current consumption (from the backplane bus) Typ. 550 mA

Power dissipation Typ. 12 W

Auxiliary power supply for the encoders Auxiliary supply: 24 V DC (X1, terminal 3)
(permitted range: 20.4 to 28.8V)

Encoder supply • Encoder supply 5V

– 5.2V � 2 %

– max. 300 mA/axis

– short-circuit proof

• Encoder supply 24V

– 1L+ –2V

– max. 300 mA/axis

– short-circuit proof

• Current consumption from 1L+ (without load):
max. 100 mA (X1, terminal 3)

Auxiliary power supply for the load current Auxiliary supply: 24 V DC (X1, terminals 13, 14, 25,
26, 37 and 38)
(permitted range: 20.4 to 28.8 V)

Supply of digital inputs and outputs Current consumption from 2L+ (channel 1),3L+
(channel 2), 4L+ (channel 3) (no load):
max. 50 mA

– Insulation tested with 500 V DC

Load voltage reverse polarity protection No
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Encoder inputs

Distance measurement • Incremental

• Absolute

Signal voltages • Symmetrical inputs: 5V to RS 422

• Asymmetrical inputs: 24V/ typ.4 mA

Input frequency and cord length for symmetrical
incremental encoders with 5 V supply

Max. 500 KHz for 32 m shielded cord length

Input frequency and cord length for symmetrical
incremental encoders with 24 V supply

Max. 500 KHz for 100 m shielded cord length

Input frequency and cord length for asymmetrical
incremental encoder with 24 V supply

Max. 50 KHz for 100 m shielded cord length

Data transfer rate and cord length for absolute
encoders

• Max. 125 KHz for 320 m shielded cord length

• Max. 250 KHz for 160 m shielded cord length

• Max. 500 KHz for 63 m shielded cord length

• Max. 1 MHz for 20 m shielded cord length

Monitoring possible for absolute encoders No

Input signals • Incremental: 2 pulse trains, 90° offset, 1 zero
pulse

• Absolute: Absolute value

Digital inputs

Number of digital inputs 12

Number of simultaneously controllable digital inputs 12

Electrical isolation No

Status indication Yes, green LED per digital input

Input voltage • 0 signal: -30 to 5V

• 1 signal: 11 V to 30 V

Input current • 0 signal: 1.5 mA at 2.5 V

• 1 signal: 9 mA at 24 V

Input delay (1I0, 1I1, 1I2, and 2I0, 2I1, 2I2 and 3I0,
3I1, 3I2)

• 0 → 1 signal: Typ. 3 ms

• 1 → 0 signal: Typ. 3 ms

Input delay (1I3, 2I3 and 3I3) • 0 → 1 signal: Typ. 300 µs

• 1 → 0 signal: Typ. 300 µs

Connection of a 2-wire BERO Possible

Unshielded cord length max. 50 m for 1I3, 2I3 and 3I3

max. 100 m for 1I0, 1I1, 2I0, 2I1, 2I2, 3I0, 3I1 and
3I2

Shielded cord length max. 600 m

Insulation test VDE 0160
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Digital outputs

Number of outputs 12

Electrical isolation No

Status indication Yes, green LED per digital output

Output current • 0 signal: 0.5 mA

• 1 signal: 0.5 A
(Permissible range: 5...600 mA)

• Lamp load: 5 W

Output delay for output current 0.5 A • 0 → 1 signal: max. 300 µs

• 1 → 0 signal: max. 300 µs

Signal level for 1 signal 2L+ , 3L+, 4L+: –0.8 V

Control of a digital input Yes

Control of a counter input Yes

Short circuit protection Yes, electronically clocked in the case of
overheating

Limit on induct. cut-off voltage 2 L+, 3L+, 4L+:   –39 V

Switching frequency • Resistive load: Max. 100 Hz

• Inductive load: Max. 0.5 Hz

Summation current of digital outputs Simultaneity factor 100%:
at 20° C and 60° C: 6 A

Unshielded cord length Max. 100 m

Shielded cord length max. 600 m

Insulation test VDE 0160

!
Danger

An overload in the output current of the digital outputs can destroy the module.

Please make sure that you do not exceed 600 mA.
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Connection Diagrams

Overview

The following table describes encoders that you can connect to the FM 451. The
connection diagrams for these encoders are described in this chapter.

Section Connection
Diagram for

Connecting Cable Remark Page

B.1 Incremental
encoder

4 � 2 � 0.25 + 2 � 1 mm2 Incremental encoder:

Up=5V, RS–422

B-2

Siemens
6FX 2001-2����

Up=5V, RS 422

B.2 Incremental
encoder

4 � 2 � 0.5 mm2 Incremental encoder:

Up=24 V, RS–422

B-3

Siemens
6FX 2001-2����

Up=24 V, RS 422

B.3 Incremental
encoder

4 � 2 � 0.5 mm2 Incremental encoder:

Up=24V, HTL

B-4

Siemens 
6FX 2001-4����

Up=24V, HTL

B.4 Absolute encoder

Siemens

4 � 2 � 0.5 mm2 Absolute encoder:

U =24V SSI

B-5

Siemens 
6FX 2001-5����

Up=24V, SSI

B
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B.1 Connection Diagram for Incremental Encoder Siemens 6FX
2001-2 (Up=5V; RS 422)

Connection Diagram

The following illustration shows the connecting diagram for the incremental
encoder Siemens 6FX 2001-2���� (Up=5 V: RS422):

Wire 4 � 2 � 0.25 + 2 � 1 mm2

� Twisted pair

Round 12-pin socket 
Siemens 6FX 2003-0CE12

solder side

1

2

3

4 5

6

7

89

10

11

12

15
14

13
12

10
11

7

6

5
6

8
1

3
4

10*

12**

11*

2**

A

A

B
B

N
N

�

FM 451 Encoder

Ground

+5.2 V

Shield on
housing

Shield on
housing

�

�

15-pin 
sub-D male
connector 
Solder side metallized 
casing secured by
screws
6FC9 341-1HC

15

9

8

1

* Pins 10 and 11 are jumpered internally.

** Pins 2 and 12 are jumpered internally.
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B.2 Connection Diagram for Incremental Encoder Siemens 6FX
2001-2 (Up=24V; RS 422)

Connection Diagram

The following illustration shows the connecting diagram for the incremental
encoder Siemens 6FX 2001-2�����(Up=24 V; RS 422):

Wire 4 � 2 � 0.5 mm2

� Twisted pair

Round 12-pin socket 
Siemens 6FX 2003-0CE12

solder side

1

2

3

4 5

6

7

89

10

11

12

15
14

13
12

10
11

7

5

5
6

8
1

3
4

10*

12**

11*

2**

A

A

B
B

N
N

�

FM 451 Encoder

Ground

+24 V

Shield on
housing

Shield on
housing

�

�

15-pin 
sub-D male
connector 
Solder side metallized 
casing secured by
screws
6FC9 341-1HC

15

9

8

1

* Pins 10 and 11 are jumpered internally.

** Pins 2 and 12 are jumpered internally.



Connection Diagrams

B-4
FM 451 Positioning Module

C79000-G7076-C451-02

B.3 Connection Diagram for Incremental Encoder Siemens 6FX
2001-4 (Up=24V; HTL)

Connection Diagram

The following illustration shows the connecting diagram for the incremental
encoder Siemens 6FX 2001-4�����(Up=24 V; HTL):

Round 12-pin socket  
Siemens 6FX 2003-0CE12
solder side

1

2

3

4 5

6

7

89

10

11

12
1
4

8
7

5
9

A*

B*

N*

FM 451 Encoder

Ground

Shield on
housing

Shield on
housing

Wire 4 � 2 � 0.5 mm2

+24 V
RE

5
8

3

10*

12**

11*

15-pin 
sub-D male
connector 
Solder side metallized 
casing secured by
screws
6FC9 341-1HC

15

9

8

1

2**

* Pins 10 and 11 are jumpered internally.

** Pins 2 and 12 are jumpered internally.

Note

If you would like to connect an incremental encoder from another manufacturer in
a push-pull configuration (current sourcing/sinking), then you must observe the
following:

• Current sourcing: Connect RE (9) to ground (7).

• Current sinking: Connect RE (9) to +24 V (5).
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B.4 Connection Diagram for Absolute Encoder Siemens 6FX 2001-5 
(Up=24V; SSI)

Connection Diagram

The following illustration shows the connecting diagram for the absolute encoder
Siemens 6FX 2001-5�����(Up=24 V; SSI):

� Twisted pair

Round 12-pin socket 
Siemens 6FX 2003-0CE12

solder side

1

2

3

4 5

6

7

89

10

11

12

15
14

2
3

7
5

CLS

�

FM 451 Encoder

+24 V

Shield on
housing

Wire 4 � 2 � 0.5 mm2

�

Ground

CLS

DAT
DAT

3
4

2
1

12
11

15-pin 
sub-D male
connector 
Solder side metallized 
casing secured by
screws
6FC9 341-1HC

15

9

8

1

Shield on
housing
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Data Blocks/Error Lists

Chapter Overview

Section Topic Page

C.1 Content of the Channel DB C-2

C.2 Content of the Parameter DB C-9

C.3 Data and Structure of the Diagnostic DB C-11

C.4 List of JOB_ERR Messages C-13

C.5 Error Classes C-14

C
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C.1 Content of the Channel DB

Note

Do not modify data that are not listed in this table.

Table C-1 Content of the Channel DB

Address Name Data
Type

Initial
Value

Description

Addresses

0.0 MOD_ADDR INT 0 Module address

2.0 CH_NO INT 1 Channel number

10.0 PARADBNO INT –1 Number of the parameter DB

Control signals

14.3 OT_ERR_A BOOL FALSE 1 = acknowledge operator error

15.0 START BOOL FALSE 1 = start positioning

15.1 STOP BOOL FALSE 1 = stop currently active traverse

15.2 DIR_M BOOL FALSE 1 = direction minus

15.3 DIR_P BOOL FALSE 1 = direction plus

15.6 SPEED252 BOOL FALSE Start speed for incremental approach with
incremental dimension number 252:

0 = creep speed

1 = rapid speed

15.7 DRV_EN BOOL FALSE 1 = enable drive on

16.0 MODE_IN BYTE B#16#0 Requested mode:

0 = no mode

1 = jogging

3 = reference point approach

4 = relative incremental mode

5 = absolute incremental mode

17.0 MODE_TYPE BYTE B#16#0 • Start speed for the jogging mode

0 = creep speed
1 = rapid speed

• Incremental dimension number for the
incremental approach mode
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Table C-1 Content of the Channel DB

Address DescriptionInitial
Value

Data
Type

Name

Return Signals

22.2 DIAG BOOL FALSE 1 = diagnostic buffer changed

22.3 OT_ERR BOOL FALSE 1 = operator error occurred

22.4 DATA_ERR BOOL FALSE 1 = data error

22.7 PARA BOOL FALSE 1 = axis has parameters

23.0 ST_ENBLD BOOL FALSE 1 = start enabled

23.1 WORKING BOOL FALSE 1 = positioning active

23.2 WAIT_EI BOOL FALSE 1 = axis waiting for ext. enable

23.4 SPEED_OUT BOOL FALSE 0 = creep speed
1 = rapid speed

23.5 ZSPEED BOOL FALSE 1 = axis is located in stationary range

23.6 CUTOFF BOOL FALSE 1 = axis is located in switch-off range

23.7 CHGOVER BOOL FALSE 1 = axis is located in switchover range

24.0 MODE_OUT BYTE B#16#0 Active mode

25.0 SYNC BOOL FALSE 1 = axis is synchronized.

25.1 MSR_DONE BOOL FALSE 1 = length measurement/edge detection
completed

25.2 GO_M BOOL FALSE 1 = axis traveling in minus direction

25.3 GO_P BOOL FALSE 1 = axis traveling in plus direction

25.5 FVAL_DONE BOOL FALSE 1 = set actual value on-the-fly completed

25.7 POS_RCD BOOL FALSE 1 = position reached

26.0 ACT_POS DINT L#0 Actual position (actual position of the axis)

Function Switches

34.0 PLOOP_ON BOOL FALSE 1 = loop traverse in plus direction

34.1 MLOOP_ON BOOL FALSE 1 = loop traverse in minus direction

34.2 EI_OFF BOOL FALSE 1 = do not evaluate enable input

34.3 EDGE_ON BOOL FALSE 1 = edge detection on

34.4 MSR_ON BOOL FALSE 1 = length measurement on
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Table C-1 Content of the Channel DB

Address DescriptionInitial
Value

Data
Type

Name

Trigger Bits for Write Jobs

35.0 MDWR_EN BOOL FALSE 1 = write machine data

35.1 MD_EN BOOL FALSE 1 = activate machine data

35.2 DELDIST_EN BOOL FALSE 1 = delete remaining distance

35.3 AVALREM_EN BOOL FALSE 1 = cancel set actual value

35.4 TRGL1WR_EN BOOL FALSE 1 = write incremental dimension table 1
(incremental dimension number 1 to 50)

35.5 TRGL2WR_EN BOOL FALSE 1 = write incremental dimension table 2
(incremental dimension number 51 to 100)

35.6 REFPT_EN BOOL FALSE 1 = set reference point

35.7 AVAL_EN BOOL FALSE 1 = set actual value.

36.0 FVAL_EN BOOL FALSE 1 = set actual value on-the-fly

36.1 ZOFF_EN BOOL FALSE 1 = set zero offset

36.2 TRG252_254_EN BOOL FALSE 1 = write incremental dimension for incremental
dimension number 252 or 254

36.3 TRG255_EN BOOL FALSE 1 = write incremental dimension for incremental
dimension number 255

36.4 DELDIAG_EN BOOL FALSE 1 = delete diagnostic buffer

Trigger Bits for Read Jobs

36.5 MDRD_EN BOOL FALSE 1 = read machine data

36.6 TRGL1RD_EN BOOL FALSE 1 = read incremental dimension table 1
(incremental dimension number 1 to 50)

36.7 TRGL2RD_EN BOOL FALSE 1 = read incremental dimension table 2
(incremental dimension number 51 to 100)

37.0 MSRRD_EN BOOL FALSE 1 = read measured values

37.1 ACTSPD_EN BOOL FALSE 1 = read actual speed, remaining distance and
current incremental dimension

37.2 ENCVAL_EN BOOL FALSE 1 = read encoder values

Done Bits for Function Switches

38.0 PLOOP_D BOOL FALSE 1 = “loop traverse in direction plus” job
completed

38.1 MLOOP_D BOOL FALSE 1 = “loop traverse in direction minus” job
completed

38.2 EI_D BOOL FALSE 1 = “do not evaluate enable input” job
completed

38.3 EDGE_D BOOL FALSE 1 = “edge detection on” job completed

38.4 MSR_D BOOL FALSE 1 = “length measurement on” job completed
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Table C-1 Content of the Channel DB

Address DescriptionInitial
Value

Data
Type

Name

Done Bits for Write Jobs

39.0 MDWR_D BOOL FALSE 1 = “write machine data” job completed

39.1 MD_D BOOL FALSE 1 = “activate machine data” job completed

39.2 DELDIST_D BOOL FALSE 1 = “delete remaining distance” job completed

39.3 AVALREM_D BOOL FALSE 1 = “cancel set actual value” job completed

39.4 TRGL1WR_D BOOL FALSE 1 = “write incremental dimension table 1” job
completed

39.5 TRGL2WR_D BOOL FALSE 1 = “write incremental dimension table 2” job
completed

39.6 REFPT_D BOOL FALSE 1 = “set reference point” job completed

39.7 AVAL_D BOOL FALSE 1 = “set actual value” job completed

40.0 FVAL_D BOOL FALSE 1 = “set actual value on-the-fly” job completed

40.1 ZOFF_D BOOL FALSE 1 = “set zero offset” job completed

40.2 TRG252_254_D BOOL FALSE 1 = “write incremental dimension for incremental
dimension number 252 or 254” completed

40.3 TRG255_D BOOL FALSE 1 = “write incremental dimension for incremental
dimension number 255” completed

40.4 DELDIAG_D BOOL FALSE 1 = “delete diagnostic buffer” job completed

Done Bits for Read Jobs

40.5 MDRD_D BOOL FALSE 1 =  “read machine data” job completed

40.6 TRGL1RD_D BOOL FALSE 1 = “read incremental dimension table 1” job
completed

40.7 TRGL2RD_D BOOL FALSE 1 = “read incremental dimension table 2” job
completed

41.0 MSRRD_D BOOL FALSE 1 = “read measured values” job completed

41.1 ACTSPD_D BOOL FALSE 1 = “read actual speed, remaining distance and
current incremental dimension” job
completed

41.2 ENCVAL_D BOOL FALSE 1 = “read encoder values” job completed
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Table C-1 Content of the Channel DB

Address DescriptionInitial
Value

Data
Type

Name

Error Bits for Function Switches

42.0 PLOOP_ERR BOOL FALSE 1 = error in “loop traverse in direction plus” job

42.1 MLOOP_ERR BOOL FALSE 1 = error in “loop traverse in direction minus” job

42.2 EI_ERR BOOL FALSE 1 = error in “Do not evaluate enable input” job

42.3 EDGE_ERR BOOL FALSE 1 = error in “edge detection on” job

42.4 MSR_ERR BOOL FALSE 1 = error in “length measurement on” job

Error Bits for Write Jobs

43.0 MDWR_ERR BOOL FALSE 1 = error in “write machine data” job

43.1 MD_ERR BOOL FALSE 1 = error in “activate machine data” job

43.2 DELDIST_ERR BOOL FALSE 1 = error in “delete remaining distance” job

43.3 AVALREM_ERR BOOL FALSE 1 = error in “cancel set actual value” job

43.4 TRGL1WR_ERR BOOL FALSE 1 = error in “write incremental dimension table
1” job

43.5 TRGL2WR_ERR BOOL FALSE 1 = error in “write incremental dimension table
2” job

43.6 REFPT_ERR BOOL FALSE 1 = error in “set reference point” job

43.7 AVAL_ERR BOOL FALSE 1 = error in “set actual value” job

44.0 FVAL_ERR BOOL FALSE 1 = error in “set actual value on-the-fly” job

44.1 ZOFF_ERR BOOL FALSE 1 = error in “set zero offset” job

44.2 TRG252_254_ERR BOOL FALSE 1 = error in “write incremental dimension for
incremental dimension number 252 or 254”
job

44.3 TRG255_ERR BOOL FALSE 1 = error in “write incremental dimension for
incremental dimension number 255” job

44.4 DELDIAG_ERR BOOL FALSE 1 = error in “delete diagnostic buffer” job
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Table C-1 Content of the Channel DB

Address DescriptionInitial
Value

Data
Type

Name

Error Bits for Read Jobs

44.5 MDRD_ERR BOOL FALSE 1 = error in “read machine data” job

44.6 TRGL1RD_ERR BOOL FALSE 1 = error in “read incremental dimension table 1”
job

44.7 TRGL2RD_ERR BOOL FALSE 1 = error in “read incremental dimension table 2”
job

45.0 MSRRD_ERR BOOL FALSE 1 = error in “read measured values” job

45.1 ACTSPD_ERR BOOL FALSE 1 = error in “read actual speed, remaining
distance and current incremental
dimension” job

45.2 ENCVAL_ERR BOOL FALSE 1 = error in “read current encoder values” job

Job Management for FC ABS_CTRL

48.0 JOB_ERR INT 0 Error number of the communication error

50.0 JOBBUSY BOOL FALSE 1 = at least one job active

50.1 JOBRESET BOOL FALSE 1 = reset all error and done bits

Data for “zero offset” job (FM 451)

80.0 ZOFF DINT L#0 Zero Offset

Data for “set actual value” Job

84.0 AVAL DINT L#0 Coordinate for “set actual value”

Data for  “set actual value on-the-fly” job (FM 451)

88.0 FVAL DINT L#0 Coordinate for “set actual value on-the-fly”

Data for “set reference point” job

92.0 REFPT DINT L#0 Coordinate for “set reference point”

Data for “write incremental dimension for incremental dimension number 252 or 254”

96.0 TRG252_254 DINT L#0 Incremental dimension for incremental
dimension number 252 or 254

Data for “write incremental dimension for incremental dimension number 255” job

100.0 TRG255 DINT L#0 Incremental dimension for incremental
dimension number 255

104.0 CHGDIF255 DINT L#0 Switchover difference for incremental dimension
number 255

108.0 CUTDIF255 DINT L#0 Switch-off difference for incremental dimension
number 255

Data for “read position data” job

112.0 ACTSPD DINT L#0 Current speed

116.0 DIST_TO_GO DINT L#0 Remaining distance

120.0 ACT_TRG DINT L#0 Current incremental dimension
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Table C-1 Content of the Channel DB

Address DescriptionInitial
Value

Data
Type

Name

Data for the “read encoder data” job

124.0 ENCVAL DINT L#0 Encoder actual value (internal representation)

128.0 ZEROVAL DINT L#0 Last zero marker value (internal representation)

132.0 ENC_ADJ DINT L#0 Absolute encoder adjustment

Data for “length measurement/edge detection” job (FM 451)

136.0 BEG_VAL DINT L#0 Start value of length measurement/edge
detection

140.0 END_VAL DINT L#0 End value of length measurement/edge
detection

144.0 LEN_VAL DINT L#0 Length
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C.2 Content of the Parameter DB

Note
Do not modify data that are not listed in this table.

Table C-2 Content of the Parameter DB

Address Name Data
Type

Initial Value Description

Machine data

4.0 EDGEDIST DINT L#0 Minimum edge-to-edge distance

8.0 UNITS DINT L#1 System of Units

12.0 AXIS_TYPE DINT L#0 0 = linear axis
1 = rotary axis

16.0 ENDROTAX DINT L#100000 End of rotary axis

20.0 ENC_TYPE DINT L#1 Encoder type, frame length

24.0 DISP_REV DINT L#80000 Displacement per encoder rev.

32.0 INC_REV DINT L#500 Increments per encoder rev.

36.0 NO_REV DINT L#1 Number of encoder revolutions

40.0 BAUDRATE DINT L#0 Baud Rate

44.0 REFPT DINT L#0 Reference-point coordinate

48.0 ENC_ADJ DINT L#0 Absolute encoder adjustment

52.0 REFPT_TYPE DINT L#0 Type of reference point approach

59.0 CNT_DIR BOOL FALSE Count direction:
0 = normal
1 = inverted

63.0 MON_WIRE BOOL TRUE 1 = wire break monitoring

63.1 MON_FRAME BOOL TRUE 1 = frame error monitoring

63.2 MON_PULSE BOOL TRUE 1 = missing pulse monitoring

64.0 SSW_STRT DINT L#–100000000 Software start limit switch

68.0 SSW_END DINT L#100000000 Software end limit switch

76.0 TRG_RANGE DINT L#1000 Target range

80.0 MON_TIME DINT L#2000 Monitoring time [ms]

84.0 ZSPEED_R DINT L#1000 Stationary range

88.0 ZSPEED_L DINT L#30000 Upper limit of stationary speed

92.0 CTRL_TYPE DINT L#1 Control mode (1 – 4)

99.0 REFPT_SPD BOOL TRUE Start speed for reference point approach
0 = rapid speed
1 = creep speed
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Table C-2 Content of the Parameter DB

Address DescriptionInitial ValueData
Type

Name

Machine data

99.1 EI_TYPE BOOL FALSE Enable Input
0 = level-triggered
1 = edge-triggered

100.0 CHGDIF_P DINT L#5000 Switchover difference plus

104.0 CHGDIF_M DINT L#5000 Switchover difference minus

108.0 CUTDIF_P DINT L#2000 Switch-off difference plus

112.0 CUTDIF_M DINT L#2000 Switch-off difference minus

Incremental dimension table 1

120.0 TRGL1.TRG[1] DINT L#0 Incremental dimension number 1

.

.
.
.

.

.
.
. Incr. dim. table 1

316.0 TRGL1.TRG[50] DINT L#0 Incremental dimension number 50

Incremental dimension table 2

320.0 TRGL2.TRG[51] DINT L#0 Incremental dimension number 51

.

.
.
.

.

.
.
. Incr. dim. table 2

516.0 TRGL2.TRG[100] DINT L#0 Incremental dimension number 100
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C.3 Data and Structure of the Diagnostic DB

Note

Do not modify data that are not listed in this table.

Table C-3 Structure of the Diagnostic DB

Address Name Data
Type

Initial Value Description

0.0 MOD_ADDR INT 0 Module address

256.0 JOB_ERR INT 0 Error number of the communication error

258.0 JOBBUSY BOOL FALSE 1 = job active

258.1 DIAGRD_EN BOOL FALSE 1 = read diagnostic buffer unconditionally

260.0 DIAG_CNT INT 0 Number of valid entries in the list

262.0 DIAG[1] STRUCT Diagnostic data latest entry

272.0 DIAG[2] STRUCT Diagnostic data second entry

282.0 DIAG[3] STRUCT Diagnostic data third entry

292.0 DIAG[4] STRUCT Diagnostic data fourth entry

302.0 DIAG[5] STRUCT Diagnostic data fifth entry

312.0 DIAG[6] STRUCT Diagnostic data sixth entry

322.0 DIAG[7] STRUCT Diagnostic data seventh entry

332.0 DIAG[8] STRUCT Diagnostic data eighth entry

342.0 DIAG[9] STRUCT Diagnostic data ninth entry
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The diagnostic entry DIAG[n] is structured as follows:

Table C-4 Structure of the Diagnostic Entry

Address Name Data
Type

Initial Value Description

+0.0 STATE BOOL FALSE 0 = event leaving state

1 = event entering state

+0.1 INTF BOOL FALSE 1 = internal error

+0.2 EXTF BOOL FALSE 1 = external error

+2.0 FCL INT 0 Error class:

1: Operating errors

2: Operator errors

4: Data error

5: Machine data errors

6: Incremental dimension table error

15: Messages

128: Diagnostic errors

+4.0 FNO INT 0 Error number

+6.0 CH_NO INT 0 Channel number

+8.0 TRG_NO INT 0 Incremenal dimension
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C.4 List of JOB_ERR Messages

JOB_ER
R (hex)

JOB_ERR
(dec)

JOB_ERR
(int)

Meaning

80A0 32928 –32608 Negative acknowledgment when reading from module. Module
removed during read operation or defective.

80A1 32929 –32607 Negative acknowledgment when writing to module. Module
removed during write operation or module defective.

80A2 32930 –32606 DP protocol error at layer 2

80A3 32931 –32605 DP protocol error at user interface / user

80A4 32932 –32604 Communication problem on K bus

80B0 32944 –32592 Data record/job unknown.

80B1 32945 –32591 Specified length wrong. Incorrectly set FM_TYPE parameter in the
channel DB for the module in use.

80B2 32946 –32590 The configured slot is empty.

80B3 32947 –32589 Actual module type does not match configured type.

80C0 32960 –32576 The module does not have the data to be read.

80C1 32961 –32575 The data of a write job of the same type have not yet been
processed on the module.

80C2 32962 –32574 The module is currently processing the max. number of jobs.

80C3 32963 –32573 Required resources (memory etc.) currently in use.

80C4 32964 –32572 Communication error

80C5 32965 –32571 Distributed I/Os not available.

80C6 32966 –32570 Priority class abort (warm restart or background)

8522 34082 –31454 Channel DB or parameter DB too short. The data cannot be read
from the DB. (write job)

8532 34098 –31438 DB number of the parameter DB too high. (write job)

853A 34106 –31430 Parameter DB does not exist. (write job)

8544 34116 –31420 Error in nth (n > 1) read access to a DB after error occurred. (write
job)

8723 34595 –30941 Channel DB or parameter DB too short. The data cannot be written
to the DB. (read job)

8730 34608 –30928 Parameter DB on the CPU write-protected. The data cannot be
written to the DB (read job).

8732 34610 –30926 DB number of the parameter DB too high. (read job)

873A 34618 –30918 Parameter DB does not exist. (read job)

8745 34629 –30907 Error in nth (n > 1) write access to a DB after error occurred. (read
job)

The errors 80A2 to 80A4 and 80Cx are temporary; in other words, they can be cleared after a waiting time
without you taking any action.
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C.5 Error Classes

Class 1: Operating Errors

Operating errors are detected asynchronous to operator input/commands. The
operating errors lead to the positioning being aborted, except for error number 9.
This leads to the positioning being terminated.

No. Meaning Diagnostic
Interrupt

1 Software limit switch start passed Yes

Cause The actual value is outside the working range.

2 Software limit switch end passed Yes

Cause The actual value is outside the working range.

3 Travel range start passed Yes

Cause Limit of traverse range passed (the coordinates of
the traverse range limits are included in the traverse
range)

4 Travel range end passed Yes

Cause Limit of traverse range passed (the coordinates of
the traverse range limits are included in the traverse
range)

5 Error in final target approach. Yes

Cause Target range was not reached within the monitoring
time

6 Stationary range left. Yes

Cause The actual value is outside the stationary range.

7 Positive feedback. Yes

Cause Actual value change > 1/2 stationary range in the
wrong direction.

8 No change in actual value or change too small Yes

Cause There is no actual value change or the actual value
change is against the programmed direction within
the monitoring time.

9 Target passed (FM 451) Yes

Cause The target was passed during “set actual value
on-the-fly”

10 Target range passed. Yes

Cause Target range was passed after the final target
approach.

11 Switchover point erroneously switched. Yes

Cause Axis oscillating at the switchover point.

12 Switch-off point erroneously switched. Yes

Cause Axis oscillating at the switch-off/reversal point.

13 Start of target range erroneously switched. Yes

Cause Axis oscillating in the target range.
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No. Diagnostic
Interrupt

Meaning

14 Change greater than the half rotary axis range Yes

Cause The speed/frequency is too high or there are
incorrect sudden changes in the actual value.

15 Change greater than rotary axis range Yes

Cause The speed/frequency is too high or there are
incorrect sudden changes in the actual value.

16 Incremental dimension for incremental dimension number
252 not transferred (FM 451)

Yes

Cause The incremental dimension was not transferred.

17 Approach to incremental dimension for incremental
dimension number 252 not possible (FM 451)

Yes

Cause The distance between the current actual position
and the specified incremental dimension is less than
the switchover difference or switch-off distance.

18 Wrong incremental dimension for incremental dimension
number 252 (FM 451)

Yes

Cause The incremental dimension is outside the working
range.

Class 2: Operator Errors

Operator errors are detected when the control signals are modified in the user data
area. Operator errors lead to the positioning being terminated.

No. Meaning Diagnostic
Interrupt

1 Illegal operating mode no

Cause The selected operating mode is illegal.

3 Illegal interface job no

Cause The selected signal is illegal with this operating
mode

4 Incorrect mode parameter no

Cause • In the “Jogging” mode, the speed specified is not
equal to the rapid speed or the creep speed

• In the “incremental approach” mode, the
incremental dimension is not equal to 1 to 100 or
not equal to 252, 254 and 255

5 No start enable no

Cause No start enable when starting.

7 Target/target range outside working range no

Cause Specified or calculated target outside the software
limit switches.

8 Parameters not set for the axis no

Cause Incorrect or no machine data were set for the axis
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No. Diagnostic
Interrupt

Meaning

9 Axis not synchronized no

Cause The “incremental approach” is only possible with an
axis that is already synchronized.

10 Target/distance cannot be positioned no

Cause The distance between the current actual position
and the specified target is less than the switch-off
difference

17 Reference point approach not possible no

Cause An SSI encoder was connected.

18 Relative or absolute incremental approach not possible no

Cause The incremental dimension is invalid.

19 Switch-off difference not greater than 1/2 target range for
incremental dimension number 255

no

Cause The switch-off difference for incremental dimension
255 is less than half the target range

20 Travel in specified direction illegal no

Cause Not enough distance to software limit switch

Class 4: Data Errors

Data errors are detected synchronous to operator input/commands. Data errors do
not lead to an error reaction.

No. Meaning Diagnostic
Interrupt

6 Specified increment too large No

Cause The value is not within �100 m or �1000 m. The
distance/ target must be greater than the travel
range

On a rotary axis, the coordinate must be > = 0 and
less than the end of the rotary axis.

10 Incorrect zero offset No

Cause The zero offset is more than � 100m or � 1000m.

The software limit switches are outside the travel
range (–100m...+100m or –1000m...+1000m) after
setting the zero offset.

Rotary axis: The value of the zero offset is higher
than the end of the rotary axis.
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No. Diagnostic
Interrupt

Meaning

11 Incorrect actual value specified No

Cause Linear axis: the coordinate is outside the current
(possibly shifted) software limit switch.

Rotary axis: The coordinate is < 0 or higher than the
end of the rotary axis.

12 Incorrect reference point No

Cause Linear axis: the coordinate is outside the current
(possibly shifted) software limit switch.

Rotary axis: The coordinate is < 0 or higher than the
end of the rotary axis.

20 Activate machine data not permitted No

Cause There are no new (error-free) machine data on the
module

27 Illegal bit-coded setting No

Cause Unused and, in this case, unwritten bits are not 0.

29 Illegal bit coding No

Cause Unused and, in this case, unwritten bits are not 0.

34 Cancel set actual value not possible No

Cause The actual position value would be outside the
working range with an SSI encoder and a linear axis
after making the setting.

36 Incorrect switchover difference in incr. dim. no. 255 No

Cause The value is not within the permitted numeric range
of �100 m or �1000 m.

On a rotary axis, the coordinate must be > = 0 and
less than the end of the rotary axis.

37 Incorrect switch-off difference in incr. dim. no. 255 No

Cause The value is not within the permitted numeric range
of �100 m or �1000 m.

The switch-off difference must be smaller than the
switchover difference.

107 Parameters not set for the axis No

Cause Either there are no machine data on the axis or they
are not activated.

108 Axis not synchronized No

Cause One of the jobs “set actual value” or “set actual value
on-the-fly” was started although the axis is not
synchronized.
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Class 5: Machine Data Errors

The diagnostic interrupt is triggered only when there is an error in the system data
block (SDB). Data machine data do not lead to an error reaction.

No. Meaning Diagnostic
Interrupt

5 Error in hardware interrupt setting Yes

Cause You have attempted to select a hardware interrupt
that the module does not support.

6 Wrong minimum edge-to-edge distance (FM 451) Yes

Cause You have entered a value < 0 or > 109 µm as the
minimum edge-to-edge distance.

7 Wrong system of units Yes

Cause The value for the system of units is outside the
permitted range of 1 to 4 and 6.

8 Incorrect axis type Yes

Cause You have specified neither 0 nor 1 as the axis type

9 Incorrect rotary axis end Yes

Cause The value for the end of the rotary axis is outside the
permitted range of 1 to 109 µm or 1 to 108 µm
(depending on the resolution).

10 Incorrect encoder type Yes

Cause The value for the encoder type is outside the
permitted range of 1 to 4.

11 Incorrect distance per encoder revolution Yes

Cause The value for distance /encoder revolution is outside
the permitted range of 1 to 109 µm (regardless of the
resolution).

13 Incorrect increments per encoder revolution (see Section 8.5,
page 8-15)

Yes

14 Incorrect number revolutions  (see Section 8.5, page 8-15) Yes

15 Incorrect baud rate Yes

Cause You have specified a baud rate outside the permitted
range of 0 to 3.

16 Incorrect reference point coordinate Yes

Cause The coordinate is outside the range of  –100m to
+100m or –1000m to +1000m (depending on the
resolution).

Linear axis: The coordinate is outside the working
range.

Rotary axis The coordinate is higher than the end of
the rotary axis or < 0.
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No. Diagnostic
Interrupt

Meaning

17 Incorrect absolute encoder adjustment Yes

Cause SSI encoder: The value of the absolute encoder
adjustment is not in the encoder range (increments
per encoder revolution × number of revolutions – 1).

18 Incorrect reference point approach type Yes

Cause You have specified a value other than 0, 1, 2 and 3.

19 Incorrect count direction Yes

Cause You have specified a value other than 0 and 1.

20 Hardware monitoring not possible Yes

Cause You have set the monitoring of frame errors in the
parameter DB to “FALSE”.

21 Incorrect software limit switch start Yes

Cause Linear axis: The software limit switch start is outside
the travel range (–100m...+100m or
–1000m...+1000m, depending on the resolution).

Linear axis: The software limit switch start (possibly
including any zero offset) is less than –100 m or
–1000 m (depending on the resolution).

22 Incorrect software limit switch end Yes

Cause Linear axis: The software limit switch end is outside
the travel range (–100m...+100m or
–1000m...+1000m, depending on the resolution) or
is less than the software limit switch start.

Linear axis: The software limit switch end ( including
any existing zero offset) is higher than +100 m or
+1000 m (depending on the resolution).

23 Incorrect maximum speed Yes

Cause The data not listed in the parameter DB must be 0.

24 Incorrect target range Yes

Cause Linear axis: Range between 0 and 100 m or 1000 m,
depending on the resolution.

Rotary axis Range greater than the end of the rotary
axis.

25 Incorrect monitoring time Yes

Cause The value for the monitoring time is outside the
permitted range of 0 to 100 000ms.

26 Incorrect stationary range Yes

Cause Linear axis: Range between 0 and 100 m or 1000 m,
depending on the resolution.

Rotary axis Range greater than the end of the rotary
axis.
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No. Diagnostic
Interrupt

Meaning

127 Incorrect stationary speed Yes

Cause The value for the stationary speed is outside the
permitted range of 0 to 100 000µm/min.

128 Incorrect control mode Yes

Cause You have specified a control mode outside the
permitted range of 1 to 4.

129 Incorrect start speed for reference point approach Yes

Cause You have specified neither 0 nor 1 as the start
speed.

130 Incorrect switchover difference in direction + Yes

Cause Linear axis: Range between 0 and 100 m or 1000 m,
(depending on the resolution).

Rotary axis Range greater than the end of the rotary
axis and less than 1/2  the target range

131 Incorrect switchover difference in direction – Yes

Cause Linear axis: Range between 0 and 100 m or 1000 m,
(depending on the resolution).

Rotary axis Range greater than the end of the rotary
axis and less than 1/2  the target range

132 Incorrect switch-off difference in direction + Yes

Cause The switch-off difference is greater than the
switchover difference plus, less than 1/2 the target
range, or is outside the permitted range between 0
and 100 m or 1000 m (depending on the resolution).

133 Incorrect switch-off difference in direction – Yes

Cause The switch-off difference is greater than the
switchover difference minus, less than 1/2 the target
range, or is outside the permitted range between 0
and 100 m or 1000 m (depending on the resolution).

200 Incorrect resolution Yes

Cause You have specified a resolution < 0.1 µm/pulse or 
> 1000 µm/pulse.

You have specified a distance/encoder revolution
and a number of pulses/encoder revolution, that
results in a resolution of < 0.1 or > 1000.

201 Encoder does not match the working range / rotary axis
range

Yes

Cause SSI encoder and rotary axis: The encoder does not
exactly cover the rotary axis range.

Linear axis: The encoder does not cover at least the
working range (incl. software limit switch).
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Class 6: Incremental Dimension Table Errors

The incremental dimension table errors do not lead to an error reaction.

No. Meaning Diagnostic
Interrupt

6 Incremental dimension specified in the incremental
dimension table too high

No

Cause The value is outside �100 m or �1000 m. The
distance/ target must be greater than the travel
range

On a rotary axis, the coordinate must be > = 0 and
less than the end of the rotary axis.

Class 15: Messages

Messages do not lead to an error reaction.

No. Meaning Diagnostic
Interrupt

1 Start of parameter assignment No

Cause The module has detected a parameter assignment
by a system data block.

2 End of parameter assignment No

Cause The module has processed the parameter
assignment by a system data block error-free.

11 Not enough distance to switchover point No

Cause The hardware response times cannot be maintained
since the interval between the switching points is too
small.

12 Not enough distance to reversal point No

Cause The hardware response times cannot be maintained
since the interval between the switching points is too
small.

14 Not enough distance to switch-off point No

Cause The hardware response times cannot be maintained
since the interval between the switching points is too
small.

15 Not enough distance to start of target range No

Cause The hardware response times cannot be maintained
since the interval between the switching points is too
small.
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Class 128: Diagnostic Errors

No. Meaning Diagnostic
Interrupt

4 External auxiliary voltage missing Yes

Cause • External 24 V auxiliary supply is not connected or
failed.

• Fuse on module defective
• Undervoltage
• Ground wire break

Effect • Positioning is aborted on all channels
• Switching off the outputs
• Deletion of the synchronization for Incremental

encoders if the auxiliary supply fails
• The FM 451 has not been assigned parameters.
• Start enable is deleted.

Remedy Make sure that the 24 V connection is correct. (If 24
V connection is correct, then the module is
defective.)

5 Front connector missing Yes

Cause Front connector of the positioning module not
inserted.

Effect • No external 24 V auxiliary supply
• Module not ready for operation

Remedy Insert the front connector of the positioning module.

51 Watchdog tripped Yes

Cause • Strong interference affecting the FM 451.
• Error in the FM 451.

Effect • Module is reset.
• All outputs deactivated
• Provided that after resetting the module, no

module defect  is detected, the module is ready
for operation again.

• The module signals the expired WATCHDOG
with “entering state” and “leaving state”.

Remedy • Eliminate the interference.
• Contact the relevant sales department who will

require details of the circumstances leading to
the error.

• Replace the FM 451.
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No. Diagnostic
Interrupt

Meaning

144 Encoder wire breakage Yes

Cause • Encoder cable cut or not plugged in.
• Encoder has no quadrature signals.
• Incorrect pin assignment.
• Cable length too long.
• Encoder signals short circuited.
• Encoder signal edge error
• Maximum input frequency of the encoder input

exceeded
• Failure of the encoder supply.

Effect • Positioning is aborted.
• Switching off the outputs
• With incremental encoders, synchronization is

deleted.
• Start enable is deleted.

Remedy • Check encoder cable.
• Keep within encoder specification.
• Monitoring can be temporarily suppressed at the

operator’s risk by setting parameters in the
parameter dialog.

• Keep to the module technical data.

145 Absolute encoder errors Yes

Cause Problems in frame exchange between the FM 451
and the absolute encoder (SSI) or exchange is
interrupted:
• Encoder cable cut or not plugged in.
• Incorrect encoder type
• Encoder incorrectly set (programmable

encoders)
• Frame length incorrectly specified
• Encoder supplies incorrect values (encoder

defective)
• Interference on measuring system cable
• Baud rate selected too high
• Monoflop time of the encoder greater than 64 µs

Effect • Positioning is aborted.
• Switching off the outputs
• Start enable is deleted.

Remedy • Check encoder cable.
• Check the encoder.
• Check the frame exchange between encoder

and FM 451.
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No. Diagnostic
Interrupt

Meaning

146 Incremental encoder missing pulses Yes

Cause • Encoder monitoring has detected missing pulses.
• Number of increments per encoder revolution is

incorrectly entered.
• Encoder defective: Does not supply the specified

number of pulses.
• Incorrect or missing zero marker.
• Interference affecting the encoder cable.

Effect • Positioning is aborted.
• Switching off the outputs
• Start enable is deleted.

Remedy • Enter the number of increments/encoder
revolution correctly (parameter dialog).

• Check the encoder and encoder cable.
• Keep to shielding and grounding regulations.
• Monitoring can be temporarily suppressed at the

operator’s risk by setting parameters in the
parameter dialog.
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Index

A
Aborting, 9-7
Aborting a reference point approach, 9-14
Aborting an incremental approach, 9-23
Aborting jogging, 9-9
Absolute encoder

data transfer, 10-4
frame run time, 10-5
increments per encoder revolution, 8-16
monoflop time, 10-5
pulse evaluation, 10-4
reaction times, 10-5

Absolute encoder adjustment, 8-19
alternative, 8-21
finding, 8-19

Absolute encoders, 10-4
Absolute incremental approach, 9-17, 9-18,

9-20
Actual monitoring time, 8-11
Addresses, C-2
Area of application for SIMATIC, A-2
Asymmetric output signals, 10-2
Asynchronous errors, 11-2
Auxiliary power for encoder, 4-5

polarity, 4-5
Auxiliary power for load current, polarity, 4-6
Axis, machine data, 8-12

B
Baud rate, 8-17
BEG_VAL, 9-34
Block library, 6-2
Block templates, 6-2
Blocks, downloading to CPU, 7-5
Bounce-free switch, 9-32

C
Cable length, maximum, 8-17
Cancel set actual value, 9-24
CE mark, A-1
Channel DB, 6-13

preparing, 7-5
structure, 6-13
task, 6-13

CNT_DIR, 8-17
Configuration software, 7-3
Connecting cords, 4-10
Connecting encoders, 4-3
Connection diagrams, B-1
Continuous travel, 9-17
Control circuit, 4-8
Control mode, 4-7, 8-6
Control signals, C-2

writing, 6-18
Controlled positioning, 2-2
Count direction, 8-17
CPU, startup, 6-9
Creating a project, 7-2

D
Data error, C-16
**Data for ”set actual value” job**, C-7
Data for ”Activate incremental dimension 254”

job, C-7
Data for ”Activate incremental dimension 255”

job, C-7
Data for ”Read position data” job, C-7
Data for ”set reference point” job, C-7
Data for the ”read encoder data” job, C-8
Delete remaining distance, 9-23
Deleting the diagnostic buffer, 11-2
Diagnostic DB, 6-14

preparing, 7-5
structure, 6-14, C-11
task, 6-14

Diagnostic error, C-22
Diagnostic interrupts, 11-11

entering state, 11-12
leaving state, 11-12
overview, 11-11
reaction of the FM 451, 11-11

Digital inputs, 4-6
Digital outputs, 4-7
Direct access to return signals, 6-17
Direction reversal, 9-36
DISP_REV, 8-15
Distance per encoder revolution, 8-15
Do not evaluate enable input, 9-38
Done bits for function switches, C-4
Done bits for read jobs, C-5



Index

Index-2
FM 451 Positioning Module

C79000-G7076-C451-02

Done bits for write jobs, C-5
Drive, 8-6

E
Edge acquisition, 9-32
Edge detection, requirements, 9-32
Edge-to-edge distance

data update, 9-33
result, 9-33

EDGE_ON, 9-34
EDGEDIST, 8-14, 9-33
EMERGENCY OFF switch, 1-4
EMERGENCY STOP switch, 4-1, 7-1
Enable input, 4-4, 9-11, 9-38
ENC_TYPE, 8-15
ENCODER, 4-2
Encoder

machine data, 8-15
mechanical adjustment, 8-21
multiturn, 10-4
single-turn, 10-4

Encoder CH1, CH2 and CH3, 4-2
Encoder data, 9-40

data used in the channel DB, 9-40
requirements, 9-40
sequence, 9-40

Encoder interface, 4-2
Encoder range, 8-14
Encoder type, 8-15
Encoders, connecting, 4-3
End of positioning, 9-2
END_VAL, 9-34
Error bits for function switches, C-6
Error bits for read jobs, C-7
Error bits for write jobs, C-6
Error classes, C-14
Error evaluation, 11-2
Error LEDs, 11-3
Execution times, 6-16

F
Fast access to module data, 6-17
FC 1, FC ABS_CTRL, 6-5
FC 2, FC ABS_DIAG, 6-11

FC ABS_CTRL, 6-5
call, 6-5
call parameters, 6-5
data blocks used, 6-5
response to errors, 6-9
return values, 6-6
tasks, 6-5

FC ABS_DIAG, 6-11
call, 6-11
call parameters, 6-11
data block used, 6-11
response to errors, 6-12
return values, 6-12
tasks, 6-11

FC ABS_INIT, 6-4
call, 6-4
call parameters, 6-4
data block used, 6-4
tasks, 6-4

FC0, FC ABS_INIT, 6-4
FCs and DBs, technical specifications, 6-15
Fictitious target, 9-36
FM 451

installing, 3-2
removing, 3-2
startup, 6-9

FM 451, wiring, 4-1
Frame error, 8-18
Frame length, 8-15
Front connector

pinout, 4-4
wiring, 4-10

Function switch, C-3
Function switches, 6-6
Functions, 6-2

execution times, 6-16

G
Ground connection, 4-11

H
Hardware installation, 7-2
Hardware limit switch, 7-1
Hardware limit switches, 4-1
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I
INC_REV, 8-16
Incorrect length measurement, 9-34
Increment, 10-3
Incremental approach mode

sequence with incremental dimension
number 1–100, 9-18

sequence with incremental dimension
number 252, 9-18

sequence with incremental dimension
number 254, 9-19

sequence with incremental dimension
number 255, 9-20

Incremental dimension number 1–100, 9-18
Incremental dimension number 252, 8-25, 9-18
Incremental dimension number 254, 8-26, 9-19
Incremental dimension number 255, 8-27, 9-20
Incremental dimension table errors, C-21
Incremental dimension tables, writing, 8-3
Incremental dimensions, 8-1, 8-24
Incremental encoder

increments per encoder revolution, 8-16
missing pulses, 8-18
reaction times, 10-3
signal shapes, 10-2

Incremental encoders, 10-2
Incremental mode, 9-17
Increments per encoder revolution, 8-16
Initial parameter assignment

incremental dimension tables, 8-3
machine data, 8-2

Installation, 5-2
Installation instructions, A-2
Installing, 5-1
Installing the configuration package, 5-1
Installing the module, 3-1

J
Job execution, order, 6-7
Job management for FC ABS_CTRL, C-7
Job status, 6-9
Jobs, 6-6
Jogging, 9-8
Jogging mode, sequence, 9-8

L
LED ”EXTF”, 11-3
LED ”INTF”, 11-3
LEN_VAL, 9-34

Length measurement, 9-32
data update, 9-33
incorrect, 9-34
minimum, 9-34
requirements, 9-32
result, 9-33

Linear axis, 8-12
Load circuit, 4-8
Load current supply, 4-6
Location of the fictitious target, 9-37
Loop traverse, 9-35

sequence, 9-35

M
Machine data, 8-1

activating, 8-2
axis, 8-12
baud rate, 8-17
count direction, 8-17
distance per encoder revolution, 8-15
encoder, 8-15
encoder type, 8-15
frame length, 8-15
increments per encoder revolution, 8-16
minimum edge-to-edge distance, 8-14
monitoring functions, 8-18
number of encoder revolutions, 8-16
reading, 8-3
writing, 8-2

Machine data error, C-18
Machine data for the drive, 8-6
Machine data of the encoder, data in the

parameter DB, 8-15
Mark, CE, iv
Maximum cable length, 8-17
Messages, C-21
Minimum edge-to-edge distance, 8-14
Minimum length measurement, 9-34
Missing pulses, incremental encoder, 8-18
Modifying incremental dimension tables, 8-3
Modifying machine data, 8-2
Module cycle, 6-15
Module data, fast access, 6-17
MON_FRAME, 8-18
MON_PULSE, 8-18
MON_WIRE, 8-18
Monitoring functions, 8-18, 9-2
Monitoring time, 8-11, 9-3, 9-4, 9-5
Motor circuit-breaker, 4-1
MSR_DONE, 9-34
MSR_ON, 9-34
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MSRRD_EN, 9-34
Multiturn encoder, 10-4, 10-4

frame length , range of values, 10-4

N
NO_REV, 8-16

O
Operating errors, C-14
Operating mode incremental, 9-17
Operating mode jogging, 9-8
Operator errors, C-15
Output signal

asymmetric, 10-2
symmetric, 10-2

P
Parameter assignment, 7-3
Parameter DB, C-9

areas, 6-14
structure, 6-14
task, 6-14

Parameters relevant for synchronization, 8-4
Pinout of the front connector, 4-4
Polarity of the auxiliary power for encoders, 4-5
Polarity of the auxiliary power for load current,

4-6
Position data, data used in the channel DB,

9-39
Positioning, end, 9-2
Power unit, 4-8
Preparations for programming, 7-3
Program structure, 6-10
Programming, 6-1
Pulses, 10-3
Putting into operation, 7-1

R
Read position data, 9-39

sequence, 9-39
Reading incremental dimension tables, 8-4
Reference point, reproducibility, 9-12
Reference point approach, 9-11
Reference point approach mode, 9-11

sequence, 9-11
Reference point switch, 4-4

Reference speed, 8-10
Reference-point switch, 9-11
Relative incremental approach, 9-17, 9-18,

9-20
Remaining distance, 9-23
Removing the module, 3-1
Reproducibility of a reference point, 9-12
Resolution, 8-22

calculation, 8-22
example, 8-23
range of values, 8-22

Return signals, C-3
reading, 6-5, 6-17

Return signals for diagnostics, 9-42
data used in the channel DB, 9-42

Return signals for positioning
data used in the channel DB, 9-41
sequence, 9-41

Reverse switch, 4-4
Reversing switch, 9-11
Rotary axis, 8-12

S
Safety concept, 4-1
Safety-relevant switches, 7-2
Samples, using, 12-3
Set actual value, 9-24

sequence, 9-24
Set actual value on-the-fly, 9-24
Set reference point, 9-30

sequence, 9-30
Signal period, 10-3
Single-turn encoder, 10-4, 10-4

frame length , range of values, 10-4
Software limit switch end, 8-14
Software limit switch start, 8-14
Standard system of units, 8-5
Stationary range, 2-2, 8-10
Stationary speed, 8-10
Status LEDs, 11-3
Step train frequency, 10-6
Switch-off difference, 2-2
Switch-off difference minus, 8-9
Switch-off difference plus, 8-9
Switch-off point, 2-2, 8-9
Switches, relevant for safety, 7-2
Switchover difference, 2-2
Switchover difference minus, 8-9
Switchover difference plus, 8-9
Switchover point, 2-2, 8-9
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Symmetric output signals, 10-2
Synchronization

reference point approach, 9-11
set reference point, 9-30

Synchronous errors, 11-2

T
Target, 2-2
Target approach, 9-3
Target range, 2-2, 8-10
Technical specifications, FM 451, 6-15
Terminate, 9-6
Terminating an incremental approach, 9-23
Terminating jogging, 9-9
Tools, 3-1
Total number of steps of the encoder, 8-16
Travel range, 8-14

relationship, 8-23
resolution, 8-23

Trigger bits for read jobs, C-4
Trigger bits for write jobs, C-4
Type of reference point approach, 8-13, 9-15
Types of error, 11-2

U
Units, selecting, 8-5
Unsharpness, 10-3, 10-6

W
Wire break, 8-18
Wiring, 4-1, 7-2

front connector, 4-10
Wiring procedure, 4-10
WORKING, 9-2
Working range, 2-2, 8-14

X
X1, 4-4

Z
Zero offset, 9-27
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Siemens AG
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Oestliche Rheinbrueckenstr. 50
D-76181 Karlsruhe
Federal Republic of Germany

Please check any industry that applies to you:

� Automotive

� Chemical

� Electrical Machinery

� Food

� Instrument and Control
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� Petrochemical

� Pharmaceutical

� Plastic

� Pulp and Paper

� Textiles

� Transportation

� Other _ _ _ _ _ _ _ _ _ _ _
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Remarks Form

Your comments and recommendations will help us to improve the quality and usefulness of our
publications. Please take the first available opportunity to fill out this questionnaire and return it
to Siemens.

Please give each of the following questions your own personal mark within the range from 1 (very
good) to 5 (poor).

1. Do the contents meet your requirements?

2. Is the information you need easy to find?

3. Is the text easy to understand?

4. Does the level of technical detail meet your requirements?

5. Please rate the quality of the graphics/tables:
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